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Preface

Disclaimer of Warranty
AgilePoint, Inc. makes no representations or warranties, either express or implied, by or with respect
to anything in this document, and shall not be liable for any implied warranties of merchantability or
fitness for a particular purpose or for any indirect, special or consequential damages.

Copyright
Copyright © 2011 AgilePoint, Inc. All rights reserved.

Trademarks
AgilePoint, Inc. and AgilePoint's products are trademarks of AgilePoint Inc. References to other
companies and their products use trademarks owned by the respective companies and are for
reference purpose only.

Government Rights Legend
Use, duplication or disclosure by the U.S. Government is subject to restrictions set forth in the
applicable license agreement and as provided in DFARS 227.7202-1(a) and 227.7202-3(a) (1995),
DFARS 252.227-7013(c)(1)(ii) (Oct 1988), FAR 12.212(a) (1995), FAR 52.227-19, or FAR 52.227-14,
as applicable.

Virus-free software policy
AgilePoint recognizes that viruses are a significant security consideration for our customers. To date,
we have had no report of AgilePoint BPMS carries any virus. AgilePoint takes the following measures
to ensure our software is free of viruses upon delivery:

• AgilePoint is built on top of Microsoft .NET framework. The pre-compiled executable is a.NET
Common Language Runtime (CLR) application, not a native machine binary. As far as is known at
this time, there are no viruses that infect .NET CLR executables.

• The virtual environment for the product packaging process in is fully isolated and protected, and
anti-virus software is installed and running during packaging.

• The deliverable package is scanned by anti-virus software before upload to our customer
download site.
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Document Revision Numbers
AgilePoint documentation uses the revision number format rX.Y.Z. The letters and numbers in this
revision number can be interpreted as follows:
• r - Indicates "revision." This helps to differentiate the document version numbers, which start with

v.

• X - The major version number for AgilePoint BPMS to which this document refers. For example,
AgilePoint releases 5.0, 5.0 SP1, and 5.5 would all have an X value of 5.

• Y - The major document revision number. This number typically changes only when either there is
a new AgilePoint release, or there are major changes to the document.

• Z - The minor document revision number. This number is incremented each time the document is
republished.

AgilePoint Documentation in PDF and HTML
AgilePoint documentation is provided in both print-friendly (PDF) and web-based (HTML) formats.

Advantages of HTML Documentation
• HTML is the primary delivery format for AgilePoint documentation.

• Unified, global search across all documentation. PDF documents allow you to search only within
the context of a given PDF file.

• All hyperlinks supported. Links in PDFs are only supported in certain contexts.

• "One-stop shopping" for all information related to AgilePoint BPMS.

• The HTML documentation is updated more frequently than the PDF documentation. Web-
based documentation is updated periodically between AgilePoint releases to address errors and
omissions, but the PDF documentation is updated only at the time of a software release.

Advantages of PDF Documentation

PDFs can be more easily printed, archived, and transferred (such as by FTP or email) than HTML
documentation.

For more information, see Downloading Files and Sharing Links from the Documentation Library on
the AgilePoint Support Portal.

Contacting AgilePoint Sales
AgilePoint is a leading Business Process Management System (BPMS) provider created by a team
of driven people who strive to incorporate the principles of relentless innovation for the benefit of
our customers. Our mission is to help companies of any size attain and sustain operational success
through process excellence.

Headquarters: AgilePoint Corporation 1916C Old Middlefield Way Mountain View, CA 94043, USA

http://support.agilepoint.com/SupportPortal/
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Tel: (650) 968 - 6789

Fax: (650) 968 - 6785

Email: info@agilepoint.com

Web site: www.agilepoint.com

International: For AgilePoint EMEA and AgilePoint Asia Pacific, please call the AgilePoint Corporate
Office for contact information.

  

Contacting Customer Support
To contact AgilePoint Support, please submit a ticket on the AgilePoint Support Portal: http://
support.agilepoint.com/SupportPortal/

If you do not have a Support Portal account, you can send an email to request one:
support@agilepoint.com

mailto:info@agilepoint.com
http://www.agilepoint.com
http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
mailto:support@agilepoint.com
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AgilePoint Envision
AgilePoint Envision is the Microsoft Visio-based business process modeling component of the
AgilePoint Business Process Management (BPM) suite. Envision extends Visio into a powerful
BPM tool that enables users to model and directly deploy end-to-end business processes that can
encompass the full lifecycle of business operations including the system-to-system, human-to-system,
and human-to-human activities.

In addition to the many customizable workflow activities that are built in, Envision provides an
extensible framework that enables IT assets to be exposed as AgileShapes in Envision.
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Opening AgilePoint Envision
To open AgilePoint Envision:

1. Click Start > All Programs > AgilePoint > AgilePoint Envision.
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AgileShapes
This section provides detailed information on the features, functionality, purpose, and intended usage
of the AgileShape components included in the AgilePoint BPMS Suite. "AgileShape" is the collective
term applied to all of the shapes (e.g. activities, conditions, end points, etc.) that can be used in an
AgilePoint business process to represent an activity. AgilePoint Envision comes with several built-in
AgileShapes for common business activities that can be grouped into three different categories; Basic,
AgileParts, and AgileWorks.

The Basic AgileShapes are special activities that are used for modeling certain portions of business
processes that are common among most (or all) process templates. These include Start and Stop
points, conditional shapes (i.e. branching and decision flow shapes), etc.

An AgilePart is an AgileShape (either built-in or custom) that represents a specific automatic activity
(e.g. Web Service, Insert Database, Copy Files, etc). It implements specific design-time features
and runtime functionality that allows AgilePoint Server to perform (or cause to be performed via
interaction with another server or system) the actual work represented by the AgileShape. In addition
to the built-in AgileParts, you can also create your own custom AgileParts using the AgilePart project
template included as part of AgilePoint Developer. Custom AgileParts allow application developers
the extensibility framework to implement more complex process and application logic, and develop
domain specific extensions.

An AgileWork is an AgileShape (either built-in or custom) that represents a specific Manual Activity
(e.g. Manual, Web form, Vote, etc.). It implements specific design-time features and runtime
functionality that allows AgilePoint Server to properly handle (e.g. assign, reassign, monitor, display,
etc.) the actual task(s) represented by the AgileShape. In addition to the built-in AgileWorks, you can
also create your own custom AgileWorks using the AgileWork project template included as part of
AgilePoint Developer. Custom AgileWorks allow application developers the extensibility framework
to implement more complex process and application logic, and develop domain specific extensions.
An AgileWork is similar to an AgilePart, but for a Manual Activity instead of an Automatic Activity. The
main differences between AgileParts and AgileWorks are the same as the differences between any
automatic and manual activity. For example, Manual activities are usually assigned to participants, so
AgileWork components have additional properties and functionality related to participants, participant
reassignment, etc. that AgilePart components do not have.

The AgileShapes will be defined in accordance with the Visio Stencil Pane for which the AgileShape is
associated.

Generic BPM
This section describes the AgileShapes in the Generic BPM stencil.

AgilePart
This is a generic AgileShape that can be associated with any AgilePart that is registered in AgilePoint
Envision. The user will be prompted to select a specific AgilePart when this AgileShape is added to a
process template.
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AgilePart Properties

Field Name Definition

(Name) Read Only

Default value: AgilePart.xxx, AgileWork

The display name of the AgileShape.

(UID) Read Only

Default value: AgilePart.xxx or AgileWork

The ID that uniquely identifies this AgileShape
from all others within the same process template.

Description Optional

A description of the AgileShape. This property
is primarily used as a means of recording
additional notes, comments, and details about
this AgileShape in order to make the process
template more understandable to process
modelers.

Debug Default value: False

This property enables you to monitor the
performance of and troubleshoot a particular
AgileShape. Setting this property to True adds
information to the AgilePoint Server log regarding
this shape – for example, data being passed
to or from the shape, or database connection
information. You can use this data to monitor the
performance of particular AgileShapes.

This property can be set to the following specific
values:

• False - This value indicates that the
AgileShape will not log additional progress
and debugging messages to the AgilePoint
Server log file at runtime.

• True - This value indicates that the
AgileShape will log additional progress
and debugging messages to the AgilePoint
Server log file at runtime. These messages
are often helpful in verifying that the
AgileShape is functioning properly and/
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Field Name Definition

or with troubleshooting any problems or
suspected problems with the AgileShape's
runtime behavior or configuration.

TimeSpan Default value: 10 Minute(s)

Specifies the maximum amount of time that
should be allowed for the completion of the
activity associated with this AgileShape before it
is considered overdue.

BusinessTime Default value: False

Determines whether the time span represents
normal time, or business hours only. This
property can be set to the following specific
values:

• True - When set to this value, the time span
represents a span of business hours only.
E.g. 5 Days of business time would normally
be equivalent to 7 Days of normal time, and
8 hours of business time would normally be
equivalent to 24 hours of normal time.

As an example, if business hours are
configured as 9am to 5pm and a Manual
AgileShape activity with a TimeSpan of
6 Business Hours is entered at 4pm on
Tuesday, then the activity must be completed
by 2pm on Wednesday.

• False - When set to this value, the time
span represents a normal (absolute) time
span, and is unaffected by any business time
configuration settings.

Length Default value: 10

The number of time units represented by the time
span.

Time Unit Default value: Minute

The type of time unit represented by the time
span. This property can be set to the following
specific values:

• Second

• Minute

• Hour
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Field Name Definition

• Day

• Week

• Month

Activity Entry Email Optional

The name of an Email Template that should be
used to generate an automatic email notification
when this AgileShape is entered at runtime.
If this property is left blank, then an email
notification will not be sent automatically when
the AgileShape is entered at runtime. If this
property is not blank, then an email notification
will be dynamically constructed and sent at
runtime (when the AgileShape is entered) using
the specified Email Template.

Activity Exit Email Optional

The name of an Email Template that should be
used to generate an automatic email notification
when this AgileShape is exited at runtime.
If this property is left blank, then an email
notification will not be sent automatically when
the AgileShape is exited at runtime. If this
property is not blank, then an email notification
will be dynamically constructed and sent at
runtime (when the AgileShape is exited) using the
specified Email Template.

Audit Level Default value: High

This property determines the amount of process
related data that is recorded to the workflow
database. This property can be set at either
the Process Template Properties layer or at the
individual AgileShape layer. This property allows
you to control the level of granularity in terms
of the amount of process related data that is
recorded to the workflow database. This property
can be set to the following specific values:

• High - This value indicates that AgilePoint
will record all data about the activity or
process to the database.

• Low - This value indicates that AgilePoint
will only allow a certain amount of data to
be recorded to the database. This option
provides a level of control over the granularity
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Field Name Definition

of AgilePoint process-related data that is
stored in the AgilePoint workflow database,
giving some flexibility in the audit trail records
by filtering out unnecessary data.

Audit level at Process Template level

• Manual activity (Generic manual activity
and AgileWork) - After the process is
completed (reaches \'91STOP' activity):

• If audit level is set to high all records
will be kept at the movement of process
completion.

• If audit level is set to low, the records
for manual work items with status of
'Removed' and 'New' will be deleted
from the database. After leaving the
manual activity, the manual work items
with status of 'Removed' will be deleted
first, then after the whole process is
completed, the manual work items with
status of 'New' will be deleted. Also the
records for unreached activity instances
will be deleted from the database.

• For example, this is useful if you assign
a group to this manual activity. Manual
work items with status of 'Removed' and
'New' are not meaningful data after the
process completed.

• Automatic activity - Not supported for now.
No action will be taken.

• Audit level at AgileShape level -

• Manual activity (Generic manual activity
and AgileWork) - If audit level is set
to high, all records will be kept at the
movement of leaving the activity. Note
that one manual activity can have
multiple work items at a time.

• Automatic activity (AgilePart only, not
including AgileStub) - If audit level is set
to high, all records will be kept at the
movement of leaving the activity. If audit
level is set to low, the record of auto work
item will be deleted from database after
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Field Name Definition

leaving the activity. No record will be kept
for this particular activity.

For example, this is useful if you have
a 'Delay' AgilePart that goes through
a large number of loops. Usually
customers are not interested in the
information about the 'Delay' AgilePart,
so setting the audit level for 'Delay'
AgilePart to low, will delete the record
immediately and the database size will
not grow as fast.

SessionMode Default value: Single

 This property can be set to the following specific
values:

• Single - If it is set to single, then ONLY one
session is effective, meaning that in a loop
scenario as shown below, the engine would
cancel a task from the previous session
automatically.

• Multiple - If it is set to multiple, then multiple
sessions can be effective in a loop scenario,
and the process will wait for all tasks to
complete and not cancel any previous tasks.

Wait All Incoming Default value: False

When an AgileShape has multiple direct
predecessors (i.e. it has multiple In-Connectors
leading directly from other AgileShapes),
this property determines how many of the
predecessor AgileShapes must be exited (at
runtime) before this AgileShape can be entered
(at runtime).
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Field Name Definition

This property can be set to the following specific
values:

• False - This value indicates that the
AgileShape will be entered (at runtime) as
soon as any one of the AgileShape's direct
predecessors are exited (at runtime).

• True (Dynamic) - This value indicates
that the AgileShape will be entered (at
runtime) only after all of the AgileShape's
"enterable" direct predecessors are exited
(at runtime). If any of the direct predecessors
are un-enterable (e.g. they will never be
entered in this process instance because
conditional logic in the process bypassed
them) and therefore un-exitable, then those
predecessors are not required to be exited
before this AgileShape is entered.

• True (Static) - This value indicates that
the AgileShape will be entered (at runtime)
only after all of the AgileShape's direct
predecessors are exited (at runtime).

AssemblyName Read Only

Default value: Automatically determined (based
upon the user's input) when the AgileShape is
first added to the process template.

The name of the .NET assembly containing
the specific AgilePart component that this
AgileShape instance is associated with.

ClassName Read Only

Default value: Automatically determined (based
upon the user's input) when the AgileShape is
first added to the process template.

The fully qualified Type name (including the
namespace) of the .NET class (in the .NET
assembly specified by the AssemblyName
property) that represents the specific AgilePart
component that this AgileShape instance is
associated with.

Method Read Only
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Field Name Definition

Default value: Automatically determined (based
upon the user's input) when the AgileShape is
first added to the process template.

The name of the method (in the .NET class
specified by the ClassName property) that will
be invoked at runtime (when the AgileShape is
entered).

ConfigureAttachments Allows you to attach documents to the activity
that are accessed from the process repository.
(For more information, see Process Repository
on the AgilePoint Support Portal.) If you
select the View check box and you are using
SharePoint Integration, you can the attachments
also display in the process model in SharePoint.

Reference URL Allows you to associate an URL to the shape
that is used in the process repository. For more
information, see Process Repository on the
AgilePoint Support Portal.

ExceptionHandlerScope Default value: Local

Specifies the value which determines how
AgilePoint Server will handle an AgilePart
exception. Two options are available: Local or
Global.

• Local - This value indicates the exception
handling (i.e., error message and status)
information for an AgilePart within a single
process instance will be saved to the custom
attribute defined in the SaveErrorMessageTo
and SaveStatusTo properties.

• Global - This value indicates the exception
handling (i.e., error message and status)
information is handled the same as the Local
option, but includes the extended ability to
call on a custom AgileConnector to handle
the exception as desired.

SaveErrorMessageTo Default value: ErrorMessage

Specifies the name of a custom process attribute
that should be updated if the AgileShape causes
an error at runtime. If such an error occurs, a
message containing information about the error

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
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will be stored in the custom process attribute
specified by this property.

SaveStatusTo Default value: Success

Specifies the name of a custom process attribute
that should be updated when the AgileShape is
exited. When the AgileShape is exited at runtime,
the value of the AgileShape's Status property
will be stored (as a String) in the custom process
attribute specified by this property.

AgileWork
This is a generic AgileShape that can be associated with any AgileWork that is registered in AgilePoint
Envision. The user will be prompted to select a specific AgileWork when this AgileShape is added to a
process template.

The main differences of an AgileWork component as compared to an AgilePart are:

• An AgileWork component must inherit from the WFAgileWork base class.

• An AgileWork component's design-time support is created using the WFAgileWorkDescriptor
class. (It is very similar to the WFAgilePartDescriptor class).

• All AgileWorks inherit the following server-side events from the WFAgileWork base class:

• AssignWorkItem

• CancelWorkItem

• CompleteWorkItem

• EnterActivityInstance

• LeaveActivityInstance

• ReassignWorkItem

AgileWork Properties

Field Name Definition

(Name) Read Only

Default value: AgilePart.xxx, AgileWork

The display name of the AgileShape.

(UID) Read Only

Default value: AgilePart.xxx or AgileWork
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The ID that uniquely identifies this AgileShape
from all others within the same process template.

Description Optional

A description of the AgileShape. This property
is primarily used as a means of recording
additional notes, comments, and details about
this AgileShape in order to make the process
template more understandable to process
modelers.

Optional Default value: False

Determines whether the activity represented by
this AgileShape can be manually canceled (using
AgilePoint Enterprise Manager). This property
can be set to the following specific values:

• True - The activity can be manually
canceled.

• False - The activity cannot be manually
canceled.

TimeSpan Default value: 10 Minute(s)

Specifies the maximum amount of time that
should be allowed for the completion of the
activity associated with this AgileShape before it
is considered overdue.

BusinessTime Default value: False

Determines whether the time span represents
normal time, or business hours only. This
property can be set to the following specific
values:

• True - When set to this value, the time span
represents a span of business hours only.
E.g. 5 Days of business time would normally
be equivalent to 7 Days of normal time, and
8 hours of business time would normally be
equivalent to 24 hours of normal time.

As an example, if business hours are
configured as 9am to 5pm and a Manual
AgileShape activity with a TimeSpan of
6 Business Hours is entered at 4pm on
Tuesday, then the activity must be completed
by 2pm on Wednesday.
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• False - When set to this value, the time
span represents a normal (absolute) time
span, and is unaffected by any business time
configuration settings.

Length Default value: 10

The number of time units represented by the time
span.

Time Unit Default value: Minute

The type of time unit represented by the time
span. This property can be set to the following
specific values:

• Second

• Minute

• Hour

• Day

• Week

• Month

Work To Perform Specifies the name of the manual activity
that needs to be performed by the activity's
participant(s).

The value of this property is used by the
AgilePoint Task Manager Web Part (for
SharePoint portals) and by the AgilePoint Task
List Web Control (for ASP.NET applications) to
determine the URL of the Web page that contains
the UI for the manual activity represented by this
AgileShape. However, the exact effects of this
property (and the valid values) vary depending on
which type of process template the AgileShape is
used in.

For Generic process templates:

When used in Generic process templates, this
property refers to the name of an ASP.NET Web
form in the ASP.NET application associated with
the process. It is the page's file name without
the file extension (.aspx). However, if the page
resides in a subfolder of the application, you
would also include the folder name(s).

E.g. If the URL of your ASP.NET application is:
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http://www.mycompany.com/MyApp/

and the URL of the Web page is:

http://www.mycompany.com/MyApp/My
Page.aspx

then you would configure the value of this
property as:

My Page

However, if the URL of your ASP.NET application
is:

http://www.mycompany.com/MyApp/

and the URL of the Web page is:

http://www.mycompany.com/MyApp/pages/
admin/My Page.aspx

then you would configure the value of this
property as:

pages/admin/My Page

For Microsoft InfoPath process templates:

When used in Microsoft InfoPath process
templates, this property refers to the Form
View of the InfoPath form associated with this
AgileShape. The names of the available form
views will automatically be listed in the drop-down
list for this property (as shown below).

 

 

For Microsoft SPDoc process templates:

When used in Microsoft SPDoc process
templates, this property refers to the name of an
ASP.NET Web form located under the "/_layouts/
AP/" subfolder of the document library's team
site. For Microsoft SPDoc process templates
associated with an AgilePoint Document Control
Library (i.e. a document library created using the
"STSAP" SharePoint Team Site template), the
following values can be used by default:
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• Submit - This value corresponds to the Web
form located at: MyTeamSite/_layouts/AP/
APSubmit.aspx

The Web form allows the participant(s) to
select/update the category metadata for the
document.

• Approve - This value corresponds to the
Web form located at:

MyTeamSite/_layouts/AP/APApprove.aspx

The Web form allows the participant(s) to
either approve or reject the document.

• Cancel - This value corresponds to the Web
form located at:

MyTeamSite/_layouts/AP/CancelTask.aspx

The Web form allows the participant to
cancel their involvement in the activity
represented by this AgileShape. If there is
only one participant, then this will also cancel
the entire process.

• Publish -

This value corresponds to the Web form
located at: MyTeamSite/_layouts/AP/
APPublish.aspx

The Web form simply waits for the
participant(s) to click the OK button in the
form. This value is typically used as the last
manual activity in a document workflow, and
allows the participant(s) to easily update the
system when the manual work associated
with the activity is finished.

Activity Entry Email Optional

The name of an Email Template that should be
used to generate an automatic email notification
when this AgileShape is entered at runtime.
If this property is left blank, then an email
notification will not be sent automatically when
the AgileShape is entered at runtime. If this
property is not blank, then an email notification
will be dynamically constructed and sent at
runtime (when the AgileShape is entered) using
the specified Email Template.



AgileShapes 26

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

Field Name Definition

Activity Exit Email Optional

The name of an Email Template that should be
used to generate an automatic email notification
when this AgileShape is exited at runtime.
If this property is left blank, then an email
notification will not be sent automatically when
the AgileShape is exited at runtime. If this
property is not blank, then an email notification
will be dynamically constructed and sent at
runtime (when the AgileShape is exited) using the
specified Email Template.

Task Reassigned Email Optional

The name of an Email Template that should be
used to generate an automatic email notification
when this AgileShape is reassigned at runtime.
If this property is left blank, then an email
notification will not be sent automatically when
the AgileShape is reassigned at runtime. If this
property is not blank, then an email notification
will be dynamically constructed and sent at
runtime (when the AgileShape is reassigned
to a new participant) using the specified Email
Template.

Reminder Email Optional

This property allows the process modeler to
configure "reminders" that will notify users (at
runtime) based on certain conditions. This
property is typically available with AgileShapes
that are associated with one or more participants
(e.g. Manual and AgileWork AgileShapes). Click
the Ellipses button to open the Reminder Email
dialog (as shown below).
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This dialog allows the process modeler to choose
a specific Email Template that should be used to
generate the "reminder" email notification(s). It
also allows the process modeler to configure the
start time (relative to the AgileShape's expiration)
and the frequency of recurrence at which the
email notification(s) will be sent.

TimeoutEmail Optional

The name of an Email Template that should be
used to generate an automatic email notification
when this AgileShape becomes overdue at
runtime.

If this property is left blank, then an email
notification will not be sent automatically when
the AgileShape becomes overdue at runtime.

If this property is not blank, then an email
notification will be dynamically constructed and
sent at runtime (when the AgileShape becomes
overdue) using the specified Email Template.

Max. Participant Default value: 1

Specifies how many Participants actually need
to be assigned to work on the activity. E.g. If the
Participants property is set to a group of users,
and Max. Participant is 2, then only 2 users
in the group actually need to be assigned to
"participate" in the activity when the AgileShape
is entered (at runtime). If all users must complete
the task, set the value to Maximum.
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Participants Specifies the user(s) that the activity can be
assigned to for completion. This property can be
set to a specific user, group of users, or a user
role. To specify multiple participants, separate the
usernames with a semicolon (;).

For more information, see Adding Participants to
an Activity on the AgilePoint Support Portal.

Reuse Participant Default value: True 

This property can be set to the following specific
values:

• True - Force the same participants to take
the rejected cases. E.g. Users A, B, C, D are
the Participants and Max. Participant is 2.
Initially, A and D are assigned to work on the
activity, but have rejected the incoming input.
If Reuse Participant is True, then the next
time the same incoming input routes back to
the activity, the same users (A and D) must
be assigned to work on the activity again.

• False - Any participant or any combination
of participants can involve subjected to the
MaxParticipant.

Audit Level Default value: High

This property determines the amount of process
related data that is recorded to the workflow
database. This property can be set at either
the Process Template Properties layer or at the
individual AgileShape layer. This property allows
you to control the level of granularity in terms
of the amount of process related data that is
recorded to the workflow database. This property
can be set to the following specific values:

• High - This value indicates that AgilePoint
will record all data about the activity or
process to the database.

• Low - This value indicates that AgilePoint
will only allow a certain amount of data to
be recorded to the database. This option
provides a level of control over the granularity
of AgilePoint process-related data that is
stored in the AgilePoint workflow database,

http://support.agilepoint.com/SupportPortal/
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giving some flexibility in the audit trail records
by filtering out unnecessary data.

Audit level at Process Template level

• Manual activity (Generic manual activity
and AgileWork) - After the process is
completed (reaches \'91STOP' activity):

• If audit level is set to high all records
will be kept at the movement of process
completion.

• If audit level is set to low, the records
for manual work items with status of
'Removed' and 'New' will be deleted
from the database. After leaving the
manual activity, the manual work items
with status of 'Removed' will be deleted
first, then after the whole process is
completed, the manual work items with
status of 'New' will be deleted. Also the
records for unreached activity instances
will be deleted from the database.

• For example, this is useful if you assign
a group to this manual activity. Manual
work items with status of 'Removed' and
'New' are not meaningful data after the
process completed.

• Automatic activity - Not supported for now.
No action will be taken.

• Audit level at AgileShape level -

• Manual activity (Generic manual activity
and AgileWork) - If audit level is set
to high, all records will be kept at the
movement of leaving the activity. Note
that one manual activity can have
multiple work items at a time.

• Automatic activity (AgilePart only, not
including AgileStub) - If audit level is set
to high, all records will be kept at the
movement of leaving the activity. If audit
level is set to low, the record of auto work
item will be deleted from database after
leaving the activity. No record will be kept
for this particular activity.
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For example, this is useful if you have
a 'Delay' AgilePart that goes through
a large number of loops. Usually
customers are not interested in the
information about the 'Delay' AgilePart,
so setting the audit level for 'Delay'
AgilePart to low, will delete the record
immediately and the database size will
not grow as fast.

Auto Complete Default value: False

This property can be set to the following specific
values:

• True - The work item (task) will be marked
as completed if it is carried out for the first
time. If a subsequent AgileShape causes
the process flow to re-enter this same
AgileShape, it will not be automatically
marked as completed in order to avoid an
infinite loop.

• False - The work item (task) will not be
marked as completed.

Debug Default value: False

This property enables you to monitor the
performance of and troubleshoot a particular
AgileShape. Setting this property to True adds
information to the AgilePoint Server log regarding
this shape – for example, data being passed
to or from the shape, or database connection
information. You can use this data to monitor the
performance of particular AgileShapes.

This property can be set to the following specific
values:

• False - This value indicates that the
AgileShape will not log additional progress
and debugging messages to the AgilePoint
Server log file at runtime.

• True - This value indicates that the
AgileShape will log additional progress
and debugging messages to the AgilePoint
Server log file at runtime. These messages
are often helpful in verifying that the
AgileShape is functioning properly and/
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or with troubleshooting any problems or
suspected problems with the AgileShape's
runtime behavior or configuration.

Priority Default value: Normal

This property indicates the priority level for the
task to be shown at runtime in the user's task list.
This property can be set to the following specific
values, or you can type over the value to set a
custom attribute:

• High - Setting the priority to 'High' will show
a Red icon in the users task list next to the
task.

• Normal - Setting the priority to 'Normal' will
show a Green icon in the users task list next
to the task.

• Low - Setting the priority to 'Low' will show a
Yellow icon in the users task list next to the
task.

SessionMode Default value: Single

 This property can be set to the following specific
values:

• Single - If it is set to single, then ONLY one
session is effective, meaning that in a loop
scenario as shown below, the engine would
cancel a task from the previous session
automatically.

• Multiple - If it is set to multiple, then multiple
sessions can be effective in a loop scenario,
and the process will wait for all tasks to
complete and not cancel any previous tasks.
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Wait All Incoming Default value: False

When an AgileShape has multiple direct
predecessors (i.e. it has multiple In-Connectors
leading directly from other AgileShapes),
this property determines how many of the
predecessor AgileShapes must be exited (at
runtime) before this AgileShape can be entered
(at runtime).

This property can be set to the following specific
values:

• False - This value indicates that the
AgileShape will be entered (at runtime) as
soon as any one of the AgileShape's direct
predecessors are exited (at runtime).

• True (Dynamic) - This value indicates
that the AgileShape will be entered (at
runtime) only after all of the AgileShape's
"enterable" direct predecessors are exited
(at runtime). If any of the direct predecessors
are un-enterable (e.g. they will never be
entered in this process instance because
conditional logic in the process bypassed
them) and therefore un-exitable, then those
predecessors are not required to be exited
before this AgileShape is entered.

• True (Static) - This value indicates that
the AgileShape will be entered (at runtime)
only after all of the AgileShape's direct
predecessors are exited (at runtime).

Wait Work Performed Default value: True



AgileShapes 33

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

Field Name Definition

This property can be set to the following specific
values:

• True - Any data involved needs to be
handled first (e.g. if participants need to
input some comments) before the activity is
considered complete.

• False - No specific data entry involved
(e.g. the participants' just need to send
some letters to the post office). The activity
will be complete when the participant(s)
manually update the status (e.g. by clicking
the Complete link in Enterprise Manager).

AssemblyName Read Only

Default value: Automatically determined (based
upon the user's input) when the AgileShape is
first added to the process template.

The name of the .NET assembly containing
the specific AgilePart component that this
AgileShape instance is associated with.

ClassName Read Only

Default value: Automatically determined (based
upon the user's input) when the AgileShape is
first added to the process template.

The fully qualified Type name (including the
namespace) of the .NET class (in the .NET
assembly specified by the AssemblyName
property) that represents the specific AgilePart
component that this AgileShape instance is
associated with.

Adding Participants to an Activity
This topic describes how to add participants to an activity.

In a Generic process template:
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In a Microsoft InfoPath, Microsoft SPDoc, or Microsoft SPList process template:

Choosing a participant from the AgilePoint User list:
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Choosing a group of participants from the AgilePoint Group list:

Choosing a group of participants from the AgilePoint Role list:
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Choosing a group of participants from Active Directory:

Select the AgilePoint Server URL and enter the login credential to connect to AgilePoint Server. The
Select Active Directory Group window appears.
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Make sure the Active Directory Name (LDAP Path) is correct, enter the search criteria and click
Search. A list of groups from Active Directory appears. Select the group to add as the participant and
click OK to complete.

Group names can include up to 64 characters.

Choosing a group of participants from SharePoint:

Select the AgilePoint Server URL and enter the login credential to connect to AgilePoint Server. The
Select SharePoint Group window appears.
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Enter the SharePoint Site URL and click Connect. The available groups will appear. Select the Group
and click OK.

Binding the participants to an InfoPath Form's metadata:
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Binding the participants to a SharePoint Document Library's metadata:

And
An activity that associates multiple activities with the And condition. All associated activities must be
completed successful before the start of the exit activity of the And condition activity.

Properties for This AgilePart

Field Name Definition

Email Optional

The name of an Email Template that should be
used to generate an automatic email notification
when this AgileShape is entered at runtime.

Dynamic Default value: True

When an AgileShape has multiple direct
predecessors (i.e. it has multiple In-Connectors
leading directly from other AgileShapes),
this property determines how many of the
predecessor AgileShapes must be exited (at
runtime) before this AgileShape can be entered
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(at runtime). This property can be set to the
following specific values:

• True - This value indicates that the And
AgileShape will be entered after one of the
AgileShape's "enterable" direct predecessors
are exited (at runtime). If any of the direct
predecessors are un-enterable (e.g. they will
never be entered in this process instance
because conditional logic in the process
bypassed them), then those predecessors
are not required to be exited before this
AgileShape is entered and the process
proceeds.

• False - This value indicates that the
AgileShape will be entered (at runtime)
only after all of the AgileShape's direct
predecessors are exited (at runtime).

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Email
An activity that specifies an email notification.

Properties for This AgilePart

Field Name Definition

Deferred Time Default value: 0 Minute(s)

Specifies the amount of additional time that
should be allowed to pass before the email
notification is sent.

This property (and its sub-properties) are very
similar to the TimeSpan property.

Email Optional

http://support.agilepoint.com/SupportPortal/


AgileShapes 43

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

Field Name Definition

The name of an Email Template that should be
used to generate an automatic email notification
when this AgileShape is entered at runtime.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Manual
A fully functional activity that is associated with a user interface (such as Web Form, Win Form) to
perform human task. A manual activity requires set up of task type, participant, and schedule to
generate task at runtime and prompt for human intervention. For instance, a manual activity may be to
prompt a user interface at run time for placing an order, approving a request, submitting or reviewing a
document, etc.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

Manual with Timeout
This AgileShape is identical to the Manual AgileShape, except that it has one additional design-time
property, and one additional Output connection. These two differences allow the process modeler
to model the portion of the process that should occur should the activity become overdue (i.e. is not
completed within the specified TimeSpan).

This AgileShape is typically used to represent a manual activity that requires a time-based escalation
process.

Properties for This AgilePart

Field Name Definition

TimeoutEmail Optional

The name of an Email Template that should be
used to generate an automatic email notification
when this AgileShape becomes overdue at
runtime.

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
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If this property is left blank, then an email
notification will not be sent automatically when
the AgileShape becomes overdue at runtime.

If this property is not blank, then an email
notification will be dynamically constructed and
sent at runtime (when the AgileShape becomes
overdue) using the specified Email Template.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

Multiple Condition
A condition activity that can branch into more than two routines based on the value of the specified
Data Binding property and the expression operator. Each Data Binding property is assigned a data
type such as: integer, number, date, and string. Various expression operators such as =, >, >=, etc.,
are supported to enable the most sophisticated process dynamics. The following is a complete list of
the complex branching options that are available based on the data type that is specified.

Data Type Expression Operators

Integer = > >= < <=

!=

String = =(IgnoreCase) StartsWith EndsWith Contains

!=

DateTime = LaterThan EarlierThan !=

Double = > >= < <= !=

Short = > >= < <= !=

Float = > >= < <= !=

Decimal = > >= < <= !=

TIP: You can use the Multiple Condition AgileShape to determine whether a String value is null by
using the operator "Equals" and entering the value as <NULL>.

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

Data Binding Select a custom attribute for data binding. The
data binding expression that is used to evaluate
the value of the condition at runtime.

Type The data type for the condition.

Advanced Opens the Define Conditions dialog box, which
enables you to add, edit, and manage conditions.
On the Define Conditions dialog box, click
Advanced to open the Define Expressions dialog
box.

You can use the Define dialog box to add or edit
expressions. Use brackets to create complex
expressions.

 

 

PropertyBinding ReadOnly

Default value: Chosen by the user when the
AgileShape is first added to the process template.
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The data binding expression that is used to
evaluate the value of the condition at runtime.

PropertyType The data type that the data binding expression
(see PropertyBinding) evaluates to at runtime.
This property can be set to the following specific
values:

• Integer

• String

• DateTime

• Double

• Short

• Float

• Decimal

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Or
An activity that associates multiple activities with the Or condition. Successful completion of one or
more of the associated activities will trigger the exit of the Or condition activity.

Properties for This AgilePart

Field Name Definition

Email Optional

The name of an Email Template that should be
used to generate an automatic email notification
when this AgileShape is entered at runtime.

Configuration Opens the Select Exclusive Predecessor
Activities dialog box, where you can configure
whether the activities in the parallel process flow
will continue to process or be canceled once one
of the process flows enters the "Or" shape.

http://support.agilepoint.com/SupportPortal/
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Exclusive This property allows the process modeler to
configure whether the "Or" shape will handle
inputs exclusively or wait and process all inputs
as they enter.

Default value: False

This property can be set to the following specific
values:

• True - This value indicates that the
AgileShape will handle incomplete activities
from the parallel process flow exclusively
based on the configuration defined using
the Select Exclusive Predecessor Activities
dialog. This dialog allows you to configure
whether the activities in the parallel process
flow will continue to process or be canceled
once one of the process flows enters the "Or"
shape.

• False - This value indicates that the
AgileShape will continue to handle incoming
activities (without the option of canceling
the activities in the parallel process flow)
regardless of the sequence upon which the
process flow enters the AgileShape.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Select Exclusive Predecessor Activities Window
This window allows the process modeler to configure whether the activities in the parallel process flow
will continue to process or be canceled once one of the process flows enters the "Or" shape.

http://support.agilepoint.com/SupportPortal/
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The "Nearest Incoming Activities" group box displays the activities that are nearest the "Or"
AgileShape. Selecting the "Cancel Manual Tasks" and/or "Stop System Tasks" will cancel the activity
that has yet to complete.

The "Other Predecessor Activities" group box displays any additional activities that are associated with
a process flow leading into the "Or" AgileShape. You can select which other predecessor activities
to cancel by selecting the check box. Below is a sample usage scenario that describes how this
functionality would work.

Case 1:
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Case 2:
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Leaving the "Cancel Manual Tasks" and/or "Stop System Tasks" blank will allow the parallel process
flow(s) to continue processing once one of the process flows enters the "Or" shape. This would be the
same behavior as if "False" was selected in the "Exclusive" property of the "Or" AgileShape.

Procedure
An activity that is tied to a system task and performed on the server side. In general, an automated
activity is for performing a task between two or more systems such as application integration.
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Examples of automated activities include generating a report at the end of a process, updating
a database when a request is approved, etc. AgilePoint provides various ways to integrate with
applications, synchronously or asynchronously, through C#, VB.NET, managed C++, COM, XML Web
Service, Messaging queue, etc.

This AgileShape should only be used within process templates that are (or will be) associated with an
AgileStub (created using AgilePoint Developer). The AgilePart and WebService AgileShapes do not
require the creation of an AgileStub, and can often be used instead of this AgileShape.

Properties for This AgilePart

Field Name Definition

Asynchronous Default value: False

This property determines whether this
AgileShape is exited immediately after
invoking the .NET method associated with this
AgileShape, or only after the associated method
has finished executing. This property can be set
to the following specific values:

• False - This value indicates that the
AgileShape invoke its associated .NET
method synchronously. The AgileShape
will only be exited (at runtime) after the
associated method has finished executing.

• True - This value indicates that the
AgileShape invoke its associated .NET
method asynchronously (i.e. in a separate
thread). The AgileShape will be exited (at
runtime) as soon as the associated method
has been invoked, regardless of whether
the method has finished executing. This
property setting is typically used to initiate
long-running procedures when the rest of the
process will be unaffected by any possible
work that the procedure might perform.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

http://support.agilepoint.com/SupportPortal/
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Procedure with Timeout
This AgileShape should only be used within process templates that are (or will be) associated with an
AgileStub (created using AgilePoint Developer).

The AgilePart and Web Service AgileShapes do not require the creation of an AgileStub, and can
often be used instead of this AgileShape. This AgileShape is identical to the Procedure AgileShape,
except that it has one additional design-time property, and one additional Output connection. These
two differences allow the process modeler to model the portion of the process that should occur
should the activity become overdue (i.e. is not completed within the specified TimeSpan). This
AgileShape is typically used to represent a procedure activity that requires a time-based escalation
process.

Properties for This AgilePart

Field Name Definition

Asynchronous Default value: False

This property determines whether this
AgileShape is exited immediately after
invoking the .NET method associated with this
AgileShape, or only after the associated method
has finished executing. This property can be set
to the following specific values:

• False - This value indicates that the
AgileShape invoke its associated .NET
method synchronously. The AgileShape
will only be exited (at runtime) after the
associated method has finished executing.

• True - This value indicates that the
AgileShape invoke its associated .NET
method asynchronously (i.e. in a separate
thread). The AgileShape will be exited (at
runtime) as soon as the associated method
has been invoked, regardless of whether
the method has finished executing. This
property setting is typically used to initiate
long-running procedures when the rest of the
process will be unaffected by any possible
work that the procedure might perform.

TimeoutEmail Optional

The name of an Email Template that should be
used to generate an automatic email notification
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Field Name Definition

when this AgileShape becomes overdue at
runtime.

If this property is left blank, then an email
notification will not be sent automatically when
the AgileShape becomes overdue at runtime.

If this property is not blank, then an email
notification will be dynamically constructed and
sent at runtime (when the AgileShape becomes
overdue) using the specified Email Template.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

Single Condition
A conditional logic activity that branches into two routines determined by a Boolean value. For
instance, Approval status of a request.

Properties for This AgilePart

Field Name Definition

PropertyBinding ReadOnly

Default value: Chosen by the user when the
AgileShape is first added to the process template.

The data binding expression that is used to
evaluate the value of the condition at runtime.

PropertyType The data type that the data binding expression
(see PropertyBinding) evaluates to at runtime.
This property can be set to the following specific
values:

• Integer

• String

• DateTime

• Double

• Short

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

• Float

• Decimal

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Start
This is a special AgileShape that represents the starting point of a process. This AgileShape is
activated when a process instance is initiated, and can never be reentered. A process template must
always contain exactly one Start AgileShape.

Properties for This AgilePart

Field Name Definition

None This AgileShape has no unique design time
properties.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Stop
A special activity that is activated at the end of a running process. A process template must always
contain exactly one Stop AgileShape.

Properties for This AgilePart

Field Name Definition

None This AgileShape has no unique design time
properties.

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
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Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

SubProcess
When entered, this AgileShape will initiate another process instance as a sub process.

Properties for This AgilePart

Field Name Definition

InitialAttributes This property allows the process modeler to
define a set of custom process attributes that
should be initialized when the sub process is
initiated, and also determines whether the sub
process shares the parent process' custom
process attributes.

Click the Ellipses button to open the Initial
Attributes dialog.

The Initial Attributes dialog also has a check
box that allows the process modeler to choose
whether the sub process shares the same
custom process attributes as the parent process.

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

SubProcess The name of the process that will be initiated as a
sub process.

To configure the AgilePoint sub process:

1. Click the Sub Process ellipses button. The
Configure Sub Process window appears.
 

 

2. Click the Browse to select the sub process
file link and select the sub process, or click
the Schema link to configure the sub process
naming to be dynamic based on associated
metadata.

3. In the "Process Initiator Name" section,
select either Default to inherit the parent's
process initiator value or select the Custom
option to assign a custom process initiator
name.

4. Click the Naming Convention tab. The
Configure Sub Process window appears.
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Field Name Definition

 

 

5. Click the Default option to allow AgilePoint to
auto-generate the sub process name or click
the Custom option and provide a name or
select it to be dynamically created based on
an associated schema value.

Wait For Complete Default value: True

This property determines whether this
AgileShape is exited immediately after initiating
the sub process, or only after the entire sub
process instance is complete. This property can
be set to the following specific values:

• False - This value indicates that the
AgileShape will be exited (at runtime)
immediately after initiating the sub process.

• True - This value indicates that the
AgileShape will be exited (at runtime) only
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Field Name Definition

after the entire sub process instance is
complete.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Premier Extension
This section describes the AgileShapes in the Premier Extension stencil.

BRE
An activity that accesses BizTalk Rules Engine and its policies which are registered in the AgilePoint
Envision. User can select the appropriate BizTalk Rules Engine and its specific policies using the BRE
shape.

Properties for This AgilePart

Field Name Definition

Policy Specifies the name of the Business Rule Policy
associated with this AgileShape.

Version Specifies the version of the Business Rule Policy
(see Policy) associated with this AgileShape.

Configure This property allows the process modeler to
configure which BizTalk Business Rule Policy
should be invoked at runtime. It also allows the
process modeler to configure the way in which
the policy should be invoked (e.g. which custom
process attributes should be associated with the
policy's input and output).

Click the Ellipses button to open the BizTalk
Business Rules Configuration dialog.

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

Input Specifies the name of the custom process
attribute that contains the XML input that will be
passed to the Business Rule Engine. The value
of the specified custom process attribute will be
passed to the Business Rule Engine when this
AgileShape is exited at runtime.

Output Specifies the name of the custom process
attribute that should be used to store the XML
output from the Business Rule Engine. The value
of the specified custom process attribute will
be updated when this AgileShape is exited at
runtime.

CopyProcessInformation Opens the CopyListItemsConfiguration dialog box
specifies the configuration for copying list items.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

http://support.agilepoint.com/SupportPortal/
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Configuration for Copy ListItems AgilePart
Specifies the configuration for copying list items.

Field Definitions

Field Name Definition

Source Site URL Specifies the name of the list that includes the
affected (copied, moved, etc.) list items.

Source List Name Specifies the source SharePoint site URL that
includes the list for which items are to be affected
(copied, moved, etc.).

Source Folder Name Specifies the name of the folder that includes the
list items to be affected (copied, moved, etc.).
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Field Name Definition

ListItem Field Name Specifies the name of the list item field to be
affected (copied, moved, etc.).

ListItem Field Value Specifies the value of the field to be affected
(copied, moved, etc.). This can be used as a
filtering mechanism where only fields with the
specified value are affected. The following are
sample values:

• $\{ListItemID\} or $\{SubListItemID\}

• list item ID

Target List Name Specifies the name of the destination list for the
affected items.

Target Folder Name Specifies the name of the destination folder for
the affected items. If the folder does not exist the
system will automatically create it.

Target Site URL Specifies the target SharePoint site URL that
includes the destination list for the affected items.

Cancel Tasks
This AgileShape can be used to cancel all Assigned and Overdue tasks.

Properties for This AgilePart

Field Name Definition

None This AgileShape has no unique design time
properties.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Delay
This AgileShape can be used to force the process to pause (for a specified length of time, or until a
specified date) before allow the process to continue to the next AgileShape.

http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

Configure This property allows the process modeler to
configure how long this AgileShape will delay the
process. Click the Ellipses button to open the
Set Time of Delay dialog.

 

 

See the TimeSpan section of the Common
AgileShape Design-Time Properties section for
additional information about specifying a time
period.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Dynamic Group
This AgileShape can be used as similar to the Manual AgileShape, however it facilitates dynamic
group functionality. When users are added/removed from a group, the change is persisted at runtime.

http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

Group/Role Default value: AgilePointGroup

Specifies whether an AgilePoint Group or an
AgilePoint Role will be used to perform the work.

Group/RoleName Specifies the name of the AgilePoint Group or
AgilePoint Role that will be used to perform the
work.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

Dynamic Parallel Approval
This AgileShape can be used to represent multiple manual (i.e. human input required) activities that
must be completed simultaneously (or in parallel).

The Dynamic Parallel Approval AgileShape currently only allows one participant per line. You cannot
(at this time) use a semicolon-delimited list of participants to assign a task to a pool of users using the
Dynamic Parallel Approval AgileShape.

Properties for This AgilePart

Field Name Definition

UserDefinedProperties This property allows the process modeler to
configure initial ClientData values that will be
associated with the AgileShape's associated
task(s) at runtime. This is basically a way of
allowing you to specify a set of name/value
pairs that are passed to your Web page via an
object called a WorkItem. This is an alternative to
passing data via URL parameters. In your Web
page you can retrieve this data via the ClientData
property of the WorkItem. It is then up to you to
decide how to use the data.

Click the Ellipses button to open the
configuration dialog.

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

 

 

WorkToPerforms This property allows the process modeler to
configure the number of parallel tasks, and the
participants and "WorkToPerform" for each task.

Click the Ellipses button to open the
configuration dialog.

 

 

The Participant values can only be a single
username. Enhancements will be made in a
future release to allow custom attributes to be
used such as $GROUP() and $ROLE(). If you
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Field Name Definition

need to use $GROUP() and $ROLE() before
then, you can simply use Manual AgileShapes.

EnabledExchangeServer Default value: False

This property allows the process modeler to
enable the AgileShape to integrate directly
with Microsoft Exchange Server so that the
AgileShape's associated task(s) can be viewed
directly from Microsoft Outlook's Task List by the
task(s)'s assigned participant(s).

See the ExchangeServer property for additional
information.

ExchangeServer This property allows the process modeler to
configure the AgileShape's integration with
Microsoft Exchange Server. When properly
enabled and configured, the AgileShape will then
insert, update, and remove Task items for the
task's assigned participants, so that the tasks can
be viewed directly from Microsoft Outlook.

Click the Ellipses button to open the
configuration dialog.
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Field Name Definition

See the EnabledExchangeServer property for
additional information.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

Dynamic Sequential Approval
This AgileShape can be used to represent a Manual (i.e. human input required) activity that must
be completed sequentially by 1 or more participants. It is designed to be used as part of a loop in
a process, so that the process flow will keep returning to this AgileShape until a sufficient number
of participants have completed the activity (or until some other condition exits the loop). The UI
associated with the Task determines where the value(s) associated with the UI are stored (e.g. an
Approval value).

Here is a simple example of how this AgileShape is typically used:

http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

UserDefinedProperties This property allows the process modeler to
configure initial ClientData values that will be
associated with the AgileShape's associated
task(s) at runtime. This is basically a way of
allowing you to specify a set of name/value
pairs that are passed to your Web page via an
object called a WorkItem. This is an alternative to
passing data via URL parameters. In your Web
page you can retrieve this data via the ClientData
property of the WorkItem. It is then up to you to
decide how to use the data.

Click the Ellipses button to open the
configuration dialog.

 

 

Approvers Default value: $Approvers
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Field Name Definition

This property specifies the name of the custom
attribute that (initially) contains the user names
of the approvers. The usernames should be
separated by a semicolon. Each time this
AgileShape is entered at runtime, the AgileShape
will assign a task to the first username specified
by this property. Then the custom attribute
associated with this property will be modified to
remove the username so that the next username
will be assigned the task during the next iteration
through the loop.

LoopCondition Default value: $HasMoreApprover

This property specifies the name of the custom
attribute that will be updated each time the
AgileShape is exited to indicate whether more
Approvers are still waiting to be assigned the
task. The value of the specified custom attribute
should be checked (using a SingleCondition
AgileShape within the loop) to determine whether
the loop should be exited or not.

EnabledExchangeServer Default value: False

This property allows the process modeler to
enable the AgileShape to integrate directly
with Microsoft Exchange Server so that the
AgileShape's associated task(s) can be viewed
directly from Microsoft Outlook's Task List by the
task(s)'s assigned participant(s).

See the ExchangeServer property for additional
information.

ExchangeServer This property allows the process modeler to
configure the AgileShape's integration with
Microsoft Exchange Server. When properly
enabled and configured, the AgileShape will then
insert, update, and remove Task items for the
task's assigned participants, so that the tasks can
be viewed directly from Microsoft Outlook.

Click the Ellipses button to open the
configuration dialog.
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Field Name Definition

See the EnabledExchangeServer property for
additional information.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

Process Adaptation
This AgileShape is a combination of the Dynamic Parallel, Dynamic Sequential, and Voting AgileWork.
It allows for a running process instance to adapt by adding a new participant to complete a task in
either a Parallel or Sequential fashion at runtime to support dynamic processes. Manageability at
runtime is accomplished either through the AgilePoint Enterprise Manager or the Process Viewer.

http://support.agilepoint.com/SupportPortal/
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To enable the Open Process Adaptation link in the Process Viewer, make the following modification
to the AgilePoint Web application's web.config file:

<appSettings>
         <add key="ProcessAdaptationUrl"  
              value="http://[hostname]:[port]/EnterpriseManager/
ProcessAdaptation/LinkedTasks.aspx"/> 
</appSettings>

The value for the Process Adaptation is the URL of the process adaptation URL in AgilePoint
Enterprise Manager.

For the Process Viewer in SharePoint using InfoPath, add the key entry into the SharePoint
Web.config at C:\Inetpub\wwwroot\wss\VirtualDirectories\8000\web.config.

Properties for This AgilePart

Field Name Definition

UserDefinedProperties This property allows the process modeler to
configure initial ClientData values that will be
associated with the AgileShape's associated
task(s) at runtime. This is basically a way of
allowing you to specify a set of name/value
pairs that are passed to your Web page via an
object called a WorkItem. This is an alternative to
passing data via URL parameters. In your Web
page you can retrieve this data via the ClientData
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Field Name Definition

property of the WorkItem. It is then up to you to
decide how to use the data.

Click the Ellipses button to open the
configuration dialog.

 

 

Voting Configuration This property allows the process modeler to
configure data binding to the data schema within
a repeating table for which to establish the
approval data.

The "Mandatory" option provides an added level
of functionality, requiring any participants that
have been identified as "Mandatory" to approve,
or the final decision will be not-approved. The
final result is also configured here by setting
a custom attribute to store the final result and
specifying the percentage of participants that
will need to approve before the final decision
is considered as approved. For example, the
process designer specifies the voting percentage
as 60%. If 60% of the approvers approve the
preceding request, then the final decision is
considered as approved.

Click the Ellipses button to open the
configuration dialog.
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Field Name Definition

 

ApprovalType The property can be set to Sequential or Parallel
at design time. This property determines a
runtime whether the task will be delivered in a
sequential or parallel fashion to the participants
of the task. This can be changed at runtime via
AgilePoint Enterprise Manager or the Process
Viewer.

Sequential means that the task will be delivered
in a sequential fashion to 1 participant at a time.

Parallel means that all the tasks will be delivered
to each of the participants at the same time,
there is no particular order for which the task is
assigned to the participants.

UpdateCustomAttribute This property allows the process modeler to
configure an update to a custom attribute value
based on an event type.
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AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

Update Custom Attributes
This AgileShape can be used to update the runtime value(s) of one or more custom process attributes.
When using this shape, you specify the name(s) of one or more custom process attributes, and
associate a snippet/fragment of C# code with each attribute name. At runtime, each snippet will be
executed/evaluated to determine the value that will be assigned to the associated custom process
attribute.

This AgilePart essentially allows you to create and embed a simple custom AgilePart in your process,
without actually having to create, name, compile, deploy, or register the AgilePart. 

Properties for This AgilePart

Field Name Definition

Configuration This property allows the process modeler
to configure the code snippet(s) that will be
invoked at runtime, as well as the custom
process attribute(s) that the return value(s) of
the snippet(s) will be stored in. Click the Ellipses
button to open the configuration dialog. After
clicking the Add button, entering an attribute
name and a code snippet, and then clicking the
View Code button, the dialog might look like this:

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Update Parent Process
This AgileShape can be used to update the values of one or more custom process attributes in a
separate process instance.

Properties for This AgilePart

Field Name Definition

Attributes This property allows the process modeler to
update the values of one or more custom process
attributes in a separate process instance (see
ParentProcessID). Click the Ellipses button to
open the configuration dialog.

 

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

 

ParentProcessID Default value: $ParentProcessID

This property specifies the Process ID of the
process instance containing the custom process
attributes that should be updated.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Vote
This AgileShape can be used when a group of approvers is involved at an activity step, you can
configure the AgileWork to require mandatory approvals from certain participants and to move forward
based on a certain percentage of approves that have approved.

Properties for This AgilePart

Field Name Definition

UserDefinedProperties This property allows the process modeler to
configure initial ClientData values that will be
associated with the AgileShape's associated
task(s) at runtime. This is basically a way of
allowing you to specify a set of name/value
pairs that are passed to your Web page via an
object called a WorkItem. This is an alternative to

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

passing data via URL parameters. In your Web
page you can retrieve this data via the ClientData
property of the WorkItem. It is then up to you to
decide how to use the data.

Click the Ellipses button to open the
configuration dialog.

 

 

Voting Configuration This property allows the process modeler to
configure data binding to the data schema within
a repeating table for which to establish the
approval data.

The "Mandatory" option provides an added level
of functionality, requiring any participants that
have been identified as "Mandatory" to approve,
or the final decision will be not-approved. The
final result is also configured here by setting
a custom attribute to store the final result and
specifying the percentage of participants that
will need to approve before the final decision
is considered as approved. For example, the
process designer specifies the voting percentage
as 60%. If 60% of the approvers approve the
preceding request, then the final decision is
considered as approved.

Click the Ellipses button to open the
configuration dialog.

 



AgileShapes 77

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

Field Name Definition

 

EnabledExchangeServer Default value: False

This property allows the process modeler to
enable the AgileShape to integrate directly
with Microsoft Exchange Server so that the
AgileShape's associated task(s) can be viewed
directly from Microsoft Outlook's Task List by the
task(s)'s assigned participant(s).

See the ExchangeServer property for additional
information.

ExchangeServer This property allows the process modeler to
configure the AgileShape's integration with
Microsoft Exchange Server. When properly
enabled and configured, the AgileShape will then
insert, update, and remove Task items for the
task's assigned participants, so that the tasks can
be viewed directly from Microsoft Outlook.

Click the Ellipses button to open the
configuration dialog.
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See the EnabledExchangeServer property for
additional information.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

Web Form
This AgileShape can be used to represent a manual (i.e. human input required) activity that uses a
Web page as the user interface for the activity. Since the associated Web page's URL is configurable
(and can include URL parameters), one common use of this AgileShape is to associate several
different activities with the same Web page. Each activity (i.e. each AgileShape instance) can pass
different input to the Web page (via URL parameters) in order to make the Web page initialize
appropriately for each individual activity. 

Another feature of the WebForm shape is that it lets you configure "User Defined Properties". This is
basically a way of allowing you to specify a set of name/value pairs that are passed to your Web page
via an object called a WorkItem. This is an alternative to passing data via URL parameters. In your
Web page you can retrieve this data via the ClientData property of the WorkItem. It is then up to you to

http://support.agilepoint.com/SupportPortal/
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decide how to use the data. Another feature of the WebForm shape is that it has the ability to integrate
with Microsoft Exchange. The User's Guide has some explanation on this.

Properties for This AgilePart

Field Name Definition

UserDefinedProperties This property allows the process modeler to
configure initial ClientData values that will be
associated with the AgileShape's associated
task(s) at runtime. This is basically a way of
allowing you to specify a set of name/value
pairs that are passed to your Web page via an
object called a WorkItem. This is an alternative to
passing data via URL parameters. In your Web
page you can retrieve this data via the ClientData
property of the WorkItem. It is then up to you to
decide how to use the data.

Click the Ellipses button to open the
configuration dialog.

 

 

WebFormControls This property provides control over the display of
custom Web Form. Controls that are used in the
form.

• Disable - The control will be visible, but not
editable.

• Enable - The control will be visible and
editable.
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• Invisible - The control will not be visible.

 

 

WebPageUrl Required

This property specifies the URL of the Web
page associated with this AgileShape. This
property will be used at runtime to determine
the (absolute) URL that will be associated with
individual activity instances. This URL will be
displayed in the AgilePoint TaskList WebControl
(if it is used). See the Manual AgileShape for
more information about how URLs associated
with manual activities are displayed in task lists.
The way the URL is derived at runtime depends
on the way this property's value is configured, as
described below:

• A Relative URL - An ASP.NET application-
relative URL can be used by specifying a
URL that starts with a slash.

E.g.: /doc/review.aspx?a=1&b=2

The location of the ASP.NET application is
derived in the same way as described under
the documentation of the Work To Perform
property of the Manual AgileShape.

• An Absolute URL - An absolute URL which
provides the full path to the Web page can
be used. E.g. The following value specifies
an absolute URL with three URL parameters.
The values of two of the parameters are
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initialized by custom process attributes ($
\{itemid\} and $\{qty\}) at runtime, and the
third is initialized to a hard coded value.

http://www.tusca.com/MyPage.aspx?item=$
\{itemid\}&quantity=$\{qty\}&express=no Click
the button to open the configuration dialog.

Click the Ellipses button to open the
configuration dialog.

 

 

Work To Perform Required

This property specifies the name of the task
associated with this AgileShape. This name
is displayed to the end user when a human-
readable label is needed (as opposed to the
WebPageUrl property, which specifies the actual
location/URL of the AgileShape's Web page).

Unlike most of the properties that this AgileShape
has in common with the Manual AgileShape,
this property functions very differently for the two
AgileShapes. The Work To Perform property
of both the Manual and WebForm shapes
represents the name of the activity that will be
displayed on a user's task list. For the Manual
shape, if the user interface is implemented in
a Web page then the WorkToPerform property
is used as the name of the Web page with an
implied extension of ".aspx". The WebForm
shape does not use the WorkToPerform property
as the Web page name. Instead, it uses the
WebPageUrl property. This property gives you
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some enhanced capabilities such as being able
to define full or relative URL paths as well as
pass URL parameters.

For example, in the Manual shape you may
specify the WorkToPerform as "Approve".
This implies that the Web page to run is
"Approve.aspx". In the WebForm shape, you can
specify an absolute WebPageUrl like this:

http://machine:port/AppName/Subfolder/
Approve.aspx?param1=value1&param2=value2

or relative like this:

Subfolder/Approve.aspx?
param1=value1&param2=value2

The main reason you might want to use URL
parameters is so that you can send instructions
to the page telling it to behave a certain way.
For example, you might want the page to display
certain data and controls only if there is a certain
URL parameter.

EnabledExchangeServer Default value: False

This property allows the process modeler to
enable the AgileShape to integrate directly
with Microsoft Exchange Server so that the
AgileShape's associated task(s) can be viewed
directly from Microsoft Outlook's Task List by the
task(s)'s assigned participant(s).

See the ExchangeServer property for additional
information.

ExchangeServer This property allows the process modeler to
configure the AgileShape's integration with
Microsoft Exchange Server. When properly
enabled and configured, the AgileShape will then
insert, update, and remove Task items for the
task's assigned participants, so that the tasks can
be viewed directly from Microsoft Outlook.

Click the Ellipses button to open the
configuration dialog.
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See the EnabledExchangeServer property for
additional information.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

SharePoint / Microsoft SPS
This section describes the AgileShapes in the SharePoint and Microsoft SPS stencils. This stencil is to
be used with the AgilePoint SharePoint Integration.

Add User to SP Group
This AgileShape can be used to automatically add a user to a SharePoint Group.

http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

CopyProcessInformation Opens the CopyListItemsConfiguration dialog box
specifies the configuration for copying list items.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Configuration for Copy ListItems AgilePart
Specifies the configuration for copying list items.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Source Site URL Specifies the name of the list that includes the
affected (copied, moved, etc.) list items.

Source List Name Specifies the source SharePoint site URL that
includes the list for which items are to be affected
(copied, moved, etc.).

Source Folder Name Specifies the name of the folder that includes the
list items to be affected (copied, moved, etc.).

ListItem Field Name Specifies the name of the list item field to be
affected (copied, moved, etc.).

ListItem Field Value Specifies the value of the field to be affected
(copied, moved, etc.). This can be used as a
filtering mechanism where only fields with the
specified value are affected. The following are
sample values:

• $\{ListItemID\} or $\{SubListItemID\}

• list item ID

Target List Name Specifies the name of the destination list for the
affected items.

Target Folder Name Specifies the name of the destination folder for
the affected items. If the folder does not exist the
system will automatically create it.

Target Site URL Specifies the target SharePoint site URL that
includes the destination list for the affected items.

Approve
This AgileShape is essentially identical to the Manual AgileShape, except that its Work To Perform
property defaults to the value Approve, and it has a different visual appearance in the process
template. This AgileShape is provided simply for the convenience of the process modeler.
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Properties for This AgilePart

Field Name Definition

None This AgileShape has no unique design time
properties.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

Approved
A single condition activity to check the custom attribute of Approved. This AgileShape is essentially
identical to the SingleCondition AgileShape, except that its PropertyBinding property defaults to the
value Approved. This AgileShape is provided simply for the convenience of the process modeler.

Properties for This AgilePart

Field Name Definition

PropertyBinding ReadOnly

Default value: Chosen by the user when the
AgileShape is first added to the process template.

The data binding expression that is used to
evaluate the value of the condition at runtime.

PropertyType The data type that the data binding expression
(see PropertyBinding) evaluates to at runtime.
This property can be set to the following specific
values:

• Integer

• String

• DateTime

• Double

• Short

• Float

http://support.agilepoint.com/SupportPortal/
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• Decimal

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Approve Reject Content
This AgileShape can be used to automatically approve or reject a document.

Properties for This AgilePart

Field Name Definition

ApprovalType The property can be set to Sequential or Parallel
at design time. This property determines a
runtime whether the task will be delivered in a
sequential or parallel fashion to the participants
of the task. This can be changed at runtime via
AgilePoint Enterprise Manager or the Process
Viewer.

Sequential means that the task will be delivered
in a sequential fashion to 1 participant at a time.

Parallel means that all the tasks will be delivered
to each of the participants at the same time,
there is no particular order for which the task is
assigned to the participants.

DocumentURL The URL location of the affected file (for example,
the file you want to add, delete, check out, etc.).

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

CAML Query
This AgileShape can be used to create a SharePoint view based on available fields using a CAML
query. You can use the CAML Query Builder AgilePart to create your CAML query, and your view.

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

Configuration Opens the CAML Query Configuration dialog box,
where you can configure a CAML query.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

CAML Query Configuration
Use this window to configure a CAML query.

http://support.agilepoint.com/SupportPortal/


AgileShapes 89

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

To configure the CAML query and create your view from available fields:

1. Enter the site URL in the Site Url text box and click Connect. The various Lists and Document
libraries are loaded in the List Name drop-down.

2. Select Show hidden fields if you want to use the SharePoint hidden fields in the CAML Query.

3. Select the List. All the columns in the selected list will be loaded in the Possible View Fields box.

4. Move the required columns to the Configured View Fields list.

5. Configure the Where clause by selecting a nest type -- And or Or.

6. Select the columns required for the condition.

7. Select the Column to order the data by and the Sort Type.

8. Click the Query Options tab, and select options such as the maximum number of rows (Row
Limit), whether to include mandatory columns, Folder location and Group By Column.

9. Click the Output Mapping tab, and map the nodes from SharePoint column to the InfoPath
schema.

If the output type is an InfoPath form, the results from the operations performed by the CAML Query
AgilePart are automatically updated in the InfoPath form. The following conditions apply:

• The InfoPath form must have a repeating table which can be mapped to the row node.

• The columns must be mapped to this repeating table.

• The ItemCount node will contain the number of rows returned by the CAML Query. This can also
be mapped if required.

Check In File
This AgileShape can be used to automatically check in a file to a SharePoint document library and
make it available to others.

Properties for This AgilePart

Field Name Definition

CheckinType The check in type. MinorCheckin may mean that
the file is in draft status, MajorCheckIn may mean
the file is ready to publish, OverwriteCheckIn will
overwrite the file if it already exists.

Comments Any comments to be associated with the action.

DocumentURL The URL location of the affected file (for example,
the file you want to add, delete, check out, etc.).
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Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Check Out File
This AgileShape can be used to automatically check out a file from a SharePoint document library and
make it unavailable for others to edit.

Properties for This AgilePart

Field Name Definition

CheckoutToLocal Select True if you want to work on a copy of the
file on your hard disk. If you want the draft copy
to be stored on the server while it is checked out
to you, select False.

DocumentURL The URL location of the affected file (for example,
the file you want to add, delete, check out, etc.).

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Common Dialog
This AgileShape can be used to create a dialog box form in SharePoint. The most common use for
this AgileShape is creating simple input or approval forms. Once you have created a Common Dialog
and deployed your process, the dialog displays to a user when he or she clicks a task in SharePoint.
The following image shows an approval form using a Common Dialog.

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

Configuration Opens the Customize Common Dialog Interface
dialog box, where you can configure the dialog
box you want to display in SharePoint.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

Customize Common Dialog Interface Window
This window allows you to configure the dialog box you want to display in SharePoint.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Dialog Title The title that appears in the title bar of the dialog
box.

Dialog Icon An icon that appears at the top of the dialog box.

Dialog Description A text description that at the top of the dialog box.

Submit Button Label The text that appears on the button that submits
the form on the dialog box and closes the dialog
box. (The text is "OK" by default in Windows.)

Cancel Button Label The text that appears on the button that closes
the dialog box without submitting the form. (The
text is "Cancel" by default in Windows.)

Data Configuration tab Opens the Data Configuration tab, which enables
you to define the fields on the form.

Schema The schema for the current process is displayed
in the left pane. Drag and drop schema fields in
the right pane to add them to the dialog box.

Label The name that appears for the field in the dialog
box. By default, this is the same as the field
name, but this can be changed.

Name The name of the field as it appears in the
schema. This name is read-only.

ReadOnly When selected, indicates that the field is read-
only in the dialog box.

Input Type The type of input field that appears on the dialog
box.

> (Data Binding) Opens a pop-up that enables you to modify the
data binding for the field.

Up Arrow Moves a field up in the list.

Down Arrow Moves a field down in the list.

X Deletes a field from the dialog box.
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Copy Files AgilePart
This AgileShape can be used to automatically copy one or more files from one SharePoint library (or
folder) to another SharePoint library (or folder).

Properties for This AgilePart

Field Name Definition

CopyProcessInformation This property specifies whether to copy certain
process related data with the file.

Filter This property specifies the filename (or a
filename filter containing wildcards) that will
be acted upon -- for example, downloaded by
the Download Files AgilePart, uploaded by the
Upload Files AgilePart, or converted to PDF by
the Convert to PDF AgilePart.

The action is taken in the location specified
by the associated URL -- either Local Path or
AbsoluteURL, depending upon the AgileShape.
If the location is a folder, only the specified file
types will be acted upon.

Some examples of possible values for this
property are listed below:

• *.* - This value indicates that all files (located
at the source location) will be affected.

• *.XML - This value indicates that all files
(located at the source location) that have the
".XML" file extension will be affected.

• *.doc - This value indicates that all files
(located at the source location) that have the
".DOC" file extension will be affected.

• MyFile.xml - This value indicates that
only the specific file (located at the source
location) named MyFile.xml will be affected.

OverWriteFile Default value: False

This property specifies whether the AgileShape
should overwrite the existing file(s) if they already
exist at the specified destination.

This property can be set to the following specific
values:
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• False - This value indicates that the
AgileShape will not overwrite any existing
file(s).

• True - This value indicates that the
AgileShape will overwrite any existing file(s).

Recursive Default value: False

This property specifies whether the AgileShape
should affect files contained in any subfolders
located under the library (or folder) in the
specified location.

This property can be set to the following specific
values:

• False - This value indicates that the
AgileShape will only affect files located in the
specified folder only.

• True - This value indicates that the
AgileShape will affect files located directly
under the specified folder, and also files in
any subfolders.

SourceFolderURL Default value: ${SPServer}/${SitePath}/
${DocLibPath}

This property specifies the URL of the SharePoint
document library (or subfolder) the file(s) should
be copied from.

E.g. http://MachineName:Port/sites/SiteName/
DocumentLibraryName

-or-

http://MachineName:Port/sites/SiteName/
DocumentLibraryName/FolderName

TargetFolderURL This property specifies the URL of the SharePoint
document library (or subfolder) the file(s) should
be copied to.

E.g. http://MachineName:Port/sites/SiteName/
DocumentLibraryName

-or-

http://MachineName:Port/sites/SiteName/
DocumentLibraryName/FolderName
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Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Copy List Item
This AgileShape can be used to copy custom list items from one list to another.

Properties for This AgilePart

Field Name Definition

CopyProcessInformation Opens the CopyListItemsConfiguration dialog box
specifies the configuration for copying list items.

AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Configuration for Copy ListItems AgilePart
Specifies the configuration for copying list items.

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Source Site URL Specifies the name of the list that includes the
affected (copied, moved, etc.) list items.

Source List Name Specifies the source SharePoint site URL that
includes the list for which items are to be affected
(copied, moved, etc.).

Source Folder Name Specifies the name of the folder that includes the
list items to be affected (copied, moved, etc.).

ListItem Field Name Specifies the name of the list item field to be
affected (copied, moved, etc.).

ListItem Field Value Specifies the value of the field to be affected
(copied, moved, etc.). This can be used as a
filtering mechanism where only fields with the
specified value are affected. The following are
sample values:
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• $\{ListItemID\} or $\{SubListItemID\}

• list item ID

Target List Name Specifies the name of the destination list for the
affected items.

Target Folder Name Specifies the name of the destination folder for
the affected items. If the folder does not exist the
system will automatically create it.

Target Site URL Specifies the target SharePoint site URL that
includes the destination list for the affected items.

Create List Item
This AgileShape can be used to create a list item.

Properties for This AgilePart

Field Name Definition

ItemValues Opens the Configuration for Creating List Item
window, where you can specify the configuration
for creating the list item.

AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Configuration for Creating List Item Window
Specifies the configuration for creating the list item.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

List URL Specifies the URL for the associated SharePoint
list. A valid list URL is required, if a library URL
(such as document library URL or form library
URL) instead of a list URL is used, an error will
occur during execution. Below are examples of a
valid list URL:

• http://Machine_Name:port/sites/SiteName/
ListName

• ${DocUrl}

After entering the list URL, click the Connect
button. Now a Content Type can be selected.
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Content Type Specifies the Content Type for the list item. This
is an optional item, the system will get a default
Content Type for the configuration.

Folder Name Specifies the folder name under which a list item
will be affected (created, deleted, etc.). There are
two ways to specify a folder:

• Select a Folder Name from the drop-down
list.

• Input a Folder Name in the drop-down list, if
the list doesn't contain the folder, the system
will create it automatically.

After the first section is completed, all columns
(with the exception of read-only columns, e.g.,
Calculate) in the selected list are shown. The
Value column shows the Data Type of the
column. If the value is Text, input is to be a string,
if it is DateTime, input is to be a valid date, etc.
There are 4 ways to set the Value column:

• Input a value (string value or datetime value
etc.) or empty.

• Input a custom attribute name ${FuLLName}.

• Click the button at the right side to select
schema metadata associated with the
process model.

• The Attachment field allows you to attach
a file to the list item, there are 2 ways to do
this:

• Local machine path, such as c:
\FileName.Extension.

• Http path, such as Http://Url /
FileName.Extesion.

Create SP Group
This AgileShape can be used to automatically add a user to a SharePoint Group.
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Properties for This AgilePart

Field Name Definition

GroupConfiguration Opens the Create Group Configuration window,
where you can configure the new group details to
be created in SharePoint.

AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Create Group Configuration Window
This property allows you to configure the new group details to be created in SharePoint.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

SiteURL This property specifies the URL for the new
where you want to add or remove the associated
item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}

Group Name The name of the affected SharePoint Group (e.g.,
the group to be created, to be deleted, to which a
user will be added, etc.).

Group Owner The domain and user name of the SharePoint
user who is to be the owner of the group.

Group Description A description of the group.

Delete Files
This AgileShape can be used to automatically delete files from a SharePoint document library.

Properties for This AgilePart

Field Name Definition

DocumentLibraryURL The SharePoint document library URL where you
would like to delete files.

Filter This property specifies the filename (or a
filename filter containing wildcards) that will
be acted upon -- for example, downloaded by
the Download Files AgilePart, uploaded by the
Upload Files AgilePart, or converted to PDF by
the Convert to PDF AgilePart.

The action is taken in the location specified
by the associated URL -- either Local Path or
AbsoluteURL, depending upon the AgileShape.
If the location is a folder, only the specified file
types will be acted upon.
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Some examples of possible values for this
property are listed below:

• *.* - This value indicates that all files (located
at the source location) will be affected.

• *.XML - This value indicates that all files
(located at the source location) that have the
".XML" file extension will be affected.

• *.doc - This value indicates that all files
(located at the source location) that have the
".DOC" file extension will be affected.

• MyFile.xml - This value indicates that
only the specific file (located at the source
location) named MyFile.xml will be affected.

Recursive Default value: False

This property specifies whether the AgileShape
should affect files contained in any subfolders
located under the library (or folder) in the
specified location.

This property can be set to the following specific
values:

• False - This value indicates that the
AgileShape will only affect files located in the
specified folder only.

• True - This value indicates that the
AgileShape will affect files located directly
under the specified folder, and also files in
any subfolders.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Delete List Item
This AgileShape can be used to delete one or more list items.

http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

DeleteListItemsConfiguration Opens the Configuration for Deleting List
Items dialog box, where you can specify the
configuration for deleting list items.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Configuration for Deleting List Items Window
This window enables you to specify the configuration for deleting list items.

Field Definitions

Field Name Definition

SiteURL This property specifies the URL for the new
where you want to add or remove the associated

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}

List Name Specifies the name of the list where the list items
will be deleted.

Folder Name Specifies the folder name under which a list item
will be affected (created, deleted, etc.). There are
two ways to specify a folder:

• Select a Folder Name from the drop-down
list.

• Input a Folder Name in the drop-down list, if
the list doesn't contain the folder, the system
will create it automatically.

After the first section is completed, all columns
(with the exception of read-only columns, e.g.,
Calculate) in the selected list are shown. The
Value column shows the Data Type of the
column. If the value is Text, input is to be a string,
if it is DateTime, input is to be a valid date, etc.
There are 4 ways to set the Value column:

• Input a value (string value or datetime value
etc.) or empty.

• Input a custom attribute name ${FuLLName}.

• Click the button at the right side to select
schema metadata associated with the
process model.

• The Attachment field allows you to attach
a file to the list item, there are 2 ways to do
this:

• Local machine path, such as c:
\FileName.Extension.

• Http path, such as Http://Url /
FileName.Extesion.
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ListItem Field Name Specifies the name of the list item field to be
deleted. This allows you to delete only one field
from a list item.

ListItem Field Value Specifies a value for which all corresponding
fields will be deleted. This can be used as a
filtering mechanism where only fields with the
specified value are deleted.

Delete Particular File Version
This AgileShape can be used to automatically delete a major or minor version of a file from a
SharePoint document library.

Properties for This AgilePart

Field Name Definition

DeleteFileVersionConfiguration Opens the Delete a particular version of a file
window, where you can configure the file version
you want to delete. Click the Ellipses button
to open the Delete a particular version of a file
dialog box.

AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Delete a Particular Version of a File Window
This property enables you to configure the file version you want to delete. Click the Ellipses button to
open and delete a particular version of a file dialog box.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Document URL The URI of the file for which you want to delete a
version.

Version number of file to be deleted The URI of the file for which you want to delete a
version.

Download Files
This AgileShape can be used to automatically download one or more files from a SharePoint library to
the local file system (of the AgilePoint Server machine).

Properties for This AgilePart

Field Name Definition

AbsoluteURL This property specifies the complete target URL.

E.g. http://MachineName:Port/sites/SiteName/
DocumentLibraryName/FolderName

Filter This property specifies the filename (or a
filename filter containing wildcards) that will
be acted upon -- for example, downloaded by
the Download Files AgilePart, uploaded by the
Upload Files AgilePart, or converted to PDF by
the Convert to PDF AgilePart.
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The action is taken in the location specified
by the associated URL -- either Local Path or
AbsoluteURL, depending upon the AgileShape.
If the location is a folder, only the specified file
types will be acted upon.

Some examples of possible values for this
property are listed below:

• *.* - This value indicates that all files (located
at the source location) will be affected.

• *.XML - This value indicates that all files
(located at the source location) that have the
".XML" file extension will be affected.

• *.doc - This value indicates that all files
(located at the source location) that have the
".DOC" file extension will be affected.

• MyFile.xml - This value indicates that
only the specific file (located at the source
location) named MyFile.xml will be affected.

LocalPath This property specifies the local file system folder
that is the destination location for the AgilePart's
action (for example, upload or download a file).

The value of this property should be a relative
path that specifies the location of the folder
relative to the AgilePoint Server application's root
directory.

E.g. If AgilePoint Server is installed at:

c:\\Inetpub\\wwwroot\\AgilePointServer\\

and the file (once downloaded) should be located
at:

c:\\Inetpub\\wwwroot\\AgilePointServer\\files\
\MyFile.txt

then this property should be set to the following
value: files

E.g. If AgilePoint Server is installed at: c:\\Inetpub
\\wwwroot\\AgilePointServer\\

and the file (once downloaded) should be located
at:

c:\\Inetpub\\wwwroot\\AgilePointServer\\files\
\temp\\MyFile.txt
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then this property should be set to the following
value: /files/temp/

OverWriteFile Default value: False

This property specifies whether the AgileShape
should overwrite the existing file(s) if they already
exist at the specified destination.

This property can be set to the following specific
values:

• False - This value indicates that the
AgileShape will not overwrite any existing
file(s).

• True - This value indicates that the
AgileShape will overwrite any existing file(s).

Recursive Default value: False

This property specifies whether the AgileShape
should affect files contained in any subfolders
located under the library (or folder) in the
specified location.

This property can be set to the following specific
values:

• False - This value indicates that the
AgileShape will only affect files located in the
specified folder only.

• True - This value indicates that the
AgileShape will affect files located directly
under the specified folder, and also files in
any subfolders.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Excel Calculate
This AgileShape unleashes the full power of Excel Services as a calculation engine. It is the
combination of the other two methods and permits both writing (temporarily or permanently) and
reading from an Excel document in the same step. In this case, the Save To field is not a required
parameter, but instead it is optional.

http://support.agilepoint.com/SupportPortal/
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The following is a use case:

Here is a simple InfoPath-based Process that uses the three methods of the AgilePart:

The example process is to demonstrate the different uses of the AgilePart. It is not necessary to use
all the methods in the same process. Steps to set this up are as follows:

Create InfoPath file

Create the form:
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Save form as ExcelServicesDemo.xsn

Prepare Excel Template, create an Excel document with the right structure:
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Save the Excel document as ExcelServicesDemo.xlsx on the Desktop.

Create two SharePoint Doc Libraries to store the run-time Excel template and the resultant Excel file:
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Call first one ExcelRuntimeTemplates:
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Browse to the Excel file ExcelServicesDemo.xlsx on the Desktop and upload it to the document
library. (Another method is to Publish the Excel from within Excel itself.)
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Create second Doc library to store resultant Excel file:

Design the Process. Design a new InfoPath process based on ExcelServicesDemo.xsn form.
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Register the Excel Services AgilePart in Envision. File->Extend AgilePoint->Register AgilePart.

Copy the Excel Services.vss file to My Documents\\My Shapes directory.

Open the Excel Services stencil in Envision.

Drag an Excel Write shape on to the canvas.

Configure the shape as shown below:

In the example, the SharePoint URL is http://moss.litwareinc.com. You should substitute it with your
own site URL.

Use the Browse button to select the Design-time Template Excel document from the Desktop. The
named fields list box gets filled automatically.
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Type the URL of a SharePoint Doc Library in the Save To field. In this example it is http://
moss.litwareinc.com/ExcelServicesDemoLib If the document library does not exist, it will NOT be
created.

Click the ellipsis button, and select the form field SaveWrite.

Add the extension .xlsx.

Configure the mappings: Select named field ExcelField1 from the list and press the arrow button
shown in red:

Do the same for the other named fields. Now select the first row of the mapping grid and press ellipsis
button as shown in red below:
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Select field1 from the schema dialog:

Repeat last two steps for all the other fields.

Manually change the XPath value for the Repeating Field Type 2 to: (XPATH)/my:myFields/
my:RepeatingGroup[my:field5='Type 2']/my:field6
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Press OK to finish configuring this Shape. Now to add a step in the process to read from an Excel
document.

Drag an Excel Read shape on to the canvas:

Open the Configuration dialog and fill as shown:

Now to add another step in the process to write and read from an Excel document:

Drag an Excel Calculate shape on to the canvas.

In the Configuration dialog, set fields as shown:
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For the Read tab configure as shown:

For the last step, add Update InfoPath shape and configure as shown:
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Publish Process and InfoPath to ExcelServicesDemo:

Initiate a Process.

Click New in the form Library ExcelServicesDemo.

Fill as shown and click Submit and Close:
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The process runs automatically.

Revising the results of running the process. Open the form just submitted and should see this:
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Click the Open SharePoint Library link to open ExcelServicesDemoLib.

Open the Excel document created by first AgilePart to check it is correctly filled:
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Check that the third AgilePart in the process has created an Excel file in C:\\SaveToDir\\CC.xlsx
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Properties for This AgilePart

Field Name Definition

Configuration Opens the Excel Calculate Configuration dialog
box, where you can configure an Excel calculate
action.

Mappings In order to update the named fields in the Excel
sheet, they need to be mapped to the process
values here.

The named fields appear in the list box on the
right and can be mapped to, by selecting them
first and then pressing the arrow button.

Once a named field is in the mapping grid on
the left, in order to map it to a process value,
first select the row and then press the ellipsis
button to select from the schema dialog for the
process or type a custom attribute directly in the
ProcessValue column.
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Field Name Definition

If the file in Design-time Template changes, then
it is necessary to press the Refresh button to
reload the named fields again.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Excel Calculate Configuration Window
This window enables you to configure an Excel calculate action

Field Definitions

Field Name Definition

Excel Services URL (Required) The URL of the Excel Service.

For example http://moss.litwareinc.com/_vti_bin/
ExcelService.asmx

This could include custom attributes like $
\{SharePointURL\}$\{ExcelService\}. Also schema
XPaths can be added using the ellipsis button.

Runtime Template (Required) The Excel template that will be used at run-
time (either .xlsx or .xltx). This document will be
copied to the location as defined by the Save To
parameter.

This could be custom attributes like $
\{SharePointURL\}$\{RuntimeTemplateLibrary\}$
\{ExcelFilename\}. Also schema XPaths can be
added using the ellipsis button.

This file should be equivalent to the Design-time
Template file with the same named fields.

This document should be located in either a
SharePoint Doc Library or in a shared folder.
Either way, this must be added to the Trusted
file locations of the Excel Services (configured
in SharePoint Central Administration - Shared
Services):

 

http://support.agilepoint.com/SupportPortal/
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Field Name Definition
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Field Name Definition

 

Design Time Template (Required) Excel template to use at design-time. This
template document is loaded at design-time to
get access to all the named fields in the Excel
sheet for mapping purposes. It is not used at run-
time.

This file should be equivalent to the Run-time
Template file with the same named fields. Also,
while designing in Envision, the file should be
accessible to the Process Designer from his/her
PC via the Browse button.

Save To (Required) The path and filename for saving the resulting
Excel document. This can be in a SharePoint
Doc library or in a directory path. This could
also be an expression like $\{SharePointURL
\}$\{ExcelDocLibrary\}$\{ExcelFilename\}. Also
schema XPaths can be added using the ellipsis
button.

Overwrite if Exists Overwrite the Save To file if it already exists.
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Excel Read
This AgileShape can be used to read data from an Excel document and store the values in custom
attributes to be used in the process.

The configuration is similar to that of WriteExcelDocument except there is no "Save To" field and there
is a "Read" tab in Mappings, instead of a Write tab.

Properties for This AgilePart

Field Name Definition

Configuration Opens the Excel Read Configuration dialog box,
where you can configure an Excel read action.

Mappings For example, to read the value in the named
field called ExcelResult into a custom attribute
called ProcessResult, set the two mapping
columns respectively. The Formatted check
box, if set, indicates that the Formatted Value
of the cell should be read instead of the Value.
For example, a Currency type cell, would return
€1,023.34 rather than 1023.34. This is useful for
situations where Formatted values of numbers or
dates are needed to be included in, say emails.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Excel Read Configuration Window
This window enables you to configure an Excel read action

Field Definitions

Field Name Definition

Excel Services URL (Required) The URL of the Excel Service.

For example http://moss.litwareinc.com/_vti_bin/
ExcelService.asmx

http://support.agilepoint.com/SupportPortal/
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This could include custom attributes like $
\{SharePointURL\}$\{ExcelService\}. Also schema
XPaths can be added using the ellipsis button.

Runtime Template (Required) The Excel template that will be used at run-
time (either .xlsx or .xltx). This document will be
copied to the location as defined by the Save To
parameter.

This could be custom attributes like $
\{SharePointURL\}$\{RuntimeTemplateLibrary\}$
\{ExcelFilename\}. Also schema XPaths can be
added using the ellipsis button.

This file should be equivalent to the Design-time
Template file with the same named fields.

This document should be located in either a
SharePoint Doc Library or in a shared folder.
Either way, this must be added to the Trusted
file locations of the Excel Services (configured
in SharePoint Central Administration - Shared
Services):
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Field Name Definition

 
 

 

Design Time Template (Required) Excel template to use at design-time. This
template document is loaded at design-time to
get access to all the named fields in the Excel
sheet for mapping purposes. It is not used at run-
time.

This file should be equivalent to the Run-time
Template file with the same named fields. Also,
while designing in Envision, the file should be
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accessible to the Process Designer from his/her
PC via the Browse button.

Excel Write
This AgileShape can be used to create and afterwards modify an Excel document based on an
Excel template. The resultant document can be saved either to a SharePoint document library or to a
directory path (local on the server or a shared folder).

Properties for This AgilePart

Field Name Definition

Configuration Opens the Excel Write Configuration dialog box,
where you can configure an Excel write action.

Mappings In order to update the named fields in the Excel
sheet, they need to be mapped to the process
values here.

The named fields appear in the list box on the
right and can be mapped to, by selecting them
first and then pressing the arrow button.

Once a named field is in the mapping grid on
the left, in order to map it to a process value,
first select the row and then press the ellipsis
button to select from the schema dialog for the
process or type a custom attribute directly in the
ProcessValue column.

If the file in Design-time Template changes, then
it is necessary to press the Refresh button to
reload the named fields again.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Excel Write Configuration Window
This window enables you to configure an Excel write action

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Excel Services URL (Required) The URL of the Excel Service.

For example http://moss.litwareinc.com/_vti_bin/
ExcelService.asmx

This could include custom attributes like $
\{SharePointURL\}$\{ExcelService\}. Also schema
XPaths can be added using the ellipsis button.

Runtime Template (Required) The Excel template that will be used at run-
time (either .xlsx or .xltx). This document will be
copied to the location as defined by the Save To
parameter.

This could be custom attributes like $
\{SharePointURL\}$\{RuntimeTemplateLibrary\}$
\{ExcelFilename\}. Also schema XPaths can be
added using the ellipsis button.

This file should be equivalent to the Design-time
Template file with the same named fields.

This document should be located in either a
SharePoint Doc Library or in a shared folder.
Either way, this must be added to the Trusted
file locations of the Excel Services (configured
in SharePoint Central Administration - Shared
Services):
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Design Time Template (Required) Excel template to use at design-time. This
template document is loaded at design-time to
get access to all the named fields in the Excel
sheet for mapping purposes. It is not used at run-
time.

This file should be equivalent to the Run-time
Template file with the same named fields. Also,
while designing in Envision, the file should be
accessible to the Process Designer from his/her
PC via the Browse button.

Save To (Required) The path and filename for saving the resulting
Excel document. This can be in a SharePoint
Doc library or in a directory path. This could
also be an expression like $\{SharePointURL
\}$\{ExcelDocLibrary\}$\{ExcelFilename\}. Also
schema XPaths can be added using the ellipsis
button.

Overwrite if Exists Overwrite the Save To file if it already exists.
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InfoPath View
This AgileShape can be used to represent a manual (i.e. human input required) activity that uses a
view of a Microsoft InfoPath form as the user interface for the activity. One use of this AgileShape is
to associate several different activities with the same view in an InfoPath form. Each activity (i.e. each
AgileShape instance) can be configured in order to make the InfoPath form view initialize appropriately
for each individual activity.

Properties for This AgilePart

Field Name Definition

UserDefinedProperties This property allows the process modeler to
configure initial ClientData values that will be
associated with the AgileShape's associated
task(s) at runtime. This is basically a way of
allowing you to specify a set of name/value
pairs that are passed to your Web page via an
object called a WorkItem. This is an alternative to
passing data via URL parameters. In your Web
page you can retrieve this data via the ClientData
property of the WorkItem. It is then up to you to
decide how to use the data.

Click the Ellipses button to open the
configuration dialog.
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Field Name Definition

ViewController This property allows the process modeler to
configure the InfoPath view. Click the Ellipses
button to open the configuration dialog.

 

 

EnabledExchangeServer Default value: False

This property allows the process modeler to
enable the AgileShape to integrate directly
with Microsoft Exchange Server so that the
AgileShape's associated task(s) can be viewed
directly from Microsoft Outlook's Task List by the
task(s)'s assigned participant(s).

See the ExchangeServer property for additional
information.

ExchangeServer This property allows the process modeler to
configure the AgileShape's integration with
Microsoft Exchange Server. When properly
enabled and configured, the AgileShape will then
insert, update, and remove Task items for the
task's assigned participants, so that the tasks can
be viewed directly from Microsoft Outlook.

Click the Ellipses button to open the
configuration dialog.
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See the EnabledExchangeServer property for
additional information.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

InfoPath Sub Process
This AgileShape is used to provide the flexibility to associate different InfoPath forms for each Sub
Process in a particular process.

Properties for This AgilePart

Field Name Definition

FormLibURL This property specifies the URL of the form
(which must be located in a SharePoint form

http://support.agilepoint.com/SupportPortal/
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library or folder). The value must be an absolute
URL.

Prefix This property specifies the prefix of the InfoPath
file name associated with the sub process.

Sub Process This property specifies the name of the sub
process.

XML Mappings Opens the XML Schema Mappings dialog box,
where you can specify the XML mapping from the
parent process to the child sub-process.

XsnFileUrl The URI of the InfoPath form for the subprocess.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

XML Schema Mappings
This window enables you to map schema nodes from a parent process to a sub-process.

Field Definitions

Field Name Definition

Child The mapped XML schema node for a child
process.

Parent The mapped XML schema node for a parent
process.

Schema Opens the schema associated with the selected
Child or Parent.

Add Creates a new parent/child pair you can map
using the schema mapper.

http://support.agilepoint.com/SupportPortal/
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Remove Removes the selected new parent/child schema
node pair.

List Form
This AgileShape can be used to leverage a SharePoint List as the form UI for manual tasks. This
feature provides an easy way of building forms with different views based on a SharePoint List. A
simple configuration window allows you to determine how fields on the form are displayed to the end-
user (e.g. Editable, Locked, or Hidden). This drastically simplifies the effort and time required to build
UI forms and therefore, building processes has become even easier for business users.

Properties for This AgilePart

Field Name Definition

UserDefinedProperties This property allows the process modeler to
configure initial ClientData values that will be
associated with the AgileShape's associated
task(s) at runtime. This is basically a way of
allowing you to specify a set of name/value
pairs that are passed to your Web page via an
object called a WorkItem. This is an alternative to
passing data via URL parameters. In your Web
page you can retrieve this data via the ClientData
property of the WorkItem. It is then up to you to
decide how to use the data.

Click the Ellipses button to open the
configuration dialog.
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Field Name Definition

 

ListForm Controls Once a SharePoint List is created and associated
to the process model, this property specifies the
view characteristics of each SharePoint List form
field for the selected work to perform view such
as Edit, Lock, and Hide.
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Click the Editable, Read Only, or Hidden field to
make a field editable, read only, or hidden when it
is served to the end user at runtime.

SubmitStep Default value: False

This property should be set to 'True' if the Form is
used as the Submit step (i.e. the first step where
you are creating the list item).

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

http://support.agilepoint.com/SupportPortal/
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Move Files
This AgileShape can be used to automatically move one file from one SharePoint library (or folder) to
another SharePoint library (or folder).

Moving a file from one library to another and then back to its original location will work as long as the
columns on both libraries are the same.

Properties for This AgilePart

Field Name Definition

DocumentURL The URL location of the affected file (for example,
the file you want to add, delete, check out, etc.).

OverWriteFile Default value: False

This property specifies whether the AgileShape
should overwrite the existing file(s) if they already
exist at the specified destination.

This property can be set to the following specific
values:

• False - This value indicates that the
AgileShape will not overwrite any existing
file(s).

• True - This value indicates that the
AgileShape will overwrite any existing file(s).

TargetFolder This property specifies the URL of the SharePoint
document library (or subfolder) the file(s) should
be copied to.

E.g. http://MachineName:Port/sites/SiteName/
DocumentLibraryName

-or-

http://MachineName:Port/sites/SiteName/
DocumentLibraryName/FolderName

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

http://support.agilepoint.com/SupportPortal/
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Move List Item
This AgileShape can be used to move a custom list item from one list to another.

Properties for This AgilePart

Field Name Definition

MoveListItemsConfiguration Opens the MoveListItemsConfiguration dialog
box, where you can specify the configuration for
moving list items from one list to another.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

MoveListItemsConfiguration Window
This window enables you to specify the configuration for moving list items from one list to another.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Source Site URL Specifies the name of the list that includes the
affected (copied, moved, etc.) list items.

Source List Name Specifies the source SharePoint site URL that
includes the list for which items are to be affected
(copied, moved, etc.).

Source Folder Name Specifies the name of the folder that includes the
list items to be affected (copied, moved, etc.).

ListItem Field Name Specifies the name of the list item field to be
affected (copied, moved, etc.).

ListItem Field Value Specifies the value of the field to be affected
(copied, moved, etc.). This can be used as a
filtering mechanism where only fields with the
specified value are affected. The following are
sample values:
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• $\{ListItemID\} or $\{SubListItemID\}

• list item ID

Target List Name Specifies the name of the destination list for the
affected items.

Target Folder Name Specifies the name of the destination folder for
the affected items. If the folder does not exist the
system will automatically create it.

Target Site URL Specifies the target SharePoint site URL that
includes the destination list for the affected items.

New Folder
This AgileShape can be used to automatically create a new folder under an existing SharePoint
document library.

AbsoluteURL

This property specifies the URL where the new folder will be created.

E.g. http://MachineName:Port/sites/SiteName/DocumentLibraryName/FolderName

Properties for This AgilePart

Field Name Definition

AbsoluteURL This property specifies the complete target URL.

E.g. http://MachineName:Port/sites/SiteName/
DocumentLibraryName/FolderName

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

New Form Library
This AgileShape can be used to automatically create a new form library under an existing SharePoint
team site.

http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

FormLibraryName This property specifies the name for the new form
library.

FormTemplateRelativePath This property specifies the location of the
InfoPath form template file (i.e. the XSN file)
that should be associated with the new form
library. The value of this property should be a
relative path that specifies the location of the file
relative to the AgilePoint Server application's root
directory.

E.g. If AgilePoint Server is installed at:

c:\\Inetpub\\wwwroot\\AgilePointServer\\

and the InfoPath form template file is located at:

c:\\Inetpub\\wwwroot\\AgilePointServer\\files\
\MyTemplate.xsn

then this property should be set to the following
value:

/files/MyTemplate.xsn

OverWriteFormLib Default value: False

This property specifies whether the AgileShape
should overwrite the existing form library if one
already exists at the location where the new
library will be created. This property can be set to
the following specific values:

• False - This value indicates that the
AgileShape will not overwrite an existing
SharePoint form library. If this value is
specified and a library already exists, then
SharePoint will not be modified, and this
AgileShape will exit and will update the
appropriate custom process attributes
(specified by the SaveErrorMessageTo and
SaveStatusTo properties).

• True - This value indicates that the
AgileShape will overwrite an existing
SharePoint form library.
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SiteURL This property specifies the URL for the new
where you want to add or remove the associated
item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

New Library
This AgileShape can be used to automatically create a new document library under an existing
SharePoint team site.

Properties for This AgilePart

Field Name Definition

DocumentLibraryName This property specifies the name for the new
document library.

DocumentTemplate This property specifies the SharePoint Document
Template that should be associated with the
new document library. The valid values for this
property are the same as the values listed in the
"New Document Library" page (displayed when
manually creating a new document library in
SharePoint). The portion of the "New Document
Library" page that lists the available values is
shown below.

 

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

 

To make the AgileShape create a new document
library for Microsoft Word documents, you would
use the following value: Microsoft Office Word
document

ListTemplate Default value: STS

This property specifies the name of the
SharePoint List template that will be used to
create the new document library.

This property can be set to the name of any
SharePoint List template. Some common values
are listed below:

• Document Library - This value indicates
that the SharePoint installation's standard
Document Library template should be used.

• Control Document Library - This value
indicates that the Document Control Library
template (installed by the AgilePoint
SharePoint Integration component) should be
used.

OverWriteDocLib Default value: False

This property specifies whether the AgileShape
should overwrite the existing document library if
one already exists at the location where the new
library will be created. This property can be set to
the following specific values:

• False - This value indicates that the
AgileShape will not overwrite an existing
SharePoint document library. If this value
is specified and a library already exists,
then SharePoint will not be modified, and
this AgileShape will exit and will update
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the appropriate custom process attributes
(specified by the SaveErrorMessageTo and
SaveStatusTo properties).

• True - This value indicates that the
AgileShape will overwrite an existing
SharePoint document library.

SiteURL This property specifies the URL for the new
where you want to add or remove the associated
item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

New Site
This AgileShape can be used to automatically create a new SharePoint team site.

The properties below are all required fields in order for the new site to be created. Below is an
example of how these properties can be populated:

http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

ConvertIfThere Default value: False

This property specifies whether the AgileShape
should convert an existing site of the same name
to a new SharePoint site. This property can be
set to the following specific values:

• False - This value indicates that the
AgileShape will not overwrite an existing
SharePoint site. If this value is specified
and a site already exists, then SharePoint
will not be modified, and this AgileShape
will exit and will update the appropriate
custom process attributes (specified by the
SaveErrorMessageTo and SaveStatusTo
properties).

• True - This value indicates that the
AgileShape will overwrite an existing
SharePoint site.

Locale This property specifies the locale code for the
new SharePoint site or site collection (E.g. 1033).

OverWriteSite Default value: False

This property specifies whether the AgileShape
should overwrite the existing site or site collection
if one already exists at the location where the
new site collection will be created. This property
can be set to the following specific values:

• False - This value indicates that the
AgileShape will not overwrite an existing
SharePoint site or site collection. If this
value is specified and a site already exists,
then SharePoint will not be modified, and
this AgileShape will exit and will update
the appropriate custom process attributes
(specified by the SaveErrorMessageTo and
SaveStatusTo properties).

• True - This value indicates that the
AgileShape will overwrite an existing
SharePoint site or site collection.
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SiteTitle This property specifies the title for the new
SharePoint site.

SiteURL This property specifies the URL for the new
where you want to add or remove the associated
item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}

UseUniquePermissions This property specifies whether the sub site
should inherit permissions from the parent site. If
set to "True" the site will use unique permissions.

WebTemplate This property specifies the name of the
SharePoint Team Site template that will be used
to create the new SharePoint site collection.
This property can be set to the name of any
SharePoint Site template (e.g. Team Site).

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

New Site Collection
This AgileShape can be used to automatically create a new SharePoint site collection.

http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

Locale This property specifies the locale code for the
new SharePoint site or site collection (E.g. 1033).

OverWriteSite Default value: False

This property specifies whether the AgileShape
should overwrite the existing site or site collection
if one already exists at the location where the
new site collection will be created. This property
can be set to the following specific values:

• False - This value indicates that the
AgileShape will not overwrite an existing
SharePoint site or site collection. If this
value is specified and a site already exists,
then SharePoint will not be modified, and
this AgileShape will exit and will update
the appropriate custom process attributes
(specified by the SaveErrorMessageTo and
SaveStatusTo properties).

• True - This value indicates that the
AgileShape will overwrite an existing
SharePoint site or site collection.

OwnerEmail This property specifies the email address of the
site owner of the new SharePoint site collection.

OwnerLoginName This property specifies the login name of the site
owner of the new SharePoint site collection. The
value should be specified using the following
format:

DomainName\\UserName

E.g. MyDomain\\Administrator

OwnerName This property specifies the display name of the
site owner of the new SharePoint site collection.

SiteTitle This property specifies the title for the new
SharePoint site.

SiteURL This property specifies the URL for the new
where you want to add or remove the associated
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item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}

WebTemplate This property specifies the name of the
SharePoint Team Site template that will be used
to create the new SharePoint site collection.
This property can be set to the name of any
SharePoint Site template (e.g. Team Site).

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Portal Listing
This AgileShape is often used to add a link to a document that is created in a SharePoint document
library by an AgilePoint process.

Properties for This AgilePart

Field Name Definition

LinkURL This property specifies the URL for the new portal
link.

Notes This property specifies the notes for the new
portal link.

Overwrite Default value: True

This property specifies whether the AgileShape
should replace the link (if any) with the same
LinkURL rather than creating a new link. This
property can be set to the following specific
values:

• False - This value indicates that the
AgileShape should simply create a new link.

http://support.agilepoint.com/SupportPortal/


AgileShapes 156

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

Field Name Definition

• True - This value indicates that the
AgileShape should replace an existing link
that has the same LinkURL with the new
link. When this value is specified and an
existing link exists, this means that the
AgileShape will essentially "update" the non-
URL properties of the existing link.

SharePointPortalURL Default value: $SPServer

This property specifies the URL for the
SharePoint Portal site.

E.g. http://MachineName:Port

Title This property specifies the title for the new portal
link.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Publish
This AgileShape is essentially identical to the Manual AgileShape, except that its Work To Perform
property defaults to the value Publish, and it has a different visual appearance in the process
template. This AgileShape is provided simply for the convenience of the process modeler.

Properties for This AgilePart

Field Name Definition

None This AgileShape has no unique design time
properties.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
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Publish Content
This AgileShape can be used to automatically change the status of a document from Draft to
Published.

Properties for This AgilePart

Field Name Definition

DocumentURL The URL location of the affected file (for example,
the file you want to add, delete, check out, etc.).

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Remove SP Group
This AgileShape can be used to automatically delete a SharePoint Group from a site.

Properties for This AgilePart

Field Name Definition

GroupConfiguration Opens the Remove Group Configuration dialog
box, where you can specify which SharePoint
group to delete from a SharePoint site.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Remove Group Configuration Window
This window allows you to specify which SharePoint group to delete from a SharePoint site.

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

SiteURL This property specifies the URL for the new
where you want to add or remove the associated
item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}

Group Name Specifies the affected group name (the group
name to be created, removed, etc.). The Group
Name cannot be duplicated in the domain. Also,
once the Group is created, it cannot be changed.

Remove User from SP Group
This AgileShape can be used to automatically remove a user from a SharePoint Group.
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Properties for This AgilePart

Field Name Definition

RemoveUserFromGroupConfiguration Opens the Remove User From Group
Configuration dialog box, where you can remove
a user from a SharePoint group.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Remove User From Group Configuration Window
This property allows you to remove a user from a SharePoint group.

Field Definitions

Field Name Definition

SiteURL This property specifies the URL for the new
where you want to add or remove the associated
item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

http://support.agilepoint.com/SupportPortal/
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Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}

Group Name Specifies the affected group name (the group
name to be created, removed, etc.). The Group
Name cannot be duplicated in the domain. Also,
once the Group is created, it cannot be changed.

User Name The user name you want to associate with the
action.

Retrieve List Item
This AgileShape can be used to retrieve list item field values to be updated in a custom attribute,
schema metadata, or SharePoint metadata.

Properties for This AgilePart

Field Name Definition

ItemValues Opens the Configuration for Retrieving ListItem
Fields dialog box, where you can specify the
configuration for retrieving list item field values
and where the values will be updated in a custom
attribute, schema metadata, or SharePoint
metadata.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Configuration for Retrieving ListItem Fields Window
Specifies the configuration for retrieving list item field values and where the values will be updated in a
custom attribute, schema metadata, or SharePoint metadata.

http://support.agilepoint.com/SupportPortal/
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After the Source Site is configured, the configuration window will look similar to below.
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The MetaData Name column is used to specify a custom attribute, schema metadata, or SharePoint
metadata where the value from the list field that is retrieved will be updated to.

The MetaData Name can be configured as follows:

1. Use the Add button to select a SharePoint metadata item.

2. Input a custom attribute name (e.g. Company1).

3. Click the button at the right side of the field to select a schema metadata.

Field Definitions

Field Name Definition

List URL Specifies the URL for the associated SharePoint
list. A valid list URL is required, if a library URL
(such as document library URL or form library
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URL) instead of a list URL is used, an error will
occur during execution. Below are examples of a
valid list URL:

• http://Machine_Name:port/sites/SiteName/
ListName

• ${DocUrl}

After entering the list URL, click the Connect
button. Now a Content Type can be selected.

ListItem Field Name Specifies the name of the list item field to be
affected (copied, moved, etc.).

ListItem Field Value Specifies the value of the field to be affected
(copied, moved, etc.). This can be used as a
filtering mechanism where only fields with the
specified value are affected. The following are
sample values:

• $\{ListItemID\} or $\{SubListItemID\}

• list item ID

Single Condition
A conditional logic activity that branches into two routines determined by a Boolean value. For
instance, Approval status of a request.

Properties for This AgilePart

Field Name Definition

PropertyBinding ReadOnly

Default value: Chosen by the user when the
AgileShape is first added to the process template.

The data binding expression that is used to
evaluate the value of the condition at runtime.

PropertyType The data type that the data binding expression
(see PropertyBinding) evaluates to at runtime.
This property can be set to the following specific
values:

• Integer
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• String

• DateTime

• Double

• Short

• Float

• Decimal

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Submit
This AgileShape is essentially identical to the Manual AgileShape, except that its Work To Perform
property defaults to the value Submit, and it has a different visual appearance in the process
template. This AgileShape is provided simply for the convenience of the process modeler.

Properties for This AgilePart

Field Name Definition

None This AgileShape has no unique design time
properties.

Common AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

Submit File to Record Center
This AgileShape can be used to store a specified file in a SharePoint Record Center.

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

RecordCenterConf Opens the Submit File To Record Center
Configuration dialog box, where you can
configure the record center submission.

AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Submit File To Record Center Configuration Window
Use this window to configure the record center submission.

Field Definitions

Field Name Definition

Record Center Site URL The URL of the SharePoint Record Center where
you want to submit the file. Once you have
entered the URL, click Connect to populate the
Routing Name list.

http://support.agilepoint.com/SupportPortal/
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Routing Name The Routing Name you want to use to submit the
file.

DocumentURL The URL location of the affected file (for example,
the file you want to add, delete, check out, etc.).

User Name The user name you want to associate with the
action.

Undo Check Out
This AgileShape can be used to undo a document check out from a SharePoint document library.

Properties for This AgilePart

Field Name Definition

DocumentURL The URL location of the affected file (for example,
the file you want to add, delete, check out, etc.).

AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Update InfoPath
This AgileShape can be used to update the values of one or more of the data elements in the XML of
the InfoPath form associated with this AgileShape.

Properties for This AgilePart

Field Name Definition

InfoPathFileURL Default value: $DocUrl

This property specifies the URL of the InfoPath
form (in Microsoft SharePoint).

XPathAndValues This property allows the process modeler to
specify new values for one or more of the

http://support.agilepoint.com/SupportPortal/
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data elements in the XML of the InfoPath form
associated with this AgileShape. Click the
Ellipses button to open the configuration dialog.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Update Meta Data
This AgileShape can be used to update metadata in SharePoint.

To define the metadata you want to update:

1. In the MetaDataNameAndValue field, click the Ellipses.

2. On the Name and Value dialog box in the Library URL field, enter a SharePoint URL that
contains the metadata attributes you want to change.

3. In the Library URL field, expand the drop-down list, and select the URL you want. This populates
the data for the rest of the fields in the dialog box.

4. Click Add.

5. On the Select SharePoint Library Column dialog box, select the field you want to update, and
click OK. (Note that you can select only one field at a time. Repeat this step for each field you
want to update.)

6. Update the following fields as desired. (See the descriptions in this topic.)

• Folder Name

• Field Name

http://support.agilepoint.com/SupportPortal/
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• Field Value

• Library URL

Properties for This AgilePart

Field Name Definition

MetaDataNameAndValue Opens the Name and Value dialog box, where
you can define the field name and value you want
to update within a specific SharePoint Library and
folder.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Name and Value Window
Use the Name and Value dialog box, where you can define the field name and value you want to
update within a specific SharePoint Library and folder.

 

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Library URL The URL of the SharePoint Library where you
want to update the metadata field name and
value.

Enter a valid SharePoint URL, and then expand
the drop-down to select a specific list or library
URL and to populate the fields for the rest of the
options in the dialog box.

To retrieve the metadata associated with the
Library URL, you must use an actual URL.
However, you can use a custom attribute at
runtime. If you want to change the runtime URL,
replace the URL in the Library URL field with the
runtime URL after you have configured the other
options in the dialog box.
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Folder Name The folder within the SharePoint Library where
you want to update the metadata field name and
value.

Field Name Identifies a field by which you want to restrict the
metadata update.

Field Value Identifies a value by which you want to restrict the
metadata update.

Add Opens the Select SharePoint Library Column
dialog box. Use this dialog box to select the
metadata attributes you want to update.

Remove Removes a metadata field and value from the list
of metadata values to update.

Value A metadata value you want to update.

Update SP Group
This AgileShape can be used to automatically update information for a SharePoint Group.

Properties for This AgilePart

Field Name Definition

GroupConfiguration Opens the Update Group Configuration dialog
box, where you can update information for a
SharePoint group.

AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Update Group Configuration Window
This window allows you to update information for a SharePoint group.

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

SiteURL This property specifies the URL for the new
where you want to add or remove the associated
item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}

Existing Group Name The name of the existing SharePoint Group for
which you would like to change the information.

New Group Name The new name of the SharePoint Group.
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New Group Description The new description that will overwrite the
existing group description.

New Group Owner The domain and user name for the new group
owner.

Upload Files
This AgileShape can be used to automatically upload one or more files from the local file system (of
the AgilePoint Server machine) to a SharePoint library.

Properties for This AgilePart

Field Name Definition

DestinationURL This property specifies the URL of the SharePoint
document library (or subfolder) the file(s) should
be uploaded to.

E.g. http://MachineName:Port/sites/SiteName/
DocumentLibraryName

-or-

http://MachineName:Port/sites/SiteName/
DocumentLibraryName/FolderName

Filter This property specifies the filename (or a
filename filter containing wildcards) that will
be acted upon -- for example, downloaded by
the Download Files AgilePart, uploaded by the
Upload Files AgilePart, or converted to PDF by
the Convert to PDF AgilePart.

The action is taken in the location specified
by the associated URL -- either Local Path or
AbsoluteURL, depending upon the AgileShape.
If the location is a folder, only the specified file
types will be acted upon.

Some examples of possible values for this
property are listed below:

• *.* - This value indicates that all files (located
at the source location) will be affected.



AgileShapes 173

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

Field Name Definition

• *.XML - This value indicates that all files
(located at the source location) that have the
".XML" file extension will be affected.

• *.doc - This value indicates that all files
(located at the source location) that have the
".DOC" file extension will be affected.

• MyFile.xml - This value indicates that
only the specific file (located at the source
location) named MyFile.xml will be affected.

LocalPath This property specifies the local file system folder
that is the destination location for the AgilePart's
action (for example, upload or download a file).

The value of this property should be a relative
path that specifies the location of the folder
relative to the AgilePoint Server application's root
directory.

E.g. If AgilePoint Server is installed at:

c:\\Inetpub\\wwwroot\\AgilePointServer\\

and the file (once downloaded) should be located
at:

c:\\Inetpub\\wwwroot\\AgilePointServer\\files\
\MyFile.txt

then this property should be set to the following
value: files

E.g. If AgilePoint Server is installed at: c:\\Inetpub
\\wwwroot\\AgilePointServer\\

and the file (once downloaded) should be located
at:

c:\\Inetpub\\wwwroot\\AgilePointServer\\files\
\temp\\MyFile.txt

then this property should be set to the following
value: /files/temp/

OverWriteFile Default value: False

This property specifies whether the AgileShape
should overwrite the existing file(s) if they already
exist at the specified destination.

This property can be set to the following specific
values:



AgileShapes 174

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

Field Name Definition

• False - This value indicates that the
AgileShape will not overwrite any existing
file(s).

• True - This value indicates that the
AgileShape will overwrite any existing file(s).

Recursive Default value: False

This property specifies whether the AgileShape
should affect files contained in any subfolders
located under the library (or folder) in the
specified location.

This property can be set to the following specific
values:

• False - This value indicates that the
AgileShape will only affect files located in the
specified folder only.

• True - This value indicates that the
AgileShape will affect files located directly
under the specified folder, and also files in
any subfolders.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Advanced Extension
This section describes the AgileShapes in the Advanced Extension stencil.

C#
This AgileShape can be used to add managed custom code using the C# coding language.

Custom Assembly Support

The Managed Code C# and Managed Code VB AgileParts allow developers to add custom classes to
their code snippets. Support for custom classes requires the following setup:

1. Create a custom assembly as a class library using managed code C# or managed code VB.

2. Deploy the custom assembly to the GAC on all AgilePoint Server and Envision machines.

3. In a text editor, create a new file.

http://support.agilepoint.com/SupportPortal/
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4. In the text file, paste the following:

<?xml version="1.0" encoding="utf-8" ?>
   <configuration>   
      <assemblies>
         <Assembly>Infragistics2.WebUI.Misc.v8.1, 
            Version=8.1.20081.1000, Culture=neutral, 
            PublicKeyToken=7dd5c3163f2cd0cb
         </Assembly>
      </assemblies>
   </configuration>

5. Replace the information in the <Assembly> element with the correct information for your
assembly. You can add as many Assembly nodes as required.

6. Save the file with the name CustomAssembly.xml.

7. Place a copy of the file in all of the following locations:

• The root installation folder for AgilePoint Server.

• The GAC of the AgilePoint Server machine.

• The root installation folder for each AgilePoint Envision instance where the custom classes
will be used.

• The GAC of each AgilePoint Envision machine.

Properties for This AgilePart

Field Name Definition

CodeSnippet This property allows the process modeler to build
and compile the managed code snippet.

Click the Ellipses button to open the Managed
Code VB Snippet.
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Field Name Definition
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Field Name Definition

 

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

External Command
This AgileShape can be used to configure an external command to run in the workflow process.

Properties for This AgilePart

Field Name Definition

Configure This property allows the process modeler to
configure the details for calling an external
command.

Click the  Ellipses button to open the
Configuration for Calling External Command
dialog.

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

 

 

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Java
This AgileShape can be used to run a Java application.

Properties for This AgilePart

Field Name Definition

Configure Opens the Configuration for Invoking Java
Program Window dialog box, where you can
configure the details for invoking the Java
program.

http://support.agilepoint.com/SupportPortal/
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Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Configuration for Invoking Java Program Window
This window allows the process modeler to configure the details for invoking the Java program.

1. Click the Search button to add a class that contains the main method for the startup class. It
automatically adds the folder where the startup class is located to ensure normal startup as shown
above.

2. Add all the libraries and/or class folders that the startup class requires by clicking either the Add
Class Folder or Add External JAR button.

3. Enter a custom parameter name for the output value in the "Return Value" text box. This is an
optional step and only returns the console output value.

4. To limit the run time, input the number of seconds before timeout.

5. Click OK when finished with the configuration.

Sequential Workflow
This AgileShape can be used to expose your Microsoft Windows Workflow Foundation assets at the
AgilePoint process layer.

http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

Configure Opens the Workflow Foundation Assembly
dialog box, where you can configure the details
for invoking Windows Workflow Foundation
activities.

Timeout Default value: 600

Specifies the maximum amount of time (in
seconds) that should be allowed for the
completion of the web service call for this
AgileShape.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Workflow Foundation Assembly Window
This window allows the process modeler to configure the details for invoking Windows Workflow
Foundation activities.

1. Click the Ellipses button to open the Workflow Foundation Assembly window.

http://support.agilepoint.com/SupportPortal/
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2. Click Browse, the following two choices are available:

• Workflow Assembly in a folder

• Workflow Assembly in GAC

The Sequential Workflow assembly can be either in the GAC or in a folder. If it is in a folder, it will
be added into the GAC automatically when the Sequential Workflow AgilePart is configured.

3. Choose a workflow assembly.

4. Configure the "Input Parameters" and "Output Parameters".

5. Click OK.

VB
This AgileShape can be used to add managed custom code using the Visual Basic coding language.

Custom Assembly Support

The Managed Code C# and Managed Code VB AgileParts allow developers to add custom classes to
their code snippets. Support for custom classes requires the following setup:

1. Create a custom assembly as a class library using managed code C# or managed code VB.

2. Deploy the custom assembly to the GAC on all AgilePoint Server and Envision machines.

3. In a text editor, create a new file.
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4. In the text file, paste the following:

<?xml version="1.0" encoding="utf-8" ?>
   <configuration>   
      <assemblies>
         <Assembly>Infragistics2.WebUI.Misc.v8.1, 
            Version=8.1.20081.1000, Culture=neutral, 
            PublicKeyToken=7dd5c3163f2cd0cb
         </Assembly>
      </assemblies>
   </configuration>

5. Replace the information in the <Assembly> element with the correct information for your
assembly. You can add as many Assembly nodes as required.

6. Save the file with the name CustomAssembly.xml.

7. Place a copy of the file in all of the following locations:

• The root installation folder for AgilePoint Server.

• The GAC of the AgilePoint Server machine.

• The root installation folder for each AgilePoint Envision instance where the custom classes
will be used.

• The GAC of each AgilePoint Envision machine.

Properties for This AgilePart

Field Name Definition

CodeSnippet This property allows the process modeler to build
and compile the managed code snippet.

Click the Ellipses button to open the Managed
Code VB Snippet.
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Field Name Definition
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Field Name Definition

 

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

WF Rule
Information pending.

Web Services
This section describes the AgileShapes in the Web Services stencil.

Web Service
An AgilePart activity that accesses a Web Service and its methods which are registered in AgilePoint
Envision. The user can select the appropriate Web Service and its specific method using the Web
Service shape.

http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

NeedCallback Default value: False

This property determines whether this
AgileShape is exited immediately after invoking
the Web service method, or will wait to exit
until the activity's status is explicitly updated
to Complete. This property can be set to the
following specific values:

• False - This value indicates that the
AgileShape invoke its associated .NET
method synchronously. The AgileShape
will be exited (at runtime) immediately after
invoking the Web service method.

• True - This value indicates that the
AgileShape invoke its associated .NET
method asynchronously (i.e. in a separate
thread). The AgileShape will be exited (at
runtime) only after the activity's status is
explicitly updated. This explicit update could
be performed manually (e.g. using AgilePoint
Enterprise Manager) or automatically by
an external system (e.g. by a separate
application that uses the AgilePoint Workflow
API to programmatically update the activity's
status).

Configuration Opens the Web Service Configuration dialog
box, where you can configure which Web
service method should be invoked at runtime.
It also allows the process modeler to configure
the custom process attributes that should be
associated with the Web service method's
parameters (if any), and the custom process
attribute that will be used to store the Web
service method's return value (if any).

Credential Default value: None

This property allows the process modeler to
configure which authentication credentials (i.e.
windows user account) should be used to invoke
the Web service method at runtime. Click the
Ellipses button to open the Login dialog.
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Field Name Definition

 

 

Proxy This property allows you to specify that a proxy
server should be used to connect to the Web
service at runtime. It allows you to bypass the
permission constraints on the local machine at
runtime.

Timeout Default value: 600

Specifies the maximum amount of time (in
seconds) that should be allowed for the
completion of the web service call for this
AgileShape.

XmlSerializeReturnValue Default value: False

This property determines whether the data
returned by the Web service call invoked by this
AgileShape will be serialized as XML or not.
This property can be set to the following specific
values:

• False - This value indicates that the return
value will be stored into the specified custom
process attribute exactly as returned by the
Web service.

• True - This value indicates that the return
value will be serialized into an XML string
before being stored into the specified custom
process attribute exactly as returned by the
Web service.
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AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Web Service Configuration Window
This window allows the process modeler to configure which Web service method should be invoked at
runtime. It also allows the process modeler to configure the custom process attributes that should be
associated with the Web service method's parameters (if any), and the custom process attribute that
will be used to store the Web service method's return value (if any).

Once the configuration dialog is open, enter the URL of a Web Service and click the Connect
button. A list of the Web service's available methods will be retrieved. Select the method you want to
associate with this AgileShape. To configure the custom process attributes for the parameters and/or
return value, simply click on an attribute (e.g. $piID) to highlight it, and then click on it again to modify
the value.

http://support.agilepoint.com/SupportPortal/
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Web Service Extension (WSE)
An AgilePart activity that accesses a Web Service and its methods which are registered in AgilePoint
Envision. The user can select the appropriate Web Service and its specific method using the Web
Service shape. The Web Service Extension uses SOAP calls over HTTP and allows for schema
mapping between the AgilePoint application schema and the Web method's request schema.

Properties for This AgilePart

Field Name Definition

None This AgileShape has no unique design time
properties.

AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

 Windows Communication Foundation (WCF)
An AgilePart that enables you to call services enabled with Windows Communication Foundation
(WCF).

http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

Configuration Opens the WCF Service Configuration dialog
box, where you can configure communication
with a WCF service.

Credential Default value: None

This property allows the process modeler to
configure which authentication credentials (i.e.
windows user account) should be used to invoke
the Web service method at runtime. Click the
Ellipses button to open the Login dialog.

 

 

Timeout Default value: 600

Specifies the maximum amount of time (in
seconds) that should be allowed for the
completion of the web service call for this
AgileShape.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

http://support.agilepoint.com/SupportPortal/
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Configuration for WCF Service Window
This dialog box enables you to configure communication with a WCF service.

The values entered in the Configuration dialog box populate the BindingName, EndpointName,
MethodName, and URL properties that display in the Envision Properties box.

Field Definitions

Field Name Definition

URL URL of the item you are configuring

Bindings Specifies the data binding you want to use.

Endpoints Specifies the endpoint to which you want to
connect.

WebMethod Specifies a method to invoke.

Endpoint URL The URL of the endpoint of the service to which
you want to connect.

RequestMapping / ResponseMapping Click the Ellipses button to map the schemas for
the process model and the WCF service.
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Field Name Definition

Custom Headers (Response) Click the Ellipses button to map the schemas
for the process model and the WCF service for a
request or response, as appropriate.

Exchange Server
This section describes the AgileShapes in the Exchange Server stencil.

Create Appointment
This AgileShape can be used to automatically create an appointment on a user's Outlook Calendar.

Properties for This AgilePart

Field Name Definition

Configuration Opens the Appointment Schedule for Exchange
Server window, where you can specify the
authentication mode to be used to access the
Exchange Server and schedule the appointment
and the appointment details.

AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Appointment Schedule for Exchange Server window
Specifies the configuration for the Create Appointment AgileShape.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Exchange 2007 or Exchange 2010 Specifies the version of your Microsoft Exchange
Server.

(Authentication) URL Specifies the Exchange Server URL.

(Authentication) Domain, Username, Password Determines that a specified account will be used
to access the Exchange Server and what the
credentials will be.

(Authentication) Use AgilePoint System User specifies to use the AgilePoint System User
credentials to access the Exchange Server.

The credentials and URL can be verified by
clicking the Test button. The Test button is
disabled if Use AgilePoint System User is
checked. In both cases, make sure that the user
has proper access rights to the Exchange Server.
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Field Name Definition

(Appointment or Meeting) Subject, Location, Start
Time, End Time, Time Zone

The details about the appointment or meeting.

(Appointment or Meeting) Body The body of the email. Accepts custom attributes
and schema by typing ${.

Create Meeting
This AgileShape can be used to automatically create a meeting on a user's Outlook Calendar

Properties for This AgilePart

Field Name Definition

Configuration Opens the Meeting Schedule for Exchange
Server window, where you can specify the
authentication mode to be used to access the
Exchange Server and schedule the meeting and
the meeting details.

AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Meeting Schedule for Exchange Server Window
Specifies the authentication mode to be used to access the Exchange Server and schedule the
appointment and the appointment details.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Exchange 2007 or Exchange 2010 Specifies the version of your Microsoft Exchange
Server.

(Authentication) URL Specifies the Exchange Server URL.

(Authentication) Domain, Username, Password Determines that a specified account will be used
to access the Exchange Server and what the
credentials will be.

(Authentication) Use AgilePoint System User specifies to use the AgilePoint System User
credentials to access the Exchange Server.

The credentials and URL can be verified by
clicking the Test button. The Test button is
disabled if Use AgilePoint System User is
checked. In both cases, make sure that the user
has proper access rights to the Exchange Server.
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Field Name Definition

(Appointment or Meeting) Subject, Location, Start
Time, End Time, Time Zone

The details about the appointment or meeting.

(Appointment or Meeting) Body The body of the email. Accepts custom attributes
and schema by typing ${.

Database
This section describes the AgileShapes in the Database stencil.

Batch Insert
This AgileShape can be used to insert multiple new database records into a database table. It can
also be configured to delete certain records before the new records are inserted.

Properties for This AgilePart

Field Name Definition

Configure Opens the Batch Insert Configuration dialog
box, where you can configure how records are
inserted into a database table.

DatabaseType The type of database that will be used.

Timeout Default value: 600

Specifies the maximum amount of time (in
seconds) that should be allowed for the
completion of the web service call for this
AgileShape.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Configuration for Inserting Database Record(s) Window
This property allows the process modeler to configure where and how the new database records are
inserted into the database.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

ConnectionString The connection string that will be used to connect
to the database at runtime.

• Click Choose to select a connection string
from the list of shared custom attributes
(defined and managed in Enterprise
Manager.)

• Click Create to create a new connection
string. to create a new connection string.

TableName The name of the database table where this
AgileShape should insert the database record.

Delete Records
This AgileShape can be used to delete multiple existing database records in a database table.
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Properties for This AgilePart

Field Name Definition

Configure Opens the Configuration for Deleting Database
Record(s) dialog box, where you can configure
where and how the records are deleted from the
database.

DatabaseType The type of database that will be used.

Timeout Default value: 600

Specifies the maximum amount of time (in
seconds) that should be allowed for the
completion of the web service call for this
AgileShape.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Configuration for Deleting Database Record(s) Window
This property allows the process modeler to configure where and how the records are deleted from the
database.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

ConnectionString The connection string that will be used to connect
to the database at runtime.

• Click Choose to select a connection string
from the list of shared custom attributes
(defined and managed in Enterprise
Manager.)

• Click Create to create a new connection
string. to create a new connection string.

TableName The name of the database table where this
AgileShape should insert the database record.

Condition The SQL WHERE clause that defines which
database records should be updated.

Insert Database
This AgileShape can be used to insert a new database record into a database table.

Properties for This AgilePart

Field Name Definition

Configure Opens the Configuration for Inserting Database
Record dialog box, where you can configure
where and how the new database records are
inserted into the database.

DatabaseType The type of database that will be used.

Timeout Default value: 600

Specifies the maximum amount of time (in
seconds) that should be allowed for the
completion of the web service call for this
AgileShape.



AgileShapes 201

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Configuration for Inserting Database Record(s) Window
This property allows the process modeler to configure where and how the new database records are
inserted into the database.

Field Definitions

Field Name Definition

ConnectionString The connection string that will be used to connect
to the database at runtime.

• Click Choose to select a connection string
from the list of shared custom attributes
(defined and managed in Enterprise
Manager.)

• Click Create to create a new connection
string. to create a new connection string.

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

TableName The name of the database table where this
AgileShape should insert the database record.

Query Database
This AgileShape can be used to execute dynamic SQL statements and/or call database stored
procedures in order to retrieve data from the database.

Properties for This AgilePart

Field Name Definition

Configure Opens the Batch Insert Configuration dialog
box, where you can configure how records are
inserted into a database table.

DatabaseType The type of database that will be used.

Timeout Default value: 600

Specifies the maximum amount of time (in
seconds) that should be allowed for the
completion of the web service call for this
AgileShape.

SQLType Default value: SQL

This property determines whether this
AgileShape will retrieve the data from the
database using a database stored procedure, or
using (one or more) dynamic SQL statements.
This property can be set to the following specific
values:

• SQL - This value indicates that the data will
be retrieved from the database using one or
more dynamic SQL statements.

• StoredProcedure - This value indicates that
the data will be retrieved from the database
using one database stored procedure. If
the SqlType property is set to SQL when
you click the Ellipses button, it will open
a configuration dialog like the one shown
below.
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Field Name Definition

If the SqlType property is set to SQL when
you click the Ellipses button, it will open a
configuration dialog like the one shown below.

 

 

Clicking the Add button from this dialog will allow
you to enter a dynamic SQL statement, and the
name of the custom process attribute that the
statement's return value should be stored in.
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Field Name Definition

 

StoredProcedure Mode:

If the SqlType property is set to StoredProcedure
when you click the button, it will open a
configuration dialog like the one shown below.

 

 

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Database Queries Window
Use this window to configure where and how the data is retrieved from the database

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

ConnectionString The connection string that will be used to connect
to the database at runtime.

• Click Choose to select a connection string
from the list of shared custom attributes
(defined and managed in Enterprise
Manager.)

• Click Create to create a new connection
string. to create a new connection string.

TableName The name of the database table where this
AgileShape should insert the database record.

Stored Procedure
This AgileShape can be used to execute dynamic SQL statements and/or call database stored
procedures.

This AgileShape does not support capturing return values or output parameters. See the Query
Database AgileShape for additional information about retrieving data from the database.
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Properties for This AgilePart

Field Name Definition

Configure Opens the Configuration for Stored Procedure
or Generic SQL dialog box, where you can
configure where and how the new database
records are inserted into the database.

DatabaseType The type of database that will be used.

Timeout Default value: 600

Specifies the maximum amount of time (in
seconds) that should be allowed for the
completion of the web service call for this
AgileShape.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Configuration for Stored Procedure or Generic SQL Window
This property allows the process modeler to configure where and how the new database records are
inserted into the database.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

ConnectionString The connection string that will be used to connect
to the database at runtime.

• Click Choose to select a connection string
from the list of shared custom attributes
(defined and managed in Enterprise
Manager.)

• Click Create to create a new connection
string. to create a new connection string.

SQL The SQL statement that will be performed on the
database by this AgileShape at runtime.

Update Database
This AgileShape can be used to update multiple existing database records in a database table.

Properties for This AgilePart

Field Name Definition

Configure Opens the Configuration for Updating Database
Record(s) dialog box, where you can configure
where and how the new database records are
inserted into the database.

DatabaseType The type of database that will be used.

Timeout Default value: 600

Specifies the maximum amount of time (in
seconds) that should be allowed for the
completion of the web service call for this
AgileShape.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

http://support.agilepoint.com/SupportPortal/
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Configuration for Updating Database Record(s) Window
This property allows the process modeler to configure where and how the new database records are
inserted into the database.

Field Definitions

Field Name Definition

ConnectionString The connection string that will be used to connect
to the database at runtime.

• Click Choose to select a connection string
from the list of shared custom attributes
(defined and managed in Enterprise
Manager.)

• Click Create to create a new connection
string. to create a new connection string.

TableName The name of the database table where this
AgileShape should insert the database record.

Condition The SQL WHERE clause that defines which
database records should be updated.
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Extender
An AgileExtender is a type of AgileShape that allows users to overlay the AgilePoint process model
with custom behavior. An AgileExtender is a kind of "meta shape" that runs on top of or in parallel to
the process, rather than running inline within the process flow. This provides increased extensibility
and allows layers of powerful functionality to be added to the process without making the core process
model unnecessarily complex.

This section describes the AgileShapes in the Extender stencil, which provides access to the built-in
AgileExtenders.

Service Level Agreement (SLA)
This AgileShape enables you to track the time it takes to complete a range of elements in a
process instance. Within a process template, you can set more than one timer using the same SLA
AgileExtender shape.

Properties for This AgilePart

Field Name Definition

SLA Timer Opens the Time Watch Between Activities dialog
box, where you can configure the SLA timer,
including the range of AgileShapes you want to
time.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Time Watch Between Activities Window
This window enables you to configure the SLA timer, including the range of AgileShapes you want to
time.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Add Creates a new timer with a name you specify.

Remove Deletes the selected timer.

Start Activity The activity upon which you want to start the
timer.

End Activity The activity upon which you want to end the
timer.

Fixed Date Selects a date to expire the timer.

Calculate Date Calculates a date to expire the timer based on
the information you enter.

Notification Optionally sends a preconfigured notification type
when the timer expires.

Sub Process Optionally starts a subprocess when the
timer expires. The list is populated from the
subprocesses in your process model.
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Miscellaneous
This section describes the AgileShapes in the Miscellaneous stencil.

DateTimeOperation
This AgileShape can be used to perform complex date calculations within a process model using
a simple graphical user interface. The DateTime Services AgilePart can manipulate the operations
between two DateTime input values or add extra values (second/minute/hour/days etc) to one
DateTime value.

Properties for This AgilePart

Field Name Definition

Configuration Opens the DateTime Services Configuration
dialog box, where you can configure date
calculations.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

DateTime Services Configuration Window
This window enables you to configure date calculations.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Input DateTime Specifies 1 or 2 dates to use as input values. You
can select a Custom Attribute, a Static date
and time, or the date and time Now (when the
DateTime AgilePart is initiated).

Add Specifies an amount of time to add to the Input
DateTime.

Subtract Specifies an amount of time to subtract from the
Input DateTime.

Compare Difference Indicates whether to compare the difference
between the two Input DateTime values.

Return Specifies whether to pass the earlier or later
value based on the comparison.
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Field Name Definition

Change Input DateTime to Output Format

Indicates that the Input DateTime format will be
converted to the Output.

Business Time Specifies that the AgilePoint work calendar is
taken into account for calculations.

Calculation Type Specifies whether to calculate or compare the
difference between Input DateTime 1 and Input
DateTime 2. You can specify the following types
of calculations:

• Real - The actual difference between the two
input DateTimes. The result depends on the
setting for the Result option.

• Relative - This setting is useful for situations
such as when an action is allowed once per
month. The "real" difference between the
last day of one month and the first day of
following month is 0 months. However, in
"relative" mode, this difference is calculated
as one month because the dates are in
adjacent months. This returns the relative
number of time units (days, weeks, months,
years) between the two input DateTimes. For
example, the Relative differences between
Sat 29-Dec-2007 23:59:59 and Wed 02-
Jan-2008 00:00:00 are 4 days or 1 week or
1 month or 1 year, depending upon the time
unit specified.

Result Specifies the type of value to return for
calculations where the Calculation Type is Real:

• Decimal - Returns the difference as is,
including any decimals.

• Whole Number - Returns the integer part of
the result by removing the decimal part.

• Rounded - Rounds up (>=0.5) or rounds
down (<0.5) the result.

Result Boolean If Compare Difference is enabled, the difference
will be evaluated as a Boolean (True/False)
result, and the Boolean value will be associated
with the text that appears in this field.
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Field Name Definition

Date String If based on the operation performed, the output is
of type DateTime, the result will be converted to
a string and stored in the format provided in the
Format list, and stored associated with the text
that appears in this field.

Difference If Compare Difference is enabled, the difference
will be stored as a NameValue where the name is
the text that appears in this field, and the value is
the output value.

HTTP Post
This AgileShape can be used to post data from a client machine to a Web application which is
predefined. The client receives response from the Web application. It also supports custom attributes
and https and web proxy.

Properties for This AgilePart

Field Name Definition

HttpPost Opens the Http Post Configuration dialog box,
where you can configure an HTTP post action.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Http Post Configuration Window
This window enables you to configure an HTTP post action.

Field Definitions

Field Name Definition

Credential The HTTP page URL section should
contain a valid URL such as http://
MachineName:PortNumber/WebApplication.aspx.

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

The Authentication section allows you to specify
the authentication for doing the Http post
function.

Do one of the following:

• Specify an account by Domain\\username
and password. You can validate whether
this account is valid by clicking on the Test
button.

• Use the AgilePoint System User at runtime,
that means it will impersonate the system
account of AgilePoint.

• Use the default credential, this means it will
use the account credentials that are used
when logging into the Web application.

Request This tab allows you to specify a custom header
by clicking on the ellipses button.

You can add parameters that will be used while
posting to a Web application, for example:

• Schema - You can attach a Xpath if the
process is based on a template with a
associated schema.

• Add - Append a new row in a table.

• Remove - Delete the current row in a table.

• Remove All - Remove all rows in a table.

Response This tab allows you to bind a response. You can
bind the response in two ways. One is to bind
the response with an AgilePoint Schema, the
other is to store it in a custom attribute. If the
Web application that is called is based on Base64
Encode, make sure to select this option.

Security This tab allows you to enable SSL Authentication.

If SSL Authentication is checked, you can add
client certificates by clicking the ellipses button.

ProxyServer This tab allows you to specify whether a proxy
can be used during the execution of the Http
Post.



AgileShapes 216

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

PDF Converter
This AgileShape can be used to automatically convert multiple formatted files to PDF files. In this
version only files in the file system can be converted.

Properties for This AgilePart

Field Name Definition

Destination The destination (folder and file path) for the file
output. Click the Ellipses (...) to select a custom
attribute.

Destination Repository Default value: FileSystem

The repository of the destination file.

Filter This property specifies the filename (or a
filename filter containing wildcards) that will
be acted upon -- for example, downloaded by
the Download Files AgilePart, uploaded by the
Upload Files AgilePart, or converted to PDF by
the Convert to PDF AgilePart.

The action is taken in the location specified
by the associated URL -- either Local Path or
AbsoluteURL, depending upon the AgileShape.
If the location is a folder, only the specified file
types will be acted upon.

Some examples of possible values for this
property are listed below:

• *.* - This value indicates that all files (located
at the source location) will be affected.

• *.XML - This value indicates that all files
(located at the source location) that have the
".XML" file extension will be affected.

• *.doc - This value indicates that all files
(located at the source location) that have the
".DOC" file extension will be affected.

• MyFile.xml - This value indicates that
only the specific file (located at the source
location) named MyFile.xml will be affected.

OverWriteFile Default value: False
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Field Name Definition

This property specifies whether the AgileShape
should overwrite the existing file(s) if they already
exist at the specified destination.

This property can be set to the following specific
values:

• False - This value indicates that the
AgileShape will not overwrite any existing
file(s).

• True - This value indicates that the
AgileShape will overwrite any existing file(s).

Recursive Default value: False

This property specifies whether the AgileShape
should affect files contained in any subfolders
located under the library (or folder) in the
specified location.

This property can be set to the following specific
values:

• False - This value indicates that the
AgileShape will only affect files located in the
specified folder only.

• True - This value indicates that the
AgileShape will affect files located directly
under the specified folder, and also files in
any subfolders.

Source The source file or folder.

Source Repository Default value: FileSystem

The repository of the source file.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Read File
This AgileShape can be used to upload contains of any file to a selected schema node of an ASP.NET
application.

The process using UpLoad File AgilePart should have an associated schema.

http://support.agilepoint.com/SupportPortal/
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Properties for This AgilePart

Field Name Definition

Configure Opens the Read File Configuration dialog box,
where you can configure a read file action.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Read File Configuration Window
This window enables you to configure a read file action.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Schema Node The schema node for which to upload the file
data.

File Path The path to the file on the local file system that
includes the contents for which to upload to the
schema node.

Text File Writer
This AgileShape enables functionality such as to extract the part/full content of a Business Process,
save the content part of a Business Process into file, define the file name, file format, folder name, and
define a location like UNC/FTP. It also provides the option of debugging mode, option of overwriting
the existing file, and validation of the process at design time.

Properties for This AgilePart

Field Name Definition

Configuration Opens the Configure Text File dialog box, where
you can configure a text file.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Configure Text File Window
Use this window to configure a text file.

Field Definitions

Field Name Definition

UNC The destination address of the file. Additional
behavior options are available.

File Content The content of the file. Additional behavior
options are available.

http://support.agilepoint.com/SupportPortal/
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Word
This AgileShape can be used to create Word documents (.doc or .docx files) or PDF files from Word
templates (.dot or .dotx files), populating Mail Merge fields in the template with values you specify in
the generated document.

Properties for This AgilePart

Field Name Definition

Configuration Opens the Configuration dialog box, where you
can configure a Word template conversion.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Word Configuration Window
This property enables you to configure a Word template conversion. Click the Ellipses button to open
the Configuration dialog box.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Word Template Enter the location for a Word template file, or
click the Ellipses to select a custom attribute.

Destination The destination (folder and file path) for the file
output. Click the Ellipses (...) to select a custom
attribute.

Save as PDF Indicates that the generated file will be saved as
a PDF file, instead of a Word document.

SharePoint Credentials Click this button to enter the SharePoint logon
credentials required to create the file.

Load Word Fields Click this button to load the list on the right with
the dynamic fields from the Word document.
Select the field names in this list, and click the left
arrow (<-) button to add the fields to the list on
the left.

Process value For each field in the Word template, select this
column, and click the Ellipses (...) button. In the
pop-up, select the value you want for the selected
Word field.

XML Manipulation
This AgileShape can be used to calculate the values in XML by formula or custom expression.

Properties for This AgilePart

Field Name Definition

Configure The configuration window allows you to define
the formula to be calculated at run-time. You
can add multiple formulas for XML calculation
by clicking the Add button. You can also use an
attribute or a field in the XML as a function to
calculate.
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Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Active Directory
This section describes the AgileShapes in the Active Directory stencil.

Create User
This AgileShape can be used to create a user in Active Directory.

Properties for This AgilePart

Field Name Definition

Context Opens the Set Context Properties window, where
you can specify the Active Directory properties.

LocationType Specifies the Active Directory Services Interface
provider type. At this time, only LDAP is
supported.

NewUserConfiguration Specifies the user information to create in Active
Directory.

AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Set Context Properties Window
Specifies the Active Directory properties.

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Context Domain The domain name.

Context Domain The username of the account to be used to
create a group in Active Directory at run time.

Password The password of the account to be used to create
a group in the domain at run time.

Directory Type The Active Directory type (LDAP/WinNT). At this
time, only LDAP is supported.

Directory Address Specifies a host address of the Active Directory.

Directory Port Specifies a port number of the Active Directory.
By default, it is 389. In the case of a remote
domain, the port should match the port of the
remote domain server.

Secure Connection In this version, the SSL is not supported; it will be
an enhancement in the future.

Update User
This AgileShape can be used to update user information in Active Directory. 
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Properties for This AgilePart

Field Name Definition

Context Opens the Set Context Properties window, where
you can specify the Active Directory properties.

LocationType Specifies the Active Directory Services Interface
provider type. At this time, only LDAP is
supported.

UserInfo Allows for the update of user information and
organization details.

There are several ways to update user
information in Active Directory:

• Enter the user name manually.

• Click the Search button and select the user
name from the list that is populated.

• Search for a user name that is a
custom attribute. The format of the
custom attribute should be as follows:$
\{CustomAttributeName\}

• Update user information via an Xpath. This
is done by clicking the Schema button, and
selecting a node. The user name will be
obtained via the Xpath at run time.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Set Context Properties Window
Specifies the Active Directory properties.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Context Domain The domain name.

Context Domain The username of the account to be used to
create a group in Active Directory at run time.

Password The password of the account to be used to create
a group in the domain at run time.

Directory Type The Active Directory type (LDAP/WinNT). At this
time, only LDAP is supported.

Directory Address Specifies a host address of the Active Directory.

Directory Port Specifies a port number of the Active Directory.
By default, it is 389. In the case of a remote
domain, the port should match the port of the
remote domain server.

Secure Connection In this version, the SSL is not supported; it will be
an enhancement in the future.
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Remove User
This AgileShape can be used to remove a user(s) from AD. The user name(s) can be a real name,
custom attribute, or schema.

Properties for This AgilePart

Field Name Definition

Context Opens the Set Context Properties window, where
you can specify the Active Directory properties.

LocationType Specifies the Active Directory Services Interface
provider type. At this time, only LDAP is
supported.

UserNames Specifies the user information to be affected
(e.g., used or disabled) from Active Directory.
When you need to affect multiple users, the user
names should be separated by a semicolon.

There are several ways to specify user names to
be affected in Active Directory:

• Enter the user name manually.

• Click the Search button and select the user
name from the list that is populated.

• Remove a user name that is a custom
attribute. The format of the custom
attribute should be as follows:$
\{CustomAttributeName\}

• Remove a user name via an Xpath. This is
done by clicking the Schema button, and
selecting a node. The user name will be
obtained via the Xpath at run time.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Set Context Properties Window
Specifies the Active Directory properties.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Context Domain The domain name.

Context Domain The username of the account to be used to
create a group in Active Directory at run time.

Password The password of the account to be used to create
a group in the domain at run time.

Directory Type The Active Directory type (LDAP/WinNT). At this
time, only LDAP is supported.

Directory Address Specifies a host address of the Active Directory.

Directory Port Specifies a port number of the Active Directory.
By default, it is 389. In the case of a remote
domain, the port should match the port of the
remote domain server.

Secure Connection In this version, the SSL is not supported; it will be
an enhancement in the future.
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Disable User
This AgileShape can be used to disable users from AD. The user name can be a real name, custom
attribute, or schema.

Properties for This AgilePart

Field Name Definition

Context Opens the Set Context Properties window, where
you can specify the Active Directory properties.

LocationType Specifies the Active Directory Services Interface
provider type. At this time, only LDAP is
supported.

UserNames Specifies the user information to be affected
(e.g., used or disabled) from Active Directory.
When you need to affect multiple users, the user
names should be separated by a semicolon.

There are several ways to specify user names to
be affected in Active Directory:

• Enter the user name manually.

• Click the Search button and select the user
name from the list that is populated.

• Remove a user name that is a custom
attribute. The format of the custom
attribute should be as follows:$
\{CustomAttributeName\}

• Remove a user name via an Xpath. This is
done by clicking the Schema button, and
selecting a node. The user name will be
obtained via the Xpath at run time.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Set Context Properties Window
Specifies the Active Directory properties.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Context Domain The domain name.

Context Domain The username of the account to be used to
create a group in Active Directory at run time.

Password The password of the account to be used to create
a group in the domain at run time.

Directory Type The Active Directory type (LDAP/WinNT). At this
time, only LDAP is supported.

Directory Address Specifies a host address of the Active Directory.

Directory Port Specifies a port number of the Active Directory.
By default, it is 389. In the case of a remote
domain, the port should match the port of the
remote domain server.

Secure Connection In this version, the SSL is not supported; it will be
an enhancement in the future.
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Create Group
This AgileShape can be used to create a group in Active Directory. The group can be a real name,
custom attribute, or schema.

Properties for This AgilePart

Field Name Definition

Context Opens the Set Context Properties window, where
you can specify the Active Directory properties.

Create Group Opens the Create Group window, where you
can specify the group information to create
in Active Directory. If the process template is
associated with a schema, the Schema buttons
will appear allowing you to select an Xpath.
Custom attributes are also supported.

LocationType Specifies the Active Directory Services Interface
provider type. At this time, only LDAP is
supported.

AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Set Context Properties Window
Specifies the Active Directory properties.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Context Domain The domain name.

Context Domain The username of the account to be used to
create a group in Active Directory at run time.

Password The password of the account to be used to create
a group in the domain at run time.

Directory Type The Active Directory type (LDAP/WinNT). At this
time, only LDAP is supported.

Directory Address Specifies a host address of the Active Directory.

Directory Port Specifies a port number of the Active Directory.
By default, it is 389. In the case of a remote
domain, the port should match the port of the
remote domain server.

Secure Connection In this version, the SSL is not supported; it will be
an enhancement in the future.
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Create Group Window
Specifies the group information to create in Active Directory. If the process template is associated with
a schema, the Schema buttons will appear allowing you to select an Xpath. Custom attributes are also
supported.

Field Definitions

Field Name Definition

Group Name Specifies the affected group name (the group
name to be created, removed, etc.). The Group
Name cannot be duplicated in the domain. Also,
once the Group is created, it cannot be changed.

Group Name (Pre-Windows 2000) Specifies the log name of the account, the
difference between the Group Name above and
this field is it can be modified after it has been
created.

Email Address Specifies the email address of the group.

Verify Group This button verifies the availability of the group
name. The button is available just for the context
domain if the context is reachable at design time.
For example, if the context domain binds with a
custom attribute, and the value depends on it at
run time, in this case, the button is unavailable.

Group Scope Refers to the profile of Group Scope in Active
Directory.

GroupType Refers to the profile of Group Type in Active
Directory.

Remove Group
This AgileShape can be used to remove groups in AD. The group can be a real name, custom
attribute, or schema.
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Properties for This AgilePart

Field Name Definition

Context Opens the Set Context Properties window, where
you can specify the Active Directory properties.

LocationType Specifies the Active Directory Services Interface
provider type. At this time, only LDAP is
supported.

Remove Group Specifies the group names to be removed from
Active Directory. When you need to remove
multiple groups, the group names should be
separated by a semicolon.

There are several ways to specify group names
to be removed from Active Directory:

• Enter the group name manually.

• Click the Search button and select the group
name from the list that is populated.

• Remove a group name that is a
custom attribute. The format of the
custom attribute should be as follows:$
\{CustomAttributeName\}

• Remove a group name via an Xpath. This
is done by clicking the Schema button, and
selecting a node. The group name will be
obtained via the Xpath at run time.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

Set Context Properties Window
Specifies the Active Directory properties.

http://support.agilepoint.com/SupportPortal/
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Field Definitions

Field Name Definition

Context Domain The domain name.

Context Domain The username of the account to be used to
create a group in Active Directory at run time.

Password The password of the account to be used to create
a group in the domain at run time.

Directory Type The Active Directory type (LDAP/WinNT). At this
time, only LDAP is supported.

Directory Address Specifies a host address of the Active Directory.

Directory Port Specifies a port number of the Active Directory.
By default, it is 389. In the case of a remote
domain, the port should match the port of the
remote domain server.

Secure Connection In this version, the SSL is not supported; it will be
an enhancement in the future.
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Remove User from Group
This AgileShape can be used to remove user(s) from a group in AD. The group or user name(s) can
be a real name, custom attribute, or schema.

Properties for This AgilePart

Field Name Definition

Context Opens the Set Context Properties window, where
you can specify the Active Directory properties.

LocationType Specifies the Active Directory Services Interface
provider type. At this time, only LDAP is
supported.

RemoveUserFromGroup Specifies the information for user name and
group to be removed from Active Directory. When
you need to remove multiple users, the user
names should be separated by a semicolon.

There are several ways to specify group names
to be removed from Active Directory:

• Enter the Group Name and User Name(s)
manually.

• Click the Search button and select the Group
Name and User Name(s) from the list that is
populated.

• Enter a custom attribute name for a Group
Name and User Names(s). The format of
the custom attribute should be as follows:$
\{CustomAttributeName\}

• Remove a group name via an Xpath. This
is done by clicking the Schema button, and
selecting a node. The group name will be
obtained via the Xpath at run time.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

http://support.agilepoint.com/SupportPortal/


AgileShapes 236

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

Set Context Properties Window
Specifies the Active Directory properties.

Field Definitions

Field Name Definition

Context Domain The domain name.

Context Domain The username of the account to be used to
create a group in Active Directory at run time.

Password The password of the account to be used to create
a group in the domain at run time.

Directory Type The Active Directory type (LDAP/WinNT). At this
time, only LDAP is supported.

Directory Address Specifies a host address of the Active Directory.

Directory Port Specifies a port number of the Active Directory.
By default, it is 389. In the case of a remote
domain, the port should match the port of the
remote domain server.
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Field Name Definition

Secure Connection In this version, the SSL is not supported; it will be
an enhancement in the future.

Retrieve User Information
This AgileShape can be used to retrieve user information from AD. The user name can be a real
name, custom attribute, or schema.

Properties for This AgilePart

Field Name Definition

Context Opens the Set Context Properties window, where
you can specify the Active Directory properties.

LocationType Specifies the Active Directory Services Interface
provider type. At this time, only LDAP is
supported.

UserInfo Allows for the update of user information and
organization details.

There are several ways to update user
information in Active Directory:

• Enter the user name manually.

• Click the Search button and select the user
name from the list that is populated.

• Search for a user name that is a
custom attribute. The format of the
custom attribute should be as follows:$
\{CustomAttributeName\}

• Update user information via an Xpath. This
is done by clicking the Schema button, and
selecting a node. The user name will be
obtained via the Xpath at run time.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

http://support.agilepoint.com/SupportPortal/
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Set Context Properties Window
Specifies the Active Directory properties.

Field Definitions

Field Name Definition

Context Domain The domain name.

Context Domain The username of the account to be used to
create a group in Active Directory at run time.

Password The password of the account to be used to create
a group in the domain at run time.

Directory Type The Active Directory type (LDAP/WinNT). At this
time, only LDAP is supported.

Directory Address Specifies a host address of the Active Directory.

Directory Port Specifies a port number of the Active Directory.
By default, it is 389. In the case of a remote
domain, the port should match the port of the
remote domain server.
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Field Name Definition

Secure Connection In this version, the SSL is not supported; it will be
an enhancement in the future.

Add User to Group
This AgileShape can be used to add a user to a group in AD. 

Properties for This AgilePart

Field Name Definition

AddUserToGroup Allows for the configuration of user information to
be added to a group in Active Directory.

There are several ways to specify user names to
be added to a group in Active Directory:

• Enter the user name manually.

• Click the Search button and select the user
name from the list that is populated.

• Add a user name that is a custom attribute.
The format of the custom attribute should be
as follows:$\{CustomAttributeName\}

• Add a user name via an Xpath. This is done
by clicking the Schema button, and selecting
a node. The user name will be obtained via
the Xpath at run time.

Context Opens the Set Context Properties window, where
you can specify the Active Directory properties.

LocationType Specifies the Active Directory Services Interface
provider type. At this time, only LDAP is
supported.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

http://support.agilepoint.com/SupportPortal/
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Set Context Properties Window
Specifies the Active Directory properties.

Field Definitions

Field Name Definition

Context Domain The domain name.

Context Domain The username of the account to be used to
create a group in Active Directory at run time.

Password The password of the account to be used to create
a group in the domain at run time.

Directory Type The Active Directory type (LDAP/WinNT). At this
time, only LDAP is supported.

Directory Address Specifies a host address of the Active Directory.

Directory Port Specifies a port number of the Active Directory.
By default, it is 389. In the case of a remote
domain, the port should match the port of the
remote domain server.
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Field Name Definition

Secure Connection In this version, the SSL is not supported; it will be
an enhancement in the future.

SAP Integration
This section describes the AgileShapes in the SAP Integration stencil. These AgileShapes enable
integration between SAP and AgilePoint.

Configuring iNet BPS
The iNetServer component of ERP Link must be installed on one of the machines in the network.
Once the iNetServer components are installed, the connections to SAP systems are configured using
the Connection Server Console.

See the document iNetConnectorAdminGuide.chm for details regarding setting up connection pools
and other components. This help file is included with the ERP-Link software.

To configure the iNET BPS:

1. Click Start > All Programs > iNetServer > Administration Console.

2. On the iNet Connection Server window, complete the following fields:

Field Name Definition

Connection Pool Identifies the connection pool for the SAP
system.

The first time you set up the SAP
AgileConnector, you must select one of the
"unconfigured" default connection pools,
and then configure it to meet your needs.

Description A free text description of the connection
pool.

Destination String • ASHOST - IP address or host name of
the SAP server.

• SYSNR - The system number the SAP
server.

Connection mode Determines the manner in which AgilePoint
connects to SAP. Select Shared &
anonymous.

Client The SAP client number.
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Field Name Definition

User The SAP user name.

Password The SAP password.

Language The language abbreviation for your SAP
language. The default value is EN.

Pool size • Max - 10

• Min - 1

3. Click Validate.

A "Validation succeeded" message displays in the bottom field, and the System field auto-
populates.

4. Click Save.

5. On the pop-up, click Yes to restart the SAP connection service.

6. Once the status field shows the "restarted" message, click Exit.

SAP Integration AgileConnector
This AgilePoint Server extension (AgileConnector) enables you to run the SAP Integration component
of the AgilePoint BPMS Suite.

Enabling the SAP AgileConnector
To configure the SAP AgileConnector, do the following.

Navigation

Navigate to the Extensions Tab:

1. Click Start > All Programs > AgilePoint > AgilePoint Configuration.

2. On the  AgilePoint Server Configuration Tool  window, click the Extensions tab.

Instructions

1. On the Extensions tab, click Add.

2. Browse to the assembly [AgilePoint Server Installation]\bin
\Ascentn.AgileConnector.SAPIntegration.dll, and then click OK to add this extension to
AgilePoint Server.

Configuring the SAP AgileConnector
To throttle the number of concurrent connections that are made to SAP, do the following.
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Navigation

Navigate to the Extensions Tab:

1. Click Start > All Programs > AgilePoint > AgilePoint Configuration.

2. On the  AgilePoint Server Configuration Tool  window, click the Extensions tab.

Instructions

1. On the Extensions tab, select the SAPIntegration AgileConnector.

2. Click the Configure button.

3. In the configuration window for the SAP Integration AgileConnector, change the number of
concurrent threads as required.

Call SAP Function
An AgilePart that calls a function in an SAP database. This AgilePart can be used alone to call a
single function, or with other Call SAP Function AgileParts and Start and End SAP Transaction
AgileParts to create a more complex transaction. For more information, see the AgilePoint BPMS
User's Guide.

Properties for This AgilePart

Field Name Definition

Configuration Opens the SAP Connection Browser window,
where you can set up and select a connection
to an SAP system. You can use this window to
access the configuration for an SAP function.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

SAP Connection Browser
The SAP Connection Browser window enables you to set up and select a connection to an SAP
system. You can use this screen to access the configuration for an SAP function.

To configure an SAP connection and map the SAP data to your schema, do the following:

1. In AgilePoint Envision, create or open a process model of any type.

2. Add a Call SAP Function AgilePart to your process model from the  SAP Integration stencil.

3. Select the Call SAP Function AgilePart. In the Configuration field, click the Ellipses .

http://support.agilepoint.com/SupportPortal/
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4. In the SAP Connection Browser window, click the Add SAP System icon.

5. In the Establish iNet Connector Session to SAP System window, select the SAP server you set
up through iNet BPS. The exact steps vary based on your configuration. When you have finished,
click OK.

6. If you want to filter the functions for your connection, in the SAP Connection Browser window
right-click the server name, and click Add RFC Filter.
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7. In the RFC Filter window, in the Function field, enter a wildcard search term. For example, to
retrieve all the functions that start with GET, you can enter GET*.

8. In the Description field, enter a name for the filter.

9. When you have finished creating the filter, click OK.

10. In the SAP Connection Browser window, select the SAP function you want, and click OK. The
SAP Integration Configuration window opens.

11. (Optional) On the SAP Integration Configuration window, specify a runtime connection string.

12. (Optional) Click Change Connection to select a different SAP database. (This starts the
procedure over.)

13. (SAP Queries Only) If you are configuring an SAP query, on the Query Filter tab, enter the
following information in the fields provided:

• Query column

• Comparison operator

• Value

• Conjunction
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14. (SAP BAPI Only) If you are configuring an SAP BAPI, on the Input Mapping tab, enter map the
fields in your schema to the SAP fields.

15. (Queries or BAPI) On the Output Mapping tab, enter map the fields in your schema to the SAP
fields.

16. When you have finished, click OK.

Begin SAP Transaction
An AgilePart that starts an SAP Transaction. This AgilePart is used with two or more Call SAP
Function AgileParts and an End SAP Transaction AgilePart to create a complex SAP transaction. For
more information, see the AgilePoint BPMS User's Guide.

TransactionName
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A unique name that identifies the transaction. To complete a transaction, the value of this property
must match the value of the TransactionName property for an End SAP Transaction AgilePart.

Properties for This AgilePart

Field Name Definition

TransactionName A unique name that identifies the transaction.
To complete a transaction, the values of this
property in the Begin SAP Transaction and End
SAP Transaction AgileParts must match.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

End SAP Transaction
An AgilePart that ends an SAP Transaction. This AgilePart is used with two or more Call SAP
Function AgileParts and Begin SAP Transaction AgilePart to create a complex SAP transaction. For
more information, see the AgilePoint BPMS User's Guide.

TransactionName

A unique name that identifies the transaction. To complete a transaction, the value of this property
must match the value of the TransactionName property for an Begin SAP Transaction AgilePart.

Properties for This AgilePart

Field Name Definition

TransactionName A unique name that identifies the transaction.
To complete a transaction, the values of this
property in the Begin SAP Transaction and End
SAP Transaction AgileParts must match.

Common AgilePart Properties
The properties of the basic AgilePart AgileShape are also included in this AgileShape. For more
information, see AgilePart on the AgilePoint Support Portal.

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
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AgileForms Stencil
This section describes the AgileShapes in the AgileForms stencil.

AgileForm Shape
Generates an AgileForm you define. This form appears as an activity in the participant's Task List. For
detailed information regarding AgileForms, see the AgileForms Online Help.

Properties for This AgilePart

Field Name Definition

Edit Form Opens the AgileForms form editor, which enables
you to edit the form. For detailed information
about editing forms in AgileForms, see the
AgileForms online help.

Export Form Saves the form as an AgileForms XML form file.

Import Form Imports an AgileForms XML form file, and
replaces the form for this shape with the imported
one. All fields from the imported form are added
to the form library for the current process.

Preview Form Opens the AgileForms preview window, where
you can preview the form.

SubmitStep Default value: False

This property should be set to 'True' if the Form is
used as the Submit step (i.e. the first step where
you are creating the list item).

Transfer Form Transfers a form from one AgileForm AgileShape
to another within a process. If you transfer a form
to an AgileShape the current form is overwritten
with the one that is transferred.

Edit Library Opens the AgileForms form library editor.

Each field you add to an AgileForm is added to
the form library for the process. The fields in a
form library are available for use for to all forms
within a process.
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Field Name Definition

Export Library Saves the form as an AgileForms XML form
library file.

Import Library Imports an AgileForms XML form library file.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

AgileForm Serial
Generates an AgileForm for serial, or sequential, approvals. This form appears as an activity in the
identified participants' Task List.

In a serial approval model, the task cannot move forward until a defined set of participants submits
an approval in a specified order. (For approvals that do not require a particular approval sequence,
use the AgileForm Parallel AgileShape.) You can define the set of approvers and number of required
approvers. All approvers for the AgileForm Serial AgileShape use the same approval form.

For detailed information regarding AgileForms, see the AgileForms Online Help.

Properties for This AgilePart

Field Name Definition

Approvers Default value: $Approvers

This property specifies the name of the custom
attribute that (initially) contains the user names
of the approvers. The usernames should be
separated by a semicolon. Each time this
AgileShape is entered at runtime, the AgileShape
will assign a task to the first username specified
by this property. Then the custom attribute
associated with this property will be modified to
remove the username so that the next username
will be assigned the task during the next iteration
through the loop.

LoopCondition Default value: $HasMoreApprover

This property specifies the name of the custom
attribute that will be updated each time the
AgileShape is exited to indicate whether more
Approvers are still waiting to be assigned the

http://support.agilepoint.com/SupportPortal/
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Field Name Definition

task. The value of the specified custom attribute
should be checked (using a SingleCondition
AgileShape within the loop) to determine whether
the loop should be exited or not.

Configuration This property allows the process modeler to
configure the participants for the approval task.

Click the Ellipses button to open the configuration
dialog.

Edit Form Opens the AgileForms form editor, which enables
you to edit the form. For detailed information
about editing forms in AgileForms, see the
AgileForms online help.

Export Form Saves the form as an AgileForms XML form file.

Import Form Imports an AgileForms XML form file, and
replaces the form for this shape with the imported
one. All fields from the imported form are added
to the form library for the current process.

Preview Form Opens the AgileForms preview window, where
you can preview the form.

SubmitStep Default value: False

This property should be set to 'True' if the Form is
used as the Submit step (i.e. the first step where
you are creating the list item).

Transfer Form Transfers a form from one AgileForm AgileShape
to another within a process. If you transfer a form
to an AgileShape the current form is overwritten
with the one that is transferred.

Edit Library Opens the AgileForms form library editor.

Each field you add to an AgileForm is added to
the form library for the process. The fields in a
form library are available for use for to all forms
within a process.

Export Library Saves the form as an AgileForms XML form
library file.

Import Library Imports an AgileForms XML form library file.
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AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

AgileForm Parallel
Generates an AgileForm for parallel (non-sequential) approvals. This form appears as an activity in
the identified participants' Task List.

In a parallel approval model, the task cannot move forward until a defined set of participants submits
an approval. However, the approvers need not approve in any particular order. (For approvals that
require a particular sequence, use the AgileForm Serial AgileShape.) Each approver must be defined
as an individual participant, using either an ID or a custom attribute. Each participant can also use a
unique AgileForm.

For detailed information regarding AgileForms, see the AgileForms Online Help.

Properties for This AgilePart

Field Name Definition

Configuration Opens the AgileForm Parallel Configuration
Window, where you can configure an AgileForm
Parallel approval.

Edit Library Opens the AgileForms form library editor.

Each field you add to an AgileForm is added to
the form library for the process. The fields in a
form library are available for use for to all forms
within a process.

Export Library Saves the form as an AgileForms XML form
library file.

Import Library Imports an AgileForms XML form library file.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
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AgileForm Parallel Configuration Window
This property allows the process modeler to configure the participants for the approval task and the
form each participant sees.

1. Click the Ellipses button to open the configuration dialog.

2. On the Dynamic Parallel Configuration dialog box, click Add, or select a participant and click
Edit.

3. Add a participant in the Participant field. You must use a single participant (as opposed to a role
or group), but you can use a custom attribute to identify the participant.

4. Define the form for the approval using the following buttons on this dialog box.

Field Definitions

Field Name Definition

Edit Opens the AgileForms form editor, which enables
you to edit the form. For detailed information
about editing forms in AgileForms, see the
AgileForms online help.

Preview Opens the AgileForms preview window, where
you can preview the form.

Export Saves the form as an AgileForms XML form file.

Import Imports an AgileForms XML form file, and
replaces the form for this shape with the imported
one. All fields from the imported form are added
to the form library for the current process.

Transfer Transfers a form from one AgileForm AgileShape
to another within a process. If you transfer a form
to an AgileShape the current form is overwritten
with the one that is transferred.

AgileForm Dynamic Group
This AgileShape can be used as similar to the Manual AgileShape, however it facilitates dynamic
group functionality. When users are added/removed from a group, the change is persisted at runtime.
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Properties for This AgilePart

Field Name Definition

Group/Role Default value: AgilePointGroup

Specifies whether an AgilePoint Group or an
AgilePoint Role will be used to perform the work.

Group/RoleName Specifies the name of the AgilePoint Group or
AgilePoint Role that will be used to perform the
work.

AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

AgileForm Process Adaptation
This AgileShape is a combination of the Dynamic Parallel, Dynamic Sequential, and Voting AgileWork.
It allows for a running process instance to adapt by adding a new participant to complete a task in
either a Parallel or Sequential fashion at runtime to support dynamic processes. Manageability at
runtime is accomplished either through the AgilePoint Enterprise Manager or the Process Viewer.

http://support.agilepoint.com/SupportPortal/
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To enable the Open Process Adaptation link in the Process Viewer, make the following modification
to the AgilePoint Web application's web.config file:

<appSettings>
         <add key="ProcessAdaptationUrl"  
              value="http://[hostname]:[port]/EnterpriseManager/
ProcessAdaptation/LinkedTasks.aspx"/> 
</appSettings>

The value for the Process Adaptation is the URL of the process adaptation URL in AgilePoint
Enterprise Manager.

For the Process Viewer in SharePoint using AgileForms, add the key entry into the SharePoint
web.config at C:\Inetpub\wwwroot\wss\VirtualDirectories\8000\web.config.

Properties for This AgilePart

Field Name Definition

UserDefinedProperties This property allows the process modeler to
configure initial ClientData values that will be
associated with the AgileShape's associated
task(s) at runtime. This is basically a way of
allowing you to specify a set of name/value
pairs that are passed to your Web page via an
object called a WorkItem. This is an alternative to
passing data via URL parameters. In your Web
page you can retrieve this data via the ClientData
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Field Name Definition

property of the WorkItem. It is then up to you to
decide how to use the data.

Click the Ellipses button to open the
configuration dialog.

 

 

Voting Configuration This property allows the process modeler to
configure data binding to the data schema within
a repeating table for which to establish the
approval data.

The "Mandatory" option provides an added level
of functionality, requiring any participants that
have been identified as "Mandatory" to approve,
or the final decision will be not-approved. The
final result is also configured here by setting
a custom attribute to store the final result and
specifying the percentage of participants that
will need to approve before the final decision
is considered as approved. For example, the
process designer specifies the voting percentage
as 60%. If 60% of the approvers approve the
preceding request, then the final decision is
considered as approved.

Click the Ellipses button to open the
configuration dialog.
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Field Name Definition

 

ApprovalType The property can be set to Sequential or Parallel
at design time. This property determines a
runtime whether the task will be delivered in a
sequential or parallel fashion to the participants
of the task. This can be changed at runtime via
AgilePoint Enterprise Manager or the Process
Viewer.

Sequential means that the task will be delivered
in a sequential fashion to 1 participant at a time.

Parallel means that all the tasks will be delivered
to each of the participants at the same time,
there is no particular order for which the task is
assigned to the participants.

UpdateCustomAttribute This property allows the process modeler to
configure an update to a custom attribute value
based on an event type.
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AgileWork Properties
The properties of the basic AgileWork AgileShape are also included in this AgileShape. For more
information, see AgileWork on the AgilePoint Support Portal.

http://support.agilepoint.com/SupportPortal/
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Menu Options Overview
This section provides an overview of AgilePoint Envision's menu commands. Since AgilePoint
Envision is a Microsoft Visio add-in, most of the available menu commands in AgilePoint Envision
function the same as in Microsoft Visio. This section only covers menu items that are unique to
AgilePoint Envision.

File Menu Options
The following menu options are available from the File menu in AgilePoint Envision.

File > New > Generic

This option allows the user to create a new process model based on the Generic process template.

File > New > Microsoft InfoPath

This option allows the user to create a new process model based on the Microsoft InfoPath process
template.

After selecting this option, you will be asked to choose the InfoPath form that will be associated with
the process model.

File > New > Microsoft SPDoc

This option allows the user to create a new process model based on the Microsoft SharePoint
Document Library process template. After selection this option, you will be asked to choose the
SharePoint Document Library that the process model will be associated with.

If you don't know the exact URL of the Document Library, you can click the Search SharePoint Site
link to select the Document Library.
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Type or select the SharePoint Site URL and click Connect. The directories available within that site
appear.

Click on the Document Library for which you would like to associate with the process model and click
OK.
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File > New > Microsoft SPList  

This option allows the user to create a new process model based on the Microsoft SharePoint List
template.

After selection this option, you will be asked to choose the SharePoint List that the process model will
be associated with.

If you don't know the exact URL of the List, you can click the Search SharePoint Site link to select
the List.

Type or select the SharePoint Site URL and click Connect. The directories available within that site
appear.
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File > Validate Process

This option validates the contents of a process template and can be used to detect certain types of
common errors, such as incorrectly connected AgileShapes. After choosing this option, the validation
dialog will be displayed.

Click Validate to begin the validation process.

If the process template contains an error, a message will appear with information about the error and
Envision will also show the source of the error highlighted in the process template so that you can
correct it.
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File > Update Server > Check out Process

This option allows you to connect to an AgilePoint Server directly from AgilePoint Envision, and then
check out the currently opened process model. This prevents more than one user from updating the
same process template at the same time.

If the process template has not been previously deployed to the AgilePoint Server, the command will
fail.
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File > Update Server > Create or Checkin, and Release Process

This option allows you to connect to an AgilePoint Server directly from AgilePoint Envision and deploy
the currently opened process model to the AgilePoint Server. To successfully deploy a process
template to an AgilePoint Server, the process template must be valid (i.e. no invalid AgileShape
connections, etc.), and any custom AgilePoint modules (e.g. AgileParts, AgileWorks, AgileStubs, etc.)
used in the process template must already be deployed to the AgilePoint Server. After selecting this
option, the Connecting to Server window appears where you will first need to connect to an AgilePoint
Server.

You will need to specify the URL location of the AgilePoint Server, and the Windows Authentication
credentials that will be used to access the AgilePoint Server. The Logon as current user option will use
your own Windows user account information to access the AgilePoint Server, or you can specify the
Domain, Username, and Password of a different user account (e.g. you could use the credentials of
the user account that the AgilePoint Server is configured to use as the System User).

After you have successfully connected to an AgilePoint Server, you may specify a version number,
comment, and release schedule for the process model.
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If you are deploying a Microsoft Info process template, you will see a dialog similar to the one below.
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The check box at the bottom of the window allows you to publish the process template's associated
InfoPath form (to Microsoft SharePoint) directly from AgilePoint Envision. If you check the check box,
you will see a window similar to the one below:
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Enter the URL of the SharePoint site where you want this InfoPath form to be published and the
Title for the Form Library name. Then click OK to publish the form to SharePoint. After clicking the
final OK button (in either of the above windows), the process template will be validated. If validation
succeeds, the process template will be deployed to the specified AgilePoint Server. If validation fails,
the process template will not be deployed and you will need to fix any errors in the process template
(and/or deploy any custom modules to the AgilePoint Server) before deploying the process template.

File > Export & Import > Save As Deploying File(xml)

This option converts your current process template to an XML file that can be used to deploy the
process to an AgilePoint Server using AgilePoint Enterprise Manager (instead of using AgilePoint
Envision). This method is most often used as an alternative in cases where AgilePoint Envision cannot
connect to AgilePoint Server to deploy a process template. This method involves using AgilePoint
Envision to convert your current process template to an XML file that can be deployed to AgilePoint
Server using AgilePoint Enterprise Manager (instead of using AgilePoint Envision).

File > Export & Import > Convert To … > Generic

This option converts your current process model's underlying process template to a Generic process
template. This option is not available when working with a process model based on the Generic
process template.

File > Export & Import > Convert To … > SharePoint Document

This option converts your current process model's underlying process template to a Microsoft SPDoc
process template. This option is not available when working with a process model based on the
Microsoft SPDoc process template.

File > Export & Import > Convert To … > InfoPath

This option converts your current process model's underlying process template to a Microsoft InfoPath
process template. This option is not available when working with a process model based on the
Microsoft InfoPath process template.

File > Export & Import > Generate Report

This option allows you to create a HTML-formatted report for a process template. The generated
report can be viewed in a Web browser. After activating this command, select the folder where
you want to save the report and then click OK. The process definition and process diagram will be
converted to HTM and GIF files, and saved to the selected folder.

File > Export & Import > Import Existing Visio file

This option creates a new AgilePoint Envision Generic process model based upon an existing
Microsoft Visio diagram. The Visio shapes, connectors, etc. that are imported from the Visio diagram
can then be converted into AgileShapes in order to create a working process model.

File > Export & Import > Import Process Template XML

This option allows for the Process Template XML to be imported from AgilePoint Enterprise Manager
into AgilePoint Envision and saved as a .vsd file. This can be helpful if you have lost your master
process template .vsd and want to recover it.

File > Process Simulation

This option allows you to run a simulation of how a process model will behave at runtime.

File > Extend AgilePoint > Register AgilePart
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This option registers a custom AgilePart component with AgilePoint Envision. Custom AgilePart
components must be registered before they can be used in a process template. After selecting this
option, the AgilePart Registration window appears.

To download and register an AgilePart that has already deployed to AgilePoint Server:

1. Click the Download button.

2. Connect to the AgilePoint Server.

3. Select an AgilePart that is available on the server and click OK.

If a previous version of the assembly was already loaded into memory by AgilePoint Server, any
changes to the assembly would not take effect until after AgilePoint Server is restarted. Modifying
any file in the bin directory will automatically cause IIS to restart AgilePoint Server.

However, modifying the assembly will not automatically cause a restart, so if you want any DLL
changes to take effect immediately, you would need to restart IIS or the AgilePoint Server.

To register an AgilePart DLL that is located on your computer's file system:

1. Click the Add button.

2. Select the appropriate DLL file and click Open.

Once an AgilePart assembly has been registered, the AgilePart and its methods will be displayed
in the AgilePart Registration window (as shown below) and they can be used in process
templates.
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File > Extend AgilePoint > Register AgileWork

This command registers a custom AgileWork component with AgilePoint Envision. Custom AgileWork
components must be registered before they can be used in a process template. After selecting this
option, the registration dialog will be displayed (as shown below).

To register an AgileWork DLL that is located on your computer's file system:

1. Click the Add button.
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2. Select the appropriate DLL file and click Open.

Once an AgileWork assembly has been registered, the AgileWork and its methods will be
displayed in the AgileWork Registration window (see above) and they can be used in process
templates.

Registering an AgileExtender in Envision

This command registers a custom AgileExtender component with AgilePoint Envision. Custom
AgileExtender components must be registered before they can be used in a process template. After
selecting this option, the registration dialog will be displayed.

1. In Envision, click File > Extend AgilePoint > Register AgileExtender.

2. On the AgileExtender Registration dialog box, click Add.

3. Select the DLL file for the AgileExtender , and click Open.

Once an AgileExtender assembly has been registered, the AgileExtender and its methods will
be displayed in the AgileExtender Registration dialog, and the methods can be used in process
templates.

File > InfoPath > Publish InfoPath to SharePoint Library

This option is only available when working with a process model based on the Microsoft InfoPath
process template. This command allows you to publish the InfoPath form associated with your process
model to a Microsoft SharePoint Form Library directly from AgilePoint Envision.

File > InfoPath > InfoPath Toolbar, Auto Naming and Others

This option is only available when working with a process model based on the Microsoft InfoPath
process template. This option allows you to configure various InfoPath-specific properties of your
process template. The Toolbar Buttons tab allows you to configure which views (in your InfoPath form)
will display the AgilePoint Toolbar. The AgilePoint Toolbar displays the Submit and Close button
when the InfoPath form is open.
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The Naming Convention tab allows you to configure how filenames are generated for new
documents in the SharePoint Form Library associated with your process template's InfoPath form.

The Advanced tab allows you to associate your existing process template with a different InfoPath
form.
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File > SharePoint … > Change Document Library

This option is only available when working with a process model based on the Microsoft SPDoc
process template. This option allows you to associate your existing process template with a different
SharePoint Document Library.

File > SharePoint … > Retrieve Meta Data Schema

This option is only available when working with a process model based on the Microsoft SPDoc
process template. This option allows you to retrieve information about the metadata columns of the
SharePoint Document Library associated with the current process model. This option is most often
used when you add a new metadata column to SharePoint and want to bind to it from an existing
process template.

File > Shapes > Generic

This option displays the Generic Visio Stencil (i.e. Shapes window) containing the basic AgilePoint
AgileShapes.

File > Shapes > Microsoft SPS

This option displays the Microsoft SPS Visio Stencil (i.e. Shapes window) containing the predefined
AgilePoint AgileShapes related to Microsoft SharePoint functionality.

File > Shapes > Premier

This option displays the Premier Extension Visio Stencil (i.e. Shapes window) containing additional
predefined AgilePoint AgileShapes. These AgileShapes are used for various purposes, including
database access, database updates, Web service calls, etc.
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View Menu Options

The following menu options are available from the View menu in AgilePoint Envision.

View > Process Template Properties

This option displays the Process Template Properties pane. This pane displays the design-time
properties of the process or the selected AgileShape. This option is most often used if the properties
window has been closed.

View > Email Templates Wizard

This option displays the Email Templates Wizard. The wizard allows you to create, modify, and/or
delete the email notification templates that can be used within a process template.

View > Custom Process Properties

This option displays the Custom Process Properties window. This window provides a convenient way
to review all of the different values used within the entire process from a single location. It also allows
you to add and/or remove custom values to the drop-down lists displayed (in the Activity Properties
toolbar) next to certain AgileShape properties. Adding custom process property values provides a
convenient way to easily define common values that will be used (for certain AgileShape properties)
in multiple AgileShapes. For example, adding two new WorkPerformer values (as shown below) will
cause both values to appear in the drop-down list for the Work To Perform property (as shown below)
for all of the Manual and Manual with Timeout AgileShapes in the process template.
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Shape Menu Options
The following menu options are available from the Shape menu in AgilePoint Envision.

Shape > Actions > Page Size

This option allows you to change the size of your process template. This option is not available when
you have an AgileShape selected.



Menu Options Overview 274

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

Help Menu Options
The following menu options are available from the Help menu in AgilePoint Envision.

Help > AgilePoint Envision Help

This command opens the Help file for AgilePoint Envision.
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Process Templates
AgilePoint process templates are created using one of the special AgilePoint business process model
templates built into AgilePoint Envision. These process templates are different than regular Visio
templates in that they can be deployed directly to AgilePoint Server to execute the workflow process
they model.

Process Template Types
The process template types in this section are available in AgilePoint Envision.

Generic Process Template
Generic is the simplest type of process template. This type of process model can be used to represent
virtually any business process. However, certain specific types of business processes may be more
easily modeled using one of the more specialized process template.

Microsoft InfoPath Process Template
The Microsoft InfoPath process template can be used to represent a business process where the
entire process is associated with a single Microsoft SharePoint Form Library (and the Microsoft
InfoPath form associated with that Form Library). Each runtime process instance will be associated
with a specific copy of that InfoPath form. For this type of process model, the views of the InfoPath
form are used as the user interface for any of the process' manual tasks, and user input is stored
directly within the form's XML schema. 

Microsoft SPDoc Process Template
The Microsoft SPDoc process template can be used to represent a business process where the entire
process is associated with a specific Microsoft SharePoint Document Library. Each runtime process
instance will be associated with a specific item (i.e. document) within the specified Document Library.
This type of process model is typically used to create workflow solutions for document control and
management. This type of process model allows the library's metadata columns to be bound directly to
the process so that the documents' metadata values can be easily used within the process model.

For this type of process model, the user interfaces for any of the process' manual tasks are usually
implemented as ASP.NET pages that can be placed in and accessed from the same SharePoint site
that contains the Document Library. 
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Microsoft SPList Process Template
The Microsoft SPList process template can be used to represent a business process where the entire
process is associated with a specific Microsoft SharePoint List. Each runtime process instance will be
associated with a specific list item within the specified List.

This type of process model allows the list's metadata columns to be bound directly to the process
so that the lists' metadata values can be easily used within the process model. A typical usage
scenario would be to initiate a process with a new list item, then use a sub process to implement forms
interaction.

AgileForms Process Template
The AgileForms process template can be used to represent a business process that uses AgileForms.
To use this template, you must have the AgileForms Envision Add-On installed.

Select a Process Template Type
To begin creating an AgilePoint process, you must first select an AgilePoint process template type:
1. Click File > New > AgilePoint > [Process Model Type].

Open an existing Process Template
To create an existing process template, start AgilePoint Envision, then use the File > Open menu
command to open the VSD file that contains the process template.

Convert a Visio Diagram to a Process Model
To convert an existing Visio diagram into a process template:
1. Start AgilePoint Envision.

2. Create (or open) a process template.

3. Click File > Export & Import >  Import Existing Visio file.

4. Select the VSD file that contains the Visio diagram you want to convert. This will import the
contents of the selected Visio diagram into your process template.

5. Once the diagram's contents are imported, convert the Visio shapes into AgilePoint AgileShapes.
Once all of the imported shapes and connectors are completely converted and integrated into the
process template, you can continue to work on the process template like you would normally.

Process Template Properties
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Process Template Properties Overview
The following properties are available at the process template level in AgilePoint Envision.

Process Template Properties
The following AgileShapes belong to the Premier Extension Stencil Pane in AgilePoint Envision.
The Process Template Properties are visible when no activities are selected in the process model. A
definition for each property can be found below.



Process Templates 278

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

Design-Time Properties

(Name) 

The actual name of the process template that AgilePoint retains.

Current Version

The current version of the process template. The next time the process template is deployed to
AgilePoint Server, the process version will be updated.

Description

Provides a text box pop for which to enter a description for the process template.

Document Reference

A reference to a document associated with the process template.

Expected Time

The amount of time that is configured for the process to complete.

Business Time

Specifies if the expected completion time will be based on business days. This property can be set to
the following specific values:

• True - This value indicates that the expected time will be based on business days, where 5 days
is equal to 1 week.
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• False - This value indicates that the expected time will be not be based on business days, where
7 days is equal to 1 week.

Length

The number of time units for the expected time (e.g. 1 second, minute, hour, etc.).

Time Unit

The unit of time to be used for the expected time.

Owner

A name given to the owner of the process template.

Previous Version

The previous version of the process template.

Application

The process template application type (e.g. SPSIntegration for SharePoint based process templates
that will be associated with a SharePoint library or list, or a custom name given as the name of an
ASP.NET application).

Assembly Name

The name of the custom assembly that the process template is associated with.

Audit Level

Default value: High 

This property determines the amount of process related data that is recorded to the workflow
database. This property can be set at either the Process Template Properties layer or at the individual
AgileShape layer. This property allows you to control the level of granularity in terms of the amount
of process related data that is recorded to the workflow database. This property can be set to the
following specific values:

• High - This value indicates that AgilePoint will record all data about the activity or process to the
database.

• Low - This value indicates that AgilePoint will only allow a certain amount of data to be recorded
to the database. This option provides a level of control over the granularity of AgilePoint process-
related data that is stored in the AgilePoint workflow database, giving some flexibility in the audit
trail records by filtering out unnecessary data.

Class Name

The name of the custom class that the process template is associated with.

Initiate Constraint

The type of process model. This determines the category for which this process model is associated
under the license model. If the process model is of type ChildProcess, it cannot be initiated as a stand
alone process. A ParentChildProcess can be initiated as either a Parent or Child process, it counts as
a Parent process.

MaximumSessionAllowed

MaximumSessionAllowed allows you to set the MaxloopAllowed at the process model level to avoid
an infinite loop scenario. Now you can set the MaxLoop to a number where the engine will then mark
the process as suspended. The process level MaxLoop setting overwrites the global/server level



Process Templates 280

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

setting in the Netflow.cfg file. If this property is set to the 'Default' the process will inherit the global
global/server level setting in the NetFlow.cfg.

OnComplete

Determines the fate of the child process once the parent process completes. This property can be set
to the following specific values:

• LeaveChildProcessRunning - This value indicates that the child process will continue to run
after the parent process completes.

• CancelChildProcesses - This value indicates that child processes will be canceled once the
parent process completes.

• InheritParentProcess - This value indicates that child processes will inherit the OnComplete
properties of the parent process.

ConfigureAttachments  

Allows you to attach documents at the process model level that are accessed from the process
repository. For more information, see Process Repository on the AgilePoint Support Portal.

Reference URL

Allows you to associate an URL at the process model level that is used in the process repository. For
more information, see Process Repository on the AgilePoint Support Portal.

Convert a Visio Shape to an AgileShape
When you import an existing Visio diagram or copy a regular Visio shape and paste it into a process
template, you will need to convert the Visio shape(s) into one or more AgileShapes before those
shapes can be a part of the Process Model.

Visio shapes larger than 1.5 inches x 1.5 inches cannot be directly converted into an AgileShape, and
will need to be replaced with (rather than converted into) an AgileShape.

Visio shapes that do not represent an "activity" (e.g. flowchart shapes that represent conditional logic
or decisions) cannot be directly converted into an AgileShape, and will need to be replaced with
(rather than converted into) an AgileShape (see below).

1. Click on the shape you want to convert to select it.

2. Right-click the selected shape and click Convert to Activity.

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
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3. In the Choose Activity Type window, select the type of AgileShape the shape should be converted
into.
 

 
See Process Template AgileShapes for more information about the types of AgileShapes and how
the Work To Perform property is used for each type of AgileShape.

4. (Optional) Check the "Replace Shape" check box if you want the converted shape to appear like
the type of AgileShape you selected. Uncheck the "Replace Shape" check box if you want the
converted shape to be displayed in the process model with the same graphical appearance as it
had prior to conversion.

5. Click the OK button.

6. (Optional) Configure additional properties of the converted AgileShape as you would for a normal
AgileShape (i.e. using the Activity Properties window).

To replace a Visio shape with an AgileShape:

1. Add one or more AgileShapes to your process template, and configure them as appropriate.

2. Change any connectors that are connected to the Visio shape so that they are now connected to
the AgileShapes you just added.

3. Remove/delete the Visio shape from the process template.
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Add an AgileShape to a Process Model
Adding an AgileShape to a Process Model is the same as adding a Visio shape to a Visio diagram.
Simply click and drag an AgileShape (from a stencil in the Shapes window) onto your process
template.

Remove an AgileShape from a Process Model
Removing an AgileShape from a Process Model is the same as removing a Visio shape from a Visio
diagram. Simply click the AgileShape to select it, and then press the delete key.

Change an AgileShape's Display Name
To change an AgileShape display name:

1. Double-click the AgileShape, and then type a new name.

Configure AgileShape Properties
To configure the properties of an AgileShape instance, first click the AgileShape to select it. Then
use the Activity Properties toolbar (shown below) to modify any of the AgileShape's configurable
properties.
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You can switch between the view using the toggle buttons ( ) at the top of the toolbar. See
Process Template AgileShapes for more information about each of the properties listed in the Activity
Properties toolbar.

Connecting AgileShapes To Each Other
Connecting AgileShapes in a process template is similar to the process of connecting Visio shapes in

a Visio diagram. First you would select Visio's Connector Tool (  ). Next you would click and hold
on to an Out Connection Point of an AgileShape, and then drag the mouse pointer to an In Connection
Point of another AgileShape (and then release the mouse button).

Some AgileShapes have Connection Points that can be used as either an In Connection Point or
an Out Connection Point, while others have Connection Points that may only be used in a specific
direction. For example, the Single Condition AgileShape has 2 Connection Points labeled Yes and
No. These 2 Connection Points must always be used as Out Connection Points, while the unlabeled
Connection Points must always be used as In Connection Points. However, you can configure which
side the labeled points are positioned on by Right-Clicking and selecting Flip Yes or Flip No.

Manage Process Attributes
You can define custom attributes in your process by selecting them from a common reference point
in a dialog box, rather than typing the exact name in the data binding field. This additional setup step
declares your attributes in a common location in the process template, but it can save you time and
effort if you want to use many custom attributes in your process.

1. Declare your custom attributes for use throughout the process template:

a. In AgilePoint Envision, open a process template, and select the process template to display its
properties in the right pane. 

b. Below the properties box, click the Manage Process Attributes link.

c. In the Manage Custom Attributes window, click Add.
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d. In the Attribute Name column, enter the name of the attribute you want to create.

e. In the Attribute Type column, select the data type for the attribute.

f. When you have finished adding all attributes you want to create, click OK.

2. Select the custom attributes you want to use:

a. Drag any AgileShape that uses data binding onto your process template – for example, the
Participants property in a Manual activity.

b. Select the shape you added. In the property where you want to use the custom attribute, click
the appropriate field to open the schema binding dialog box. (From the previous example, for
a Manual activity, in the Participants list, click Add Participant.)

c. In the Data Binding field, click the Ellipses (…) button.

d. On the Select XPath from XML Schema dialog box, click the Process Attributes tab.
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e. In the Custom Attribute Collection list, select the attribute you want to use, and click OK.

Using Swim Lanes in Envision
Swim Lanes allow for blocks to be added to the modeling canvas that belong to a particular AgilePoint
group, role, or a single participant. When a manual activity is added to a Swim Lane, the AgilePoint
group, role, or participant is automatically assigned based on which Swim Lane the manual activity is
dropped (i.e. where Swim Lanes are tied to participant(s).
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Registering a custom AgileShape
Custom AgilePart and AgileWork components must be registered before they can be used in a
process template. Registration requires that a .NET assembly (containing at least one AgilePart and/or
AgileWork component) be imported into AgilePoint Envision.

To register a custom AgilePart:

1. Use the File > Extend AgilePoint > Register AgilePart menu command.

To register a custom AgileWork:

1. Use the File > Extend AgilePoint > Register AgileWork menu command.
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Applying Process Attributes
Process attributes can be initialized, updated, and/or retrieved directly from within the process model.
For example, the Single Condition and Multiple Condition AgileShapes allow you to route the process
flow based on whether the current value(s) of specified process attributes match criteria defined by the
process modeler from within AgilePoint Envision.

Furthermore, several built-in AgileShapes allow the process modeler to initialize and/or modify the
value(s) of one or more process attributes. For example, the C# Snippet AgileShape allows the
process modeler to initialize and/or modify the value(s) of one or more process attributes to a value
derived by executing a specified fragment of C# code at run time. This allows even non-developers to
update the values of process attributes to values as simple as a literal value (e.g. a number, date, or
string). With very minimal training, it also allows for more complex and dynamic functionality such as
increasing a numeric attribute's value by 1, setting a date attribute to the current time, etc.

As another example, the SubProcess AgileShape allows the modeler to specify values for "initial
attributes" that will be pre-initialized for the sub process instance that will be created at run time.
Other AgileShapes also provide ways for non-developers to configure process attributes, and custom
AgileShapes allow you to add virtually any type of additional "data field" configuration capabilities you
may require directly into the process modeling environment.
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Data Services
This section provides information and instructions about how AgilePoint Data Services is used to
collect and track application data.

The Data Services includes two core components:

• Data Population - Data Population allows you to write to a database the desired application data
values. The data can then be used for reporting purposes.

• Data Tracking - Data Tracking provides the functionality to set up fields in AgilePoint Envision
to be monitored for changes to application data, for example you can see for a specific field on a
form, the Old Value and if the data changes, the New Value. This viewpoint is provided via the
AgilePoint Enterprise Manager Data Tracking tab.

Configure the Windows Service for Data Services
1. Open the DataServicesWindowsService.exe.config at C:\Program Files\AgilePoint\AgilePoint

Data Services and change the following properties accordingly:

• DbConnectionString: This connection string should point to the Database which contains the
WF_DATA_TRACKING table where the output of the data tracking is stored.

• TempDbConnectionString: This connection string should point to the Database which
contains WF_DATA_SERVICE_TEMPDB which is populated by the AgileConnector with
the before and after XML values.  Set this to the same value that is configured for the
Agileconnector.

• EnableDataPopulation: Set this to true to enable Data Population.

• EnableDataTracking: Set this to true to enable Data Tracking.

• TimerInterval: This is the timer interval used by the Windows Service to check for any new
entries in the Temporary database.  On a production system, this can be set to a high interval
like 3600 (i.e. one hour).

Change the Logon Credentials
Before starting the Windows Service, change the Log On credentials to Administrator (as the Local
Service account which is the default used by the Windows Service does not have enough access
privileges to AgilePoint Server). This can be done as follows:

1. Open the Services console.

2. Right-click on the AgilePointDataServices and open the Properties window.

3. On Log On tab, select This account, and enter the Administrator account information as follows:
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4. When finished, click OK.

5. Start the Windows Service.

Modify the Enterprise Manager web.config
1. Add the following element under <AppSettings> in the Enterprise Manager web.config file:

<add key="DataTrackingConnectionString"
  value="<Connection string>" />

Add a valid connection string depending on your database that is used for data tracking.  

Example:

<add key="DataTrackingConnectionString"
   
 value="server=[hostname];database=AgilePointTracking;trusted_connection=true"
    />
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The web.config file for Enterprise Manager can be located at: C:\<AgilePointServer>
\EnterpriseManager

Enable the Server Extension
1. Open the AgilePoint Server Configuration utility and go to the Extension window.

2. Click the Add button.

3. Click the Ellipses button on the Extension window and add the following assembly: …
\AgilePointServer\bin\Ascentn.AgileConnector.DataService.dll

4. Give the AgileConnector a unique name based on the Application for which it will be associated.

5. Click OK.

6. Click the Configure button and configure the Data Service as shown in the following screen
capture.



Data Services 291

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

7. The Application Filter field should be set to SPSIntegration for InfoPath applications, for ASP.NET
applications, set the Application Filter name to the Application name specified in the Process
Template (e.g. MyASPApplication as shown below).

8. Ensure that the Connection String points to a valid database that contains the Temporary tracking
table for the Data Services. 

9. Click OK.

Data Population
Data Population allows you to write to a database (SQL or Oracle) the desired application data values.
The data can then be used for reporting purposes. For Data Population, the data tracking database
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that is created should include table columns based on the fields from the form, the Primary Key should
be the Process Instance ID.

The configuration is done via AgilePoint Envision.

To setup the Data Population:

1. Click the Data Population link in the Process Templates Properties pane.

The Connecting to Server window appears.

2. Select the Logon type and click OK.

The Data Population Configuration window appears. This windows allows you to select either
a Basic or Advanced way of configuring the repository and setting up the mapping for data
population.

3. Select one of the following:

• Basic - Suitable only for development environments where the data source resides on the same
machine as the AgilePoint Envision client.

• Advanced - Suitable for environments where the data source resides on a separate machine from
the AgilePoint Envision client.

If you selected the Basic option, the Data Service Configuration window appears.
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1. Click the Ellipses button to populate the database list with all the databases on the server.

2. (Optional) Change the Target Table name if desired.

3. Select the Data Fields from the forms schema for which to populate data to the database.

4. Click Finish.

If you selected the Advanced option, the Configuration Repository window appears.



Data Services 294

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

1. In the Repository field, select either Microsoft SQL Server or Oracle to write the data to a
database, or SharePoint list to write the data to a SharePoint list.

2. Do one of the following:

• If you have chose to write the data to a database:

1. Click the Configure button to configure the database connection details.

2. Click the Retrieve button to retrieve the database table names.

3. (Optional) In the Runtime Database connection string field, enter the database connection
string that will be used at runtime.

4. Click OK.

• If you have chosen to write data to a SharePoint list:

1. In the Site URL field, enter the SharePoint Site URL for the list and click the green arrow to sync
with the list.

2. In the List Name field, select the list(s) name(s) for which to populate data. Also select the
Primary Key to be used for each list.

3. (Optional) In the Runtime Server URL field, enter the SharePoint site URL that will be used at
runtime.

4. Click OK. The Schema Mapper window appears.
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The left window pane shows the form's Schema, the right side shows the database structure.

5. Map the fields accordingly from the form's schema on the left to the database fields (and all
the attributes on the right). To map an element to the processId drag and drop as usual to the
respective field, while mapping to a processed, the right element must be of type string, else it will
give an error message.

6. You will see the connection lines appear as shown above. The connection lines may show
different colors based on the compatibility of the data types as follows:

• Green - The data type matches.

• Blue - The data type does not match, the system will handle the conversion.

• Red - The data type does not match, custom data conversion is required. In this case,
click the Add button and add the custom mapping code as necessary to handle the data
conversion.

7. After the mapping is complete, click OK to save the mapping and close. At runtime, the database
or SharePoint List is populated with the values of the form fields. 
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Mapping Custom Attributes to Multiple Tables
The following instructions are a use case for mapping custom attributes to multiple tables.

1. Create a Generic AgilePoint application without a schema.

2. Add a couple of Update Custom Attribute activities to change the Custom Attribute values. Add a
Delay shape in between to observe the changes. The AgilePoint process will look something like
this:

3. Click the Data Population link to open the Configure Repository dialog. Select the Database as
Repository and set the Database connection string and click the Connect button to display the
list of tables present in the specified database.

4. Select the tables that are required and set the Runtime address string (optional), then click OK.

5. In the Custom Attributes Mapping window, enter the attribute name in the AttributeName
column and select the FieldName to which the attribute has to be mapped.
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Data Tracking
Use this procedure to set up the Data Tracking.

1. Click the Modify Tracking link in the Process Templates Properties pane.

The Attributes Tracking Dialog appears.

2. The Conditional Data Tracking field can be used to enable conditional data tracking and would
take an expression (e.g. enter ${ to bring up the list of friendly names, select Amount and type
>500 to track the data only if the Amount is greater than 500).

3. In the Attributes to be tracked box, select the fields for which to track from the schema.

This information is then provided via the AgilePoint Enterprise Manager Data Tracking tab.
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Email Templates and Notifications
Email notifications are dynamically constructed and sent at runtime using the specified Email
Template in the Activity Properties toolbar. An activity can have more than one email related property.
For example, an activity can have multiple email notifications related to the different stages of the
activity. This allows different types of email notifications to be sent out during the different stages of an
activity. The different types of email notifications include:

• Activity Entry Email - Email that is dynamically constructed and sent automatically to the
participant(s) defined in the email template notifying them when the activity is entered.

• Activity Exit Email - Email that is dynamically constructed and sent automatically to the
recipient(s) defined in the email template notifying them when the activity is exited.

• Task Reassigned Email - Email that is dynamically constructed and sent automatically to the
participant(s) defined in the email template notifying them that the activity has been reassigned.

• Activity Timeout Email - (Available only for the Manual with Timeout activity) Email that is
dynamically constructed and sent automatically to the participant(s) defined in the email template
notifying them when the activity pasts its due date.

• Reminder Email - Email that is dynamically constructed and sent automatically to the recipient(s)
defined in the email template reminding them of an activity to complete. The Reminder Email
Notification can be configured to be sent at recurring intervals.

Email Template Window
This section provides information and instructions about how to use the fields in the Email Template.
The fields in the Email Template are used to specify what the participant(s) will see when the Email
Notification is opened.
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In addition to manually typing in the value of a field, most of the fields in the Email Template allow you
to also select from a list of process attributes to dynamically populate that field at run time. To bring up
the list of available process attributes, type ${ in the text box and select the process attribute for which
you would like to use in that field. For example, you may want to select ${TaskParticipantUserName}
in the To field of your Email Template. The To field will be populated with the user name of the task's
participant.  

Incoming and Reminder Emails are sent separately for each participant, while Activity Exit Emails are
sent per activity (regardless of number of participants). Therefore, if your email address is in the To or
CC field of the email template associated with the Activity Entry Email, you will get X number of copies
of the email. If the entire list of (potential) participants is in the To or CC field, then all of the (potential)
participants will receive X number of copies of the email. If you use the ${TaskParticipantUserName}
process attribute in the To field instead of specifying the entire list of participants in the To field, then
for each participant, a separate email will be sent, and none of the participants will receive duplicate
copies of the email.

If you want to send a single email to all of the (potential) participants (instead of separate messages),
you could use the Email AgileShape to send a single email, instead of associating your template with
the Activity Entry Email property of a multi-participant manual activity.
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Field Definitions

Field Name Definition

Name The Name field is used to display the name of an
Email Template. The name specified should be
meaningful to the process modeler.

From The From field is used to specify what gets
displayed in the From field of the Email
Notification. This field supports the use of pre-
defined process attributes. When a pre-defined
process attribute is used, the "domain\username"
will be converted automatically.

To The To field is used to specify what gets
displayed in the To field of the Email Notification.
This field supports the use of pre-defined process
attributes. When a pre-defined process attribute
is used, the "domain\username" will be converted
automatically. You can add multiple entries by
separating them with a semicolon.

CC The CC field is used to specify what gets
displayed in the CC field of the Email Notification.
This field supports the use of pre-defined process
attributes. When a pre-defined process attribute
is used, the "domain\username" will be converted
automatically. You can add multiple entries by
separating them with a semicolon.

Subject The Subject field is used to specify what gets
displayed in the Subject field of the Email
Notification. This field supports the use of pre-
defined process attributes.

Priority The Priority field is used to specify the priority
setting of the Email Notification. Valid values for
this field include: Normal, High, and Low.

Format The Format field is used to specify the format for
which the content of the email will be displayed.
Both HTML and plain text are supported
formats for email. HTML is set as the default
as part of the SMTP settings during the Server
Configuration process. To send email in plain text
format, select Text from the drop-down list. 
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Field Name Definition

Left to Right/Right to Left The Left to Right and Right to Left option buttons
allow you to change the alignment for which text
is inserted into the content section of the Email
Template.

Content The Content field is used to type the custom
message to be displayed in the body of the Email
Notification. This field supports the use of pre-
defined process attributes.

In order to show a URL link as a clickable HTML
link in the email notification, the URL link must be
entered into the email template with the HTML
tags. The following is an example of how to
include an URL link with HTML tags:

<a href="http://machinename:portnum/
applicationname/ApproveRequest.aspx?
${TaskID}"> Please click this link to invoke the
Request Form.</a> <br></br>

Attachments The Attachments field is used to specify any
files that you would like to include in the Email
Notification. To attach a file to the notification,
type in the full path of the file e.g., C:\My
Documents\sample.doc. You can also use a
custom attribute to attach a file to the notification
e.g., ${AttachDoc} or ${HomeDirectory}\...

Email Template Process Attributes
When you create an email template, you can select from a list of built-in process attributes to
automatically populate a field in your email template. A built-in process attribute is simply a name
that has been assigned to represent a specific variable in a process. For example, you can select
${ProcessInitiator} in the From field of your email template. This way, the user name of the Process
Initiator will be used in the From field of your email.
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Data Binding in an Email Template
AgilePoint allows you to use built-in process attributes that access InfoPath XML Schema or SPDoc
metadata. In InfoPath based process instances, you can access all or part of the form's XML.
Using the special $/ attribute contains the XML of the entire InfoPath form. By specifying an XPath
expression $/{XPathExpression} (in place of a custom attribute name), you can access a specific
section or element of the XML.

E.g. $/*, $//*, $/exp:expenseReport, ${/exp:expenseReport/exp:startDate}

To access an InfoPath Form's XML Schema or SPDoc metadata:
1. Type ${ in the body of the email template to bring up the list of available process attributes.
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2. Select <XML Schema> from the list. The InfoPath DataSource window appears.

For SPDoc, the Select SharePoint Document Library Column window appears.

3. Select the data column for which you would like to associate.

4. Click OK. The association is shown below.
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Create a new Activity Entry Email Notification
1. Access the Email Templates Wizard. The Email Templates Wizard can be accessed using the

View > Email Templates Wizard menu command. It can also be accessed by selecting the Add
Mail Template option (shown below) in the Activity Properties toolbar.
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2. Click the New button. The New Name window appears.

3. Type a name for the new email template and click the OK button. The Email Templates Wizard
reappears with the name of the new email template.

4. Complete the From, To, CC, and Subject fields. For more information, see Email Template
Fields.
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5. Select the priority to be assigned to the email. Normal is set as the default.

6. Select the format for which the email content will be displayed. Both HTML and plain text formats
are supported.

7. Type the content of the message. The Left to Right and Right to Left option buttons allow you to
customize the alignment of the content.

8. (Optional) To attach a file to the email, type the full path of the file in the Attachments text box
(e.g., C:\My Documents\sample.doc). To attach multiple files, use a semicolon.

9. Click the OK button. The Email Notification is now part of the process. The same steps can be
repeated to create Outgoing, Reassigning, and Activity Timeout Email Notifications. For more
information, see Email Template Window on the AgilePoint Support Portal.

Create a Reminder Email Notification
1. In the Activities Toolbar, place your cursor in the Reminder Email text box and click the button

to open the Reminding Mail window.

2. Select a specific Email Template that should be used to generate the reminder email
notification(s).

3. Configure the start time (relative to the activity's expiration) and the frequency of recurrence for
which the email notification(s) will be sent.

4. Click OK. The Reminder Email Template is now part of the process.

Approval Email Templates
You can create an email template for the Activity Entry Email that participants will use to indicate
approvals.

http://support.agilepoint.com/SupportPortal/
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Create a Text-Based Approval Email Template
You can create an email template for the Activity Entry Email that participants will use to approve a
request using a text-only format.

In the email body, include the following information. Note that the terms used in the email can follow
the format approved/rejected, or yes/no.

Approval Keywords Rejection Keywords

{Approve [] = {Xpath-Node}=Value} {Reject [] = {Xpath-Node}=Value}

{Approved [] = {Xpath-Node}=Value} {Rejected [] = {Xpath-Node}=Value}

{Yes [] = {Xpath-Node}=Value} {No[] = {Xpath-Node}=Value}

{Remarks [] = {Xpath-Node}}

• Xpath-Node  represents a valid Xpath node -- for example, {/pd:MyFields/pd:Approval}

• Value  represents the value you want to pass when the user selects this option. A common
usage is True or False. The action that is selected with the X will be processed along with any
information in the remarks section.
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Create an HTML-Based Approval Email Template
You can create an HTML-based email template for the Activity Entry Email that participants will use to
approve a request.



Email Templates and Notifications 309

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

To create an HTML-based email templates for approval:

1. In the Email Templates Wizard, click the HTML code button (< >).

2. In the email body, paste the following HTML code.

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN">
<HTML><HEAD><TITLE></TITLE>
<META http-equiv=Content-Type content="text/html; charset=utf-8">
<META content="MSHTML 6.00.6001.18319" name=GENERATOR>
   </META></HEAD>
<BODY bgColor=#ffffff>
<STYLE type=text/css>
<!--
p.one
{border-left-color:#397dd0;
border-bottom-color:#397dd0;
margin-left:50px;
width:500px;
border-top-style:solid;
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border-top-color:#397dd0;
border-right-style:solid;
border-left-style:solid;
height:225px;
border-right-color:#397dd0;
border-bottom-style:solid}
-->
</STYLE>
<P class=one style="WIDTH: 444px; 
   HEIGHT: 257px"><BR>
<TABLE name="ApprovalInfo">
<COLGROUP width=25></COLGROUP>
<TBODY>
<TR>
<TD></TD>
<TH><SPAN style="FONT-FAMILY: Arial Narrow">
   Approval Information:</SPAN></TH></TR>
<TR>
<TD></TD>
<TD><SPAN style="FONT-FAMILY: Arial Narrow">
   <INPUT type=radio CHECKED 
   name={/pd:myFields/pd:Approved}> Approved</INPUT> 
   </SPAN></TD></TR>
<TR>
<TD></TD>
<TD><SPAN style="FONT-FAMILY: Arial Narrow">
   <INPUT type=radio  name={/pd:myFields/pd:Approved}> 
   Rejected</SPAN></TD></TR>
<TR>
<TD></TD>
<TD><SPAN style="FONT-FAMILY: Arial Narrow">Remarks: 
   </SPAN><INPUT 
style="WIDTH: 250px" size=25 value="Test Remark" 
name={/pd:myFields/pd:Remarks}></TD></TR>
<TR>
<TD></TD>
<TD><SPAN style="FONT-FAMILY: Arial Narrow">Please 
   don't remove or edit the information below this line.
   </SPAN></TD></TR>
<TR>
<TD></TD>
<TD><SPAN style="FONT-FAMILY: Arial Narrow">
<HR>
</SPAN></TD></TR>
<TR>
<TD></TD>
<TD><SPAN style="FONT-FAMILY: Arial Narrow">
   TaskId: ${TaskID}</SPAN></TD>
</TR>
<TR></TR>
<TR></TR>
</TBODY>
</TABLE></P></BODY></HTML>

3. Modify the text of the email template as required.
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4. When you have finished modifying the email template, click OK.

Email Approval on Mobile Devices
If an approver is using a mobile device, he or she cannot use the standard email approval methods
because it is not possible to edit email histories on many mobile email applications.

As an alternative to the standard text or HTML email approval methods, an approver can reply to the
approval email with one of the following keywords as the first word in the email body.

Approval Keywords Rejection Keywords

Approve Reject

Approved Rejected

Yes No

Custom Macros
A custom macro is used to simplify the data entry task when constructing an email notification by
using a single attribute name (or macro) to refer to a combination of process attributes. Custom
macros are stored in the process attribute list with a "*" for easy identification and can be reused when
constructing additional email notification templates in the future.

In the steps below, a macro has been created called AccountInfo that has been defined as:

${ActivityName}<br>${ActivityParticipantFullNames}

When *AccountInfo is selected from the process attribute list,

${ActivityName}<br>${ActivityParticipantFullNames}

is displayed. Follow the steps below to create and use this custom macro in an email template.

To create a custom macro:

1. From the E-mail Templates Wizard, click the Macro button. The Custom Mail Template Macro
window appears.
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2. Type a name for the macro in the "Name" text box.

3. Define your custom macro in the "Macro" text box. You can use the list of process attributes to
build your custom macro. In the window capture above, a custom macro called "Account Info"
has been created so that when the AccountInfo macro is selected, the Activity Name and Activity
Participant Full Name are inserted.

4. Click the Add button. The custom macro is added to the list.

5. Click the Close button to return to the E-mail Templates Wizard.

6. When it is time to use the macro, type ${, the custom macro that you have created will be
available in the list. Notice that the macro has a "*" next to it to identify it as a custom macro.

7. To use this custom macro, in the body of the email template, type ${ and select *AccountInfo. The
macro definition is inserted as shown below.
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Process Repository
Process Repository enhances collaboration and process documentation where you store the .vsd file
to a SharePoint Document Library, and also attach documents or a URL hyperlink to any AgilePart
or AgileWork. Also supported is the ability to attach process documentation at the process level.
SharePoint is used as the process repository where all artifacts of a process can be accessed.

In order to utilize the Process Repository functionality, first verify that the AgilePointProcessRepository
template is available in SharePoint.

Verify the ProcessRepository Template Exists
1. On the SharePoint site, click Site Actions > Create.

2. Verify that AgilePointProcessRepository is available under the Libraries section.

3. You will use this template to create the process repository in SharePoint. If the site template is not
shown in the list, your SharePoint site administrator will need to deploy the ProcessRepository.stp
template file.

For more information, see Deploying a SharePoint Site Template File on the AgilePoint Support
Portal.

Set Up a Process Repository
To setup Process Repository in SharePoint:

1. Create a new SharePoint library and select the AgilePointProcessRepository template type.

2. Name the new library AgilePointProcessRepository or give it a desired name.

http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/


Process Repository 315

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

3. The AgilePointProcessRepository library is now created for you, you will use this repository
to publish the .vsd (AgilePoint Process Model) for collaboration, and also access the process
documentation.

4. AgilePoint Envision allows you to attach documents or a hyperlink at the process model level,
and/or at the activity level (i.e. AgileParts and AgileWorks). The documents are to be stored in
a SharePoint document library. If you would like to attach documents to the process, create a
document library in SharePoint (e.g. Travel Request Process Documentation) to store the process
documentation.

Setup Process Discovery in AgilePoint Envision
AgilePoint Envision allows you to attach documents or a hyperlink at the process model level, and/or
at the activity level (i.e. AgileParts and AgileWorks).

Associate Process Documentation at the Process Model Level
1. Ensure that no activities are selected and the Process Template properties are visible.

2. In the ProcessRepository section, click the ConfigureAttachments property and click the ellipses
button to open the Configure Attachments window. The Configure Attachments window appears.

3. Click Add > SharePoint Document Library. The Get SharePoint Document Library window
appears.

4. In the SharePoint Server URL, type in the SharePoint URL and click Get Doc Lib.

5. Check the Windows Authentication check box to allow the OS to authenticate you in SharePoint
or provide alternative credentials in the text boxes provided to connect to SharePoint. Once
connected, the Document Libraries are populated in the list.

6. Select the Document Library where your documents are stored, select the document and click
OK.
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7. The Configure Attachments window appears and the document now shows in the list of
attachments. To add another document click Add. To remove a document click the document and
click Remove. To open the document select the document and click Open.

Select the check box in the View column to enable the attachment to be viewed directly from the
process model diagram.
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You can also add a hyperlink to any online artifact by right-clicking and pasting the URL into the
Reference URL property.

Associate Process Documentation at the Activity Level
1. In a process model, click an AgilePart or AgileWork for which you would like to associate process

documentation.

2. In the ProcessRepository section, click the ConfigureAttachments property and click the
ellipses button to open the Configure Attachments window. The Configure Attachments window
appears.

3. Click Add > SharePoint Document Library. The Get SharePoint Document Library window
appears.

4. In the SharePoint Server URL, type in the SharePoint URL and click Get Doc Lib.
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5. Check the Windows Authentication to allow the OS to authenticate you in SharePoint or provide
alternative credentials in the text boxes provided to connect to SharePoint. Once connected, the
Document Libraries are populated in the list.

6. Select the Document Library where your documents are stored, select the document and click
OK.

7. The Configure Attachments window appears and the document now shows in the list of
attachments. To add another document, click Add. To remove a document click the document
and click Remove. To open the document select the document and click Open.

Select the check box in the View column to enable the attachment to be viewed directly from the
process model diagram.
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You can also add a hyperlink to any online artifact by right-clicking and pasting the URL into the
Reference URL property.
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Publish Process Documentation to SharePoint
This section provides information about the publishing the process documentation to SharePoint.

1. Click File > Update Server > Publish Process Documentation to SharePoint. The SharePoint
Process Repository window appears.

2. Enter the SharePoint Site URL and click Connect.

3. Select the SharePoint Document Library and click Show Folder Tree.

4. Select the SharePoint document repository, or click Add Folder to add a folder to use as the
process repository and click OK. The Process Repository Information window appears.
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The information entered in this window will be shown as metadata columns in the SharePoint
process repository.

5. Click the User/Owner ellipses button and select the SharePoint user that is the manager or owner
of this process.

6. Click the Role ellipses button and select the SharePoint role associated with the User/Owner.

7. Enter a description for this process and any comments and click OK. The process model .vsd and
associated document(s) are now published to the SharePoint process repository.

Also you can see that the document association appears in the process model.
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You can remove the document association text from showing in the process model, by right-clicking
the activity and selecting Hide Properties. You can also view the document from the Envision process
model by right-clicking the attachment and clicking the attachment.

Open the Process Repository in SharePoint
Once the AgilePoint Process Repository has been setup in AgilePoint Envision and in SharePoint, you
can now open the process repository in SharePoint.

1. Open the AgilePoint Process Repository SharePoint library.

2. In the Type column, click the Internet icon. The Process Discovery page appears.
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3. Click the document attachment name (e.g. Submit Activity Use Case.one) to open the document.

4. From the SharePoint process repository library, click the Process Name drop-down and notice
that all the general SharePoint options are available for associating workflows, Check Out, etc.
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Edit Stencil Images
This section provides information and instructions about how to create and edit AgilePoint related
stencils and their shapes in Visio, as well as how to associate shapes to AgilePoint activities.
AgilePoint comes with several built-in activities that already have their own graphics and icons. You
may want to substitute in your own images, or implement new stencils and shapes for your custom
AgilePoint activities (e.g. AgileParts and AgileWorks). AgilePoint Envision provides you a way to
customize the stencils and shapes and associate them with AgilePoint activities.

Create and Save a New Stencil
This option allows you to create a new stencil. A stencil contains a group of shapes that you can drag
and drop to construct your process model. The easiest way to do this is to copy an existing AgilePoint
stencil as a base and work from that.

1. In Windows Explorer navigate to C:\Program Files\Microsoft Office\Office12\1033\Solutions
\AgilePoint or similar path depending on your environment.

2. Make a copy of the Generic.vss file and place it in the same folder.

3. Give the copy a descriptive name for the new stencil (e.g. IT Assets Group 1).

4. Open AgilePoint Envision, click the Shapes button and click IT Assets Group 1.

5. The stencil appears as Generic BPM in the stencil pane. Rename it by right-clicking on the stencil
title and clicking Edit Stencil. The Stencil opens in edit mode.

6. Right-click again and click Properties.

7. In the Title field, type a name for the new stencil (e.g. IT Assets Group 1) and click OK.

8. Delete the existing icons in the new stencil so that you have a clean slate and save the stencil
by clicking on the Save button next to the stencil. Saving as Visio 2002 will ensure backward
compatibility.

Create a New Master Icon
This part provides information for adding a new master icon to a stencil that can represent a custom
AgileShape.

1. Close AgilePoint Envision and leave MS Visio open as shown below.
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2. Click File > Open.

3. Navigate to the folder where the VSS files are stored (e.g. C:\Program Files\Microsoft Office
\Office12\1033\Solutions\AgilePoint) and open the new stencil (i.e. IT Assets Group 1).

4. Right-click in the new stencil pane and click New Master.

5. Give the new master a descriptive name (e.g. Procurement Algorithm). It is recommended to
choose Normal (32 x 32) for the icon size and to leave the behavior check boxes unchecked.
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6. Click OK.

7. Right-click on the Procurement Algorithm activity in the stencil pane and click Edit Master >
Edit Icon Image.

8. Either draw an icon pixel by pixel, or simply copy and existing icon and paste it here.
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9. When finished, close the icon window.

Associate a Master Shape with the Icon Image
This option allows you to add a master shape that represents an AgilePoint activity on the drawing
canvas.

1. Right-click on the icon image in the stencil pane and click Edit Master > Edit Master Shape.

2. Click Insert > Picture > From File.

3. Browse and select the image file (.bmp, .gif, jpg, etc.) to add. Proceed directly to the next step to
finalize the shape.
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Finalize the Shape
This option allows you to associate the stencil shape you just created with a custom AgilePart or
AgileWork assembly.

1. Click Tools > Macro > ThisDocument > FinalizeShape. The Choose Activity Type window
appears. Here are all the built in AgileShapes and custom AgileParts and AgileWorks that have
been registered in AgilePoint Envision.

2. Select either AgilePart or AgileWork depending on the type of custom activity, choose the name
from the list and click OK.

Edit an Icon Image on a Stencil
This option allows you to manually edit the icon image that displays in the stencil pane that represents
an AgilePoint activity.

1. In AgilePoint Envision, open the stencil that includes the icon image for which you would like to
edit.

2. Right-click the Stencil title (e.g. Generic) and select Edit Stencil. The Stencil appears in Edit
mode.

3. Right-click the icon image in the stencil pane and select Edit Master > Edit Icon Image. The
image file will be displayed and you can modify the icon as needed.
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Edit Master Shape
1. To edit the shape itself including the label and properties of the shape, right mouse on the icon in

the stencil pane and select Edit Master > Edit Master Shape. The shape image will be displayed.

2. Right-click the shape image and select Show ShapeSheet (you must be in the developer mode to
do this).

3. In the ShapeSheet, look for the LockGroup property and change the value from 1 to 0 to unlock
the group.

4. Right-click the shape image again and select Shape > Ungroup.

5. Now you can edit the image including the text in the image.



Custom Configured Stencils (My Stencil) 331

AgilePoint BPMS v5.0 SP2 AgilePoint Envision User's Guide r5.2.5

Custom Configured Stencils (My Stencil)
Envision users or administrators can modify the properties of an AgileShape, and then share them
with other Envision users using a special stencil called My Stencil. Envision administrators can make
the properties for shapes in this stencil read-only if desired.

A common use for this feature is a system administrator creating complex configuration settings for an
AgileShape, where the settings are common to many users within an organization. The administrator
sets up the configuration, and then shares the stencil. Business users then need only to add the shape
to their process models to implement the organizational standards.

For the most part, the behavior for sharing AgileShapes in Envision is the same for sharing any
shapes in Microsoft Visio. The main functionality that Envision has added are:

• Support for sharing AgileShapes, along with preconfigured properties

• Support for setting all properties collectively to read-only

Create an AgileShape with Preconfigured Properties
1. In AgilePoint Envision, open a process model of any type.

2. Open the stencil named My Stencil.

3. Drag and drop an AgileShape to the process model.

4. Modify the shape's properties as desired.

5. Drag the configured shape from the process model to My Stencil. You can create your own
stencil or use an existing stencil. If you use an existing stencil, you will need to make it editable
when prompted. When you drop the shape on the stencil, the Edit Master Properties dialog box
appears.

6. On the Edit Master Properties dialog box, complete the following fields as desired:

• Name – The name that appears below your shape in the stencil and by default in the process
model.

• Tooltip Description – The name that appears for the shape in the pop-up tooltip in a stencil.

• Allow everyone to edit properties – Selected means that the shape's properties are editable
by anyone. Deselected means that the shape cannot be edited, except by the creator.

7. Click OK.

Modify an AgileShape with Preconfigured Properties
To modify a customized AgileShape, do the following.

1. In AgilePoint Envision, open a process model of any type.

2. Open My Stencil with the customized AgileShape.
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3. Drag and drop the customized shape to the process model.

4. Follow the instructions in Creating a Customized AgileShape.

5. Drag the modified shape from the process model back to a stencil.
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Data Binding
AgilePoint allows you to bind to XML Schema or SharePoint Document Library metadata.

XML Schema Support for ASP.NET Applications
For ASP.NET applications, this feature enables the creation and manipulation of XML Data Schema
within AgilePoint Envision. An AgilePoint Developer created XML Data Schema file can also be
imported into AgilePoint Envision. 

Schema XML Binding
In InfoPath or ASP.NET based process templates, you can access all or part of the values stored
in the schema of the form to determine the routing of your process, or to display information in an
email notification. To access the InfoPath XML Schema within an email template, type ${ and select
<XML Schema>. If outside an email template, such as in a Multiple Condition Activity, you can simply
define the columns within the Data Binding field. You can also construct the process attribute syntax
manually to access a specific section or element of the XML. This is accomplished by specifying
an XPath expression ${XPathExpression} (in place of a custom attribute name). Below are a few
examples that can be used:

• $/*

• $//*

• $/exp:expenseReport

• ${/exp:expenseReport/exp:startDate}

In InfoPath or ASP.NET based process instances, you can access all or part of the form's XML. Using
the special $/ attribute contains the XML of the entire form. By specifying an XPath expression $/
{XPathExpression} (in place of a custom attribute name), you can access a specific section or element
of the XML e.g.: $/*, $//*, $/exp:expenseReport, ${/exp:expenseReport/exp:startDate}.

To access an InfoPath Form's XML Schema or SPDoc metadata:

1. Type ${ in the body of the email template to bring up the list of available process attributes.

2. Select <XML Schema> from the list. The InfoPath DataSource window appears.
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SPDoc Metadata Binding
In SPDoc based process templates, you can access the values of a SharePoint Document Library's
metadata columns. This data can then be used in your process (e.g. to determine the workflow in
your process, or to display information in an email notification). To access the metadata column(s)
within an email template, type ${ and select <XML Schema>. If outside an email template, such as in a
Multiple Condition Activity, you can simply define the columns within the Data Binding field. The Show
All check box allows you to see a complete list of metadata columns to choose from.
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For SPDoc, the Select SharePoint Document Library Column window appears.

1. Select the data column for which you would like to associate.

2. Click OK. The association is shown below.
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Windows
This section provides a list of pages in AgilePoint Envision.

Adding Participants to an Activity
This topic describes how to add participants to an activity.

In a Generic process template:

In a Microsoft InfoPath, Microsoft SPDoc, or Microsoft SPList process template:

Choosing a participant from the AgilePoint User list:
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Choosing a group of participants from the AgilePoint Group list:

Choosing a group of participants from the AgilePoint Role list:
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Choosing a group of participants from Active Directory:
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Select the AgilePoint Server URL and enter the login credential to connect to AgilePoint Server. The
Select Active Directory Group window appears.

Make sure the Active Directory Name (LDAP Path) is correct, enter the search criteria and click
Search. A list of groups from Active Directory appears. Select the group to add as the participant and
click OK to complete.

Group names can include up to 64 characters.

Choosing a group of participants from SharePoint:
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Select the AgilePoint Server URL and enter the login credential to connect to AgilePoint Server. The
Select SharePoint Group window appears.

Enter the SharePoint Site URL and click Connect. The available groups will appear. Select the Group
and click OK.
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Binding the participants to an InfoPath Form's metadata:
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Binding the participants to a SharePoint Document Library's metadata:

Add User To Group Configuration Window
This window allows you to configure the user information to be created in SharePoint.
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Field Definitions

Field Name Definition

Source Site URL Specifies the name of the list that includes the
affected (copied, moved, etc.) list items.

Group Name The name of the affected SharePoint Group (e.g.,
the group to be created, to be deleted, to which a
user will be added, etc.).

Email The email address for the user who will be added
to the SharePoint group.

User Notes Notes associated with the user to be added to the
SharePoint group.

Appointment Schedule for Exchange Server window
Specifies the configuration for the Create Appointment AgileShape.
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Field Definitions

Field Name Definition

Exchange 2007 or Exchange 2010 Specifies the version of your Microsoft Exchange
Server.

(Authentication) URL Specifies the Exchange Server URL.

(Authentication) Domain, Username, Password Determines that a specified account will be used
to access the Exchange Server and what the
credentials will be.

(Authentication) Use AgilePoint System User specifies to use the AgilePoint System User
credentials to access the Exchange Server.

The credentials and URL can be verified by
clicking the Test button. The Test button is
disabled if Use AgilePoint System User is
checked. In both cases, make sure that the user
has proper access rights to the Exchange Server.
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Field Name Definition

(Appointment or Meeting) Subject, Location, Start
Time, End Time, Time Zone

The details about the appointment or meeting.

(Appointment or Meeting) Body The body of the email. Accepts custom attributes
and schema by typing ${.

CAML Query Configuration
Use this window to configure a CAML query.

To configure the CAML query and create your view from available fields:

1. Enter the site URL in the Site Url text box and click Connect. The various Lists and Document
libraries are loaded in the List Name drop-down.

2. Select Show hidden fields if you want to use the SharePoint hidden fields in the CAML Query.

3. Select the List. All the columns in the selected list will be loaded in the Possible View Fields box.
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4. Move the required columns to the Configured View Fields list.

5. Configure the Where clause by selecting a nest type -- And or Or.

6. Select the columns required for the condition.

7. Select the Column to order the data by and the Sort Type.

8. Click the Query Options tab, and select options such as the maximum number of rows (Row
Limit), whether to include mandatory columns, Folder location and Group By Column.

9. Click the Output Mapping tab, and map the nodes from SharePoint column to the InfoPath
schema.

If the output type is an InfoPath form, the results from the operations performed by the CAML Query
AgilePart are automatically updated in the InfoPath form. The following conditions apply:

• The InfoPath form must have a repeating table which can be mapped to the row node.

• The columns must be mapped to this repeating table.

• The ItemCount node will contain the number of rows returned by the CAML Query. This can also
be mapped if required.

Configure Text File Window
Use this window to configure a text file.

Field Definitions

Field Name Definition

UNC The destination address of the file. Additional
behavior options are available.

File Content The content of the file. Additional behavior
options are available.

Configuration for Batch Inserting Database Record
Window
This property allows the process modeler to configure where and how the new database records are
inserted into the database.
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Field Definitions

Field Name Definition

ConnectionString The connection string that will be used to connect
to the database at runtime.

• Click Choose to select a connection string
from the list of shared custom attributes
(defined and managed in Enterprise
Manager.)

• Click Create to create a new connection
string. to create a new connection string.

TableName The name of the database table where this
AgileShape should insert the database record.

Configuration for Copy ListItems AgilePart
Specifies the configuration for copying list items.
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Field Definitions

Field Name Definition

Source Site URL Specifies the name of the list that includes the
affected (copied, moved, etc.) list items.

Source List Name Specifies the source SharePoint site URL that
includes the list for which items are to be affected
(copied, moved, etc.).

Source Folder Name Specifies the name of the folder that includes the
list items to be affected (copied, moved, etc.).

ListItem Field Name Specifies the name of the list item field to be
affected (copied, moved, etc.).

ListItem Field Value Specifies the value of the field to be affected
(copied, moved, etc.). This can be used as a
filtering mechanism where only fields with the
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Field Name Definition

specified value are affected. The following are
sample values:

• $\{ListItemID\} or $\{SubListItemID\}

• list item ID

Target List Name Specifies the name of the destination list for the
affected items.

Target Folder Name Specifies the name of the destination folder for
the affected items. If the folder does not exist the
system will automatically create it.

Target Site URL Specifies the target SharePoint site URL that
includes the destination list for the affected items.

Configuration for Creating List Item Window
Specifies the configuration for creating the list item.
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Field Definitions

Field Name Definition

List URL Specifies the URL for the associated SharePoint
list. A valid list URL is required, if a library URL
(such as document library URL or form library
URL) instead of a list URL is used, an error will
occur during execution. Below are examples of a
valid list URL:

• http://Machine_Name:port/sites/SiteName/
ListName

• ${DocUrl}

After entering the list URL, click the Connect
button. Now a Content Type can be selected.
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Field Name Definition

Content Type Specifies the Content Type for the list item. This
is an optional item, the system will get a default
Content Type for the configuration.

Folder Name Specifies the folder name under which a list item
will be affected (created, deleted, etc.). There are
two ways to specify a folder:

• Select a Folder Name from the drop-down
list.

• Input a Folder Name in the drop-down list, if
the list doesn't contain the folder, the system
will create it automatically.

After the first section is completed, all columns
(with the exception of read-only columns, e.g.,
Calculate) in the selected list are shown. The
Value column shows the Data Type of the
column. If the value is Text, input is to be a string,
if it is DateTime, input is to be a valid date, etc.
There are 4 ways to set the Value column:

• Input a value (string value or datetime value
etc.) or empty.

• Input a custom attribute name ${FuLLName}.

• Click the button at the right side to select
schema metadata associated with the
process model.

• The Attachment field allows you to attach
a file to the list item, there are 2 ways to do
this:

• Local machine path, such as c:
\FileName.Extension.

• Http path, such as Http://Url /
FileName.Extesion.

Configuration for Deleting Database Record(s) Window
This property allows the process modeler to configure where and how the records are deleted from the
database.
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Field Definitions

Field Name Definition

ConnectionString The connection string that will be used to connect
to the database at runtime.

• Click Choose to select a connection string
from the list of shared custom attributes
(defined and managed in Enterprise
Manager.)

• Click Create to create a new connection
string. to create a new connection string.

TableName The name of the database table where this
AgileShape should insert the database record.

Condition The SQL WHERE clause that defines which
database records should be updated.

Configuration for Deleting List Items Window
This window enables you to specify the configuration for deleting list items.
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Field Definitions

Field Name Definition

SiteURL This property specifies the URL for the new
where you want to add or remove the associated
item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}

List Name Specifies the name of the list where the list items
will be deleted.

Folder Name Specifies the folder name under which a list item
will be affected (created, deleted, etc.). There are
two ways to specify a folder:

• Select a Folder Name from the drop-down
list.

• Input a Folder Name in the drop-down list, if
the list doesn't contain the folder, the system
will create it automatically.
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Field Name Definition

After the first section is completed, all columns
(with the exception of read-only columns, e.g.,
Calculate) in the selected list are shown. The
Value column shows the Data Type of the
column. If the value is Text, input is to be a string,
if it is DateTime, input is to be a valid date, etc.
There are 4 ways to set the Value column:

• Input a value (string value or datetime value
etc.) or empty.

• Input a custom attribute name ${FuLLName}.

• Click the button at the right side to select
schema metadata associated with the
process model.

• The Attachment field allows you to attach
a file to the list item, there are 2 ways to do
this:

• Local machine path, such as c:
\FileName.Extension.

• Http path, such as Http://Url /
FileName.Extesion.

ListItem Field Name Specifies the name of the list item field to be
deleted. This allows you to delete only one field
from a list item.

ListItem Field Value Specifies a value for which all corresponding
fields will be deleted. This can be used as a
filtering mechanism where only fields with the
specified value are deleted.

Configuration for Inserting Database Record(s) Window
This property allows the process modeler to configure where and how the new database records are
inserted into the database.
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Field Definitions

Field Name Definition

ConnectionString The connection string that will be used to connect
to the database at runtime.

• Click Choose to select a connection string
from the list of shared custom attributes
(defined and managed in Enterprise
Manager.)

• Click Create to create a new connection
string. to create a new connection string.

TableName The name of the database table where this
AgileShape should insert the database record.

Configuration for Invoking Java Program Window
This window allows the process modeler to configure the details for invoking the Java program.
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1. Click the Search button to add a class that contains the main method for the startup class. It
automatically adds the folder where the startup class is located to ensure normal startup as shown
above.

2. Add all the libraries and/or class folders that the startup class requires by clicking either the Add
Class Folder or Add External JAR button.

3. Enter a custom parameter name for the output value in the "Return Value" text box. This is an
optional step and only returns the console output value.

4. To limit the run time, input the number of seconds before timeout.

5. Click OK when finished with the configuration.

Configuration for Retrieving ListItem Fields Window
Specifies the configuration for retrieving list item field values and where the values will be updated in a
custom attribute, schema metadata, or SharePoint metadata.
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After the Source Site is configured, the configuration window will look similar to below.
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The MetaData Name column is used to specify a custom attribute, schema metadata, or SharePoint
metadata where the value from the list field that is retrieved will be updated to.

The MetaData Name can be configured as follows:

1. Use the Add button to select a SharePoint metadata item.

2. Input a custom attribute name (e.g. Company1).

3. Click the button at the right side of the field to select a schema metadata.
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Field Definitions

Field Name Definition

List URL Specifies the URL for the associated SharePoint
list. A valid list URL is required, if a library URL
(such as document library URL or form library
URL) instead of a list URL is used, an error will
occur during execution. Below are examples of a
valid list URL:

• http://Machine_Name:port/sites/SiteName/
ListName

• ${DocUrl}

After entering the list URL, click the Connect
button. Now a Content Type can be selected.

ListItem Field Name Specifies the name of the list item field to be
affected (copied, moved, etc.).

ListItem Field Value Specifies the value of the field to be affected
(copied, moved, etc.). This can be used as a
filtering mechanism where only fields with the
specified value are affected. The following are
sample values:

• $\{ListItemID\} or $\{SubListItemID\}

• list item ID

Configuration for Stored Procedure or Generic SQL
Window
This property allows the process modeler to configure where and how the new database records are
inserted into the database.
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Field Definitions

Field Name Definition

ConnectionString The connection string that will be used to connect
to the database at runtime.

• Click Choose to select a connection string
from the list of shared custom attributes
(defined and managed in Enterprise
Manager.)

• Click Create to create a new connection
string. to create a new connection string.

SQL The SQL statement that will be performed on the
database by this AgileShape at runtime.

Configuration for Updating Database Record(s) Window
This property allows the process modeler to configure where and how the new database records are
inserted into the database.
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Field Definitions

Field Name Definition

ConnectionString The connection string that will be used to connect
to the database at runtime.

• Click Choose to select a connection string
from the list of shared custom attributes
(defined and managed in Enterprise
Manager.)

• Click Create to create a new connection
string. to create a new connection string.

TableName The name of the database table where this
AgileShape should insert the database record.

Condition The SQL WHERE clause that defines which
database records should be updated.

Configuration for WCF Service Window
This dialog box enables you to configure communication with a WCF service.
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The values entered in the Configuration dialog box populate the BindingName, EndpointName,
MethodName, and URL properties that display in the Envision Properties box.

Field Definitions

Field Name Definition

URL URL of the item you are configuring

Bindings Specifies the data binding you want to use.

Endpoints Specifies the endpoint to which you want to
connect.

WebMethod Specifies a method to invoke.

Endpoint URL The URL of the endpoint of the service to which
you want to connect.

RequestMapping / ResponseMapping Click the Ellipses button to map the schemas for
the process model and the WCF service.

Custom Headers (Response) Click the Ellipses button to map the schemas
for the process model and the WCF service for a
request or response, as appropriate.
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Create Group Configuration Window
This property allows you to configure the new group details to be created in SharePoint.

Field Definitions

Field Name Definition

SiteURL This property specifies the URL for the new
where you want to add or remove the associated
item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}
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Field Name Definition

Group Name The name of the affected SharePoint Group (e.g.,
the group to be created, to be deleted, to which a
user will be added, etc.).

Group Owner The domain and user name of the SharePoint
user who is to be the owner of the group.

Group Description A description of the group.

Create Group Window
Specifies the group information to create in Active Directory. If the process template is associated with
a schema, the Schema buttons will appear allowing you to select an Xpath. Custom attributes are also
supported.

Field Definitions

Field Name Definition

Group Name Specifies the affected group name (the group
name to be created, removed, etc.). The Group
Name cannot be duplicated in the domain. Also,
once the Group is created, it cannot be changed.

Group Name (Pre-Windows 2000) Specifies the log name of the account, the
difference between the Group Name above and
this field is it can be modified after it has been
created.

Email Address Specifies the email address of the group.

Verify Group This button verifies the availability of the group
name. The button is available just for the context
domain if the context is reachable at design time.
For example, if the context domain binds with a
custom attribute, and the value depends on it at
run time, in this case, the button is unavailable.

Group Scope Refers to the profile of Group Scope in Active
Directory.

GroupType Refers to the profile of Group Type in Active
Directory.
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Customize Common Dialog Interface Window
This window allows you to configure the dialog box you want to display in SharePoint.
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Field Definitions

Field Name Definition

Dialog Title The title that appears in the title bar of the dialog
box.

Dialog Icon An icon that appears at the top of the dialog box.

Dialog Description A text description that at the top of the dialog box.

Submit Button Label The text that appears on the button that submits
the form on the dialog box and closes the dialog
box. (The text is "OK" by default in Windows.)

Cancel Button Label The text that appears on the button that closes
the dialog box without submitting the form. (The
text is "Cancel" by default in Windows.)

Data Configuration tab Opens the Data Configuration tab, which enables
you to define the fields on the form.
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Field Name Definition

Schema The schema for the current process is displayed
in the left pane. Drag and drop schema fields in
the right pane to add them to the dialog box.

Label The name that appears for the field in the dialog
box. By default, this is the same as the field
name, but this can be changed.

Name The name of the field as it appears in the
schema. This name is read-only.

ReadOnly When selected, indicates that the field is read-
only in the dialog box.

Input Type The type of input field that appears on the dialog
box.

> (Data Binding) Opens a pop-up that enables you to modify the
data binding for the field.

Up Arrow Moves a field up in the list.

Down Arrow Moves a field down in the list.

X Deletes a field from the dialog box.

Database Queries Window
Use this window to configure where and how the data is retrieved from the database
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Field Definitions

Field Name Definition

ConnectionString The connection string that will be used to connect
to the database at runtime.

• Click Choose to select a connection string
from the list of shared custom attributes
(defined and managed in Enterprise
Manager.)

• Click Create to create a new connection
string. to create a new connection string.

TableName The name of the database table where this
AgileShape should insert the database record.

DateTime Services Configuration Window
This window enables you to configure date calculations.
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Field Definitions

Field Name Definition

Input DateTime Specifies 1 or 2 dates to use as input values. You
can select a Custom Attribute, a Static date
and time, or the date and time Now (when the
DateTime AgilePart is initiated).

Add Specifies an amount of time to add to the Input
DateTime.

Subtract Specifies an amount of time to subtract from the
Input DateTime.

Compare Difference Indicates whether to compare the difference
between the two Input DateTime values.
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Field Name Definition

Return Specifies whether to pass the earlier or later
value based on the comparison.

Change Input DateTime to Output Format

Indicates that the Input DateTime format will be
converted to the Output.

Business Time Specifies that the AgilePoint work calendar is
taken into account for calculations.

Calculation Type Specifies whether to calculate or compare the
difference between Input DateTime 1 and Input
DateTime 2. You can specify the following types
of calculations:

• Real - The actual difference between the two
input DateTimes. The result depends on the
setting for the Result option.

• Relative - This setting is useful for situations
such as when an action is allowed once per
month. The "real" difference between the
last day of one month and the first day of
following month is 0 months. However, in
"relative" mode, this difference is calculated
as one month because the dates are in
adjacent months. This returns the relative
number of time units (days, weeks, months,
years) between the two input DateTimes. For
example, the Relative differences between
Sat 29-Dec-2007 23:59:59 and Wed 02-
Jan-2008 00:00:00 are 4 days or 1 week or
1 month or 1 year, depending upon the time
unit specified.

Result Specifies the type of value to return for
calculations where the Calculation Type is Real:

• Decimal - Returns the difference as is,
including any decimals.

• Whole Number - Returns the integer part of
the result by removing the decimal part.

• Rounded - Rounds up (>=0.5) or rounds
down (<0.5) the result.

Result Boolean If Compare Difference is enabled, the difference
will be evaluated as a Boolean (True/False)
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Field Name Definition

result, and the Boolean value will be associated
with the text that appears in this field.

Date String If based on the operation performed, the output is
of type DateTime, the result will be converted to
a string and stored in the format provided in the
Format list, and stored associated with the text
that appears in this field.

Difference If Compare Difference is enabled, the difference
will be stored as a NameValue where the name is
the text that appears in this field, and the value is
the output value.

Delete a Particular Version of a File Window
This property enables you to configure the file version you want to delete. Click the Ellipses button to
open and delete a particular version of a file dialog box.

Field Definitions

Field Name Definition

Document URL The URI of the file for which you want to delete a
version.

Version number of file to be deleted The URI of the file for which you want to delete a
version.
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Excel Calculate Configuration Window
This window enables you to configure an Excel calculate action

Field Definitions

Field Name Definition

Excel Services URL (Required) The URL of the Excel Service.

For example http://moss.litwareinc.com/_vti_bin/
ExcelService.asmx

This could include custom attributes like $
\{SharePointURL\}$\{ExcelService\}. Also schema
XPaths can be added using the ellipsis button.

Runtime Template (Required) The Excel template that will be used at run-
time (either .xlsx or .xltx). This document will be
copied to the location as defined by the Save To
parameter.

This could be custom attributes like $
\{SharePointURL\}$\{RuntimeTemplateLibrary\}$
\{ExcelFilename\}. Also schema XPaths can be
added using the ellipsis button.

This file should be equivalent to the Design-time
Template file with the same named fields.

This document should be located in either a
SharePoint Doc Library or in a shared folder.
Either way, this must be added to the Trusted
file locations of the Excel Services (configured
in SharePoint Central Administration - Shared
Services):
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Field Name Definition
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Field Name Definition

 

Design Time Template (Required) Excel template to use at design-time. This
template document is loaded at design-time to
get access to all the named fields in the Excel
sheet for mapping purposes. It is not used at run-
time.

This file should be equivalent to the Run-time
Template file with the same named fields. Also,
while designing in Envision, the file should be
accessible to the Process Designer from his/her
PC via the Browse button.

Save To (Required) The path and filename for saving the resulting
Excel document. This can be in a SharePoint
Doc library or in a directory path. This could
also be an expression like $\{SharePointURL
\}$\{ExcelDocLibrary\}$\{ExcelFilename\}. Also
schema XPaths can be added using the ellipsis
button.

Overwrite if Exists Overwrite the Save To file if it already exists.
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Excel Read Configuration Window
This window enables you to configure an Excel read action

Field Definitions

Field Name Definition

Excel Services URL (Required) The URL of the Excel Service.

For example http://moss.litwareinc.com/_vti_bin/
ExcelService.asmx

This could include custom attributes like $
\{SharePointURL\}$\{ExcelService\}. Also schema
XPaths can be added using the ellipsis button.

Runtime Template (Required) The Excel template that will be used at run-
time (either .xlsx or .xltx). This document will be
copied to the location as defined by the Save To
parameter.

This could be custom attributes like $
\{SharePointURL\}$\{RuntimeTemplateLibrary\}$
\{ExcelFilename\}. Also schema XPaths can be
added using the ellipsis button.

This file should be equivalent to the Design-time
Template file with the same named fields.

This document should be located in either a
SharePoint Doc Library or in a shared folder.
Either way, this must be added to the Trusted
file locations of the Excel Services (configured
in SharePoint Central Administration - Shared
Services):
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Field Name Definition
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Field Name Definition

 

Design Time Template (Required) Excel template to use at design-time. This
template document is loaded at design-time to
get access to all the named fields in the Excel
sheet for mapping purposes. It is not used at run-
time.

This file should be equivalent to the Run-time
Template file with the same named fields. Also,
while designing in Envision, the file should be
accessible to the Process Designer from his/her
PC via the Browse button.

Excel Write Configuration Window
This window enables you to configure an Excel write action

Field Definitions

Field Name Definition

Excel Services URL (Required) The URL of the Excel Service.
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Field Name Definition

For example http://moss.litwareinc.com/_vti_bin/
ExcelService.asmx

This could include custom attributes like $
\{SharePointURL\}$\{ExcelService\}. Also schema
XPaths can be added using the ellipsis button.

Runtime Template (Required) The Excel template that will be used at run-
time (either .xlsx or .xltx). This document will be
copied to the location as defined by the Save To
parameter.

This could be custom attributes like $
\{SharePointURL\}$\{RuntimeTemplateLibrary\}$
\{ExcelFilename\}. Also schema XPaths can be
added using the ellipsis button.

This file should be equivalent to the Design-time
Template file with the same named fields.

This document should be located in either a
SharePoint Doc Library or in a shared folder.
Either way, this must be added to the Trusted
file locations of the Excel Services (configured
in SharePoint Central Administration - Shared
Services):
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Field Name Definition
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Field Name Definition

 

Design Time Template (Required) Excel template to use at design-time. This
template document is loaded at design-time to
get access to all the named fields in the Excel
sheet for mapping purposes. It is not used at run-
time.

This file should be equivalent to the Run-time
Template file with the same named fields. Also,
while designing in Envision, the file should be
accessible to the Process Designer from his/her
PC via the Browse button.

Save To (Required) The path and filename for saving the resulting
Excel document. This can be in a SharePoint
Doc library or in a directory path. This could
also be an expression like $\{SharePointURL
\}$\{ExcelDocLibrary\}$\{ExcelFilename\}. Also
schema XPaths can be added using the ellipsis
button.

Overwrite if Exists Overwrite the Save To file if it already exists.
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Http Post Configuration Window
This window enables you to configure an HTTP post action.

Field Definitions

Field Name Definition

Credential The HTTP page URL section should
contain a valid URL such as http://
MachineName:PortNumber/WebApplication.aspx.

The Authentication section allows you to specify
the authentication for doing the Http post
function.

Do one of the following:

• Specify an account by Domain\\username
and password. You can validate whether
this account is valid by clicking on the Test
button.

• Use the AgilePoint System User at runtime,
that means it will impersonate the system
account of AgilePoint.

• Use the default credential, this means it will
use the account credentials that are used
when logging into the Web application.

Request This tab allows you to specify a custom header
by clicking on the ellipses button.

You can add parameters that will be used while
posting to a Web application, for example:

• Schema - You can attach a Xpath if the
process is based on a template with a
associated schema.

• Add - Append a new row in a table.

• Remove - Delete the current row in a table.

• Remove All - Remove all rows in a table.

Response This tab allows you to bind a response. You can
bind the response in two ways. One is to bind
the response with an AgilePoint Schema, the
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Field Name Definition

other is to store it in a custom attribute. If the
Web application that is called is based on Base64
Encode, make sure to select this option.

Security This tab allows you to enable SSL Authentication.

If SSL Authentication is checked, you can add
client certificates by clicking the ellipses button.

ProxyServer This tab allows you to specify whether a proxy
can be used during the execution of the Http
Post.

Meeting Schedule for Exchange Server Window
Specifies the authentication mode to be used to access the Exchange Server and schedule the
appointment and the appointment details.
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Field Definitions

Field Name Definition

Exchange 2007 or Exchange 2010 Specifies the version of your Microsoft Exchange
Server.

(Authentication) URL Specifies the Exchange Server URL.

(Authentication) Domain, Username, Password Determines that a specified account will be used
to access the Exchange Server and what the
credentials will be.

(Authentication) Use AgilePoint System User specifies to use the AgilePoint System User
credentials to access the Exchange Server.

The credentials and URL can be verified by
clicking the Test button. The Test button is
disabled if Use AgilePoint System User is
checked. In both cases, make sure that the user
has proper access rights to the Exchange Server.
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Field Name Definition

(Appointment or Meeting) Subject, Location, Start
Time, End Time, Time Zone

The details about the appointment or meeting.

(Appointment or Meeting) Body The body of the email. Accepts custom attributes
and schema by typing ${.

MoveListItemsConfiguration Window
This window enables you to specify the configuration for moving list items from one list to another.

Field Definitions

Field Name Definition

Source Site URL Specifies the name of the list that includes the
affected (copied, moved, etc.) list items.
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Field Name Definition

Source List Name Specifies the source SharePoint site URL that
includes the list for which items are to be affected
(copied, moved, etc.).

Source Folder Name Specifies the name of the folder that includes the
list items to be affected (copied, moved, etc.).

ListItem Field Name Specifies the name of the list item field to be
affected (copied, moved, etc.).

ListItem Field Value Specifies the value of the field to be affected
(copied, moved, etc.). This can be used as a
filtering mechanism where only fields with the
specified value are affected. The following are
sample values:

• $\{ListItemID\} or $\{SubListItemID\}

• list item ID

Target List Name Specifies the name of the destination list for the
affected items.

Target Folder Name Specifies the name of the destination folder for
the affected items. If the folder does not exist the
system will automatically create it.

Target Site URL Specifies the target SharePoint site URL that
includes the destination list for the affected items.

Name and Value Window
Use the Name and Value dialog box, where you can define the field name and value you want to
update within a specific SharePoint Library and folder.
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Field Definitions

Field Name Definition

Library URL The URL of the SharePoint Library where you
want to update the metadata field name and
value.

Enter a valid SharePoint URL, and then expand
the drop-down to select a specific list or library
URL and to populate the fields for the rest of the
options in the dialog box.

To retrieve the metadata associated with the
Library URL, you must use an actual URL.
However, you can use a custom attribute at
runtime. If you want to change the runtime URL,
replace the URL in the Library URL field with the
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runtime URL after you have configured the other
options in the dialog box.

Folder Name The folder within the SharePoint Library where
you want to update the metadata field name and
value.

Field Name Identifies a field by which you want to restrict the
metadata update.

Field Value Identifies a value by which you want to restrict the
metadata update.

Add Opens the Select SharePoint Library Column
dialog box. Use this dialog box to select the
metadata attributes you want to update.

Remove Removes a metadata field and value from the list
of metadata values to update.

Value A metadata value you want to update.

Read File Configuration Window
This window enables you to configure a read file action.
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Field Definitions

Field Name Definition

Schema Node The schema node for which to upload the file
data.

File Path The path to the file on the local file system that
includes the contents for which to upload to the
schema node.

Remove Group Configuration Window
This window allows you to specify which SharePoint group to delete from a SharePoint site.
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Field Definitions

Field Name Definition

SiteURL This property specifies the URL for the new
where you want to add or remove the associated
item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}

Group Name Specifies the affected group name (the group
name to be created, removed, etc.). The Group
Name cannot be duplicated in the domain. Also,
once the Group is created, it cannot be changed.

Remove User From Group Configuration Window
This property allows you to remove a user from a SharePoint group.
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Field Definitions

Field Name Definition

SiteURL This property specifies the URL for the new
where you want to add or remove the associated
item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}

Group Name Specifies the affected group name (the group
name to be created, removed, etc.). The Group
Name cannot be duplicated in the domain. Also,
once the Group is created, it cannot be changed.

User Name The user name you want to associate with the
action.

SAP Connection Browser
The SAP Connection Browser window enables you to set up and select a connection to an SAP
system. You can use this screen to access the configuration for an SAP function.
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To configure an SAP connection and map the SAP data to your schema, do the following:

1. In AgilePoint Envision, create or open a process model of any type.

2. Add a Call SAP Function AgilePart to your process model from the  SAP Integration stencil.

3. Select the Call SAP Function AgilePart. In the Configuration field, click the Ellipses .

4. In the SAP Connection Browser window, click the Add SAP System icon.

5. In the Establish iNet Connector Session to SAP System window, select the SAP server you set
up through iNet BPS. The exact steps vary based on your configuration. When you have finished,
click OK.
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6. If you want to filter the functions for your connection, in the SAP Connection Browser window
right-click the server name, and click Add RFC Filter.

7. In the RFC Filter window, in the Function field, enter a wildcard search term. For example, to
retrieve all the functions that start with GET, you can enter GET*.
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8. In the Description field, enter a name for the filter.

9. When you have finished creating the filter, click OK.

10. In the SAP Connection Browser window, select the SAP function you want, and click OK. The
SAP Integration Configuration window opens.

11. (Optional) On the SAP Integration Configuration window, specify a runtime connection string.

12. (Optional) Click Change Connection to select a different SAP database. (This starts the
procedure over.)

13. (SAP Queries Only) If you are configuring an SAP query, on the Query Filter tab, enter the
following information in the fields provided:

• Query column

• Comparison operator

• Value

• Conjunction

14. (SAP BAPI Only) If you are configuring an SAP BAPI, on the Input Mapping tab, enter map the
fields in your schema to the SAP fields.

15. (Queries or BAPI) On the Output Mapping tab, enter map the fields in your schema to the SAP
fields.
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16. When you have finished, click OK.

Select Exclusive Predecessor Activities Window
This window allows the process modeler to configure whether the activities in the parallel process flow
will continue to process or be canceled once one of the process flows enters the "Or" shape.
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The "Nearest Incoming Activities" group box displays the activities that are nearest the "Or"
AgileShape. Selecting the "Cancel Manual Tasks" and/or "Stop System Tasks" will cancel the activity
that has yet to complete.

The "Other Predecessor Activities" group box displays any additional activities that are associated with
a process flow leading into the "Or" AgileShape. You can select which other predecessor activities
to cancel by selecting the check box. Below is a sample usage scenario that describes how this
functionality would work.

Case 1:
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Case 2:
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Leaving the "Cancel Manual Tasks" and/or "Stop System Tasks" blank will allow the parallel process
flow(s) to continue processing once one of the process flows enters the "Or" shape. This would be the
same behavior as if "False" was selected in the "Exclusive" property of the "Or" AgileShape.

Set Context Properties Window
Specifies the Active Directory properties.
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Field Definitions

Field Name Definition

Context Domain The domain name.

Context Domain The username of the account to be used to
create a group in Active Directory at run time.

Password The password of the account to be used to create
a group in the domain at run time.

Directory Type The Active Directory type (LDAP/WinNT). At this
time, only LDAP is supported.

Directory Address Specifies a host address of the Active Directory.

Directory Port Specifies a port number of the Active Directory.
By default, it is 389. In the case of a remote
domain, the port should match the port of the
remote domain server.

Secure Connection In this version, the SSL is not supported; it will be
an enhancement in the future.
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Submit File To Record Center Configuration Window
Use this window to configure the record center submission.

Field Definitions

Field Name Definition

Record Center Site URL The URL of the SharePoint Record Center where
you want to submit the file. Once you have
entered the URL, click Connect to populate the
Routing Name list.

Routing Name The Routing Name you want to use to submit the
file.

DocumentURL The URL location of the affected file (for example,
the file you want to add, delete, check out, etc.).

User Name The user name you want to associate with the
action.

Time Watch Between Activities Window
This window enables you to configure the SLA timer, including the range of AgileShapes you want to
time.
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Field Definitions

Field Name Definition

Add Creates a new timer with a name you specify.

Remove Deletes the selected timer.

Start Activity The activity upon which you want to start the
timer.

End Activity The activity upon which you want to end the
timer.

Fixed Date Selects a date to expire the timer.

Calculate Date Calculates a date to expire the timer based on
the information you enter.

Notification Optionally sends a preconfigured notification type
when the timer expires.
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Field Name Definition

Sub Process Optionally starts a subprocess when the
timer expires. The list is populated from the
subprocesses in your process model.

Update Group Configuration Window
This window allows you to update information for a SharePoint group.

Field Definitions

Field Name Definition

SiteURL This property specifies the URL for the new
where you want to add or remove the associated
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Field Name Definition

item (e.g., SharePoint site, document library, site
collection, user, group, etc.).

Below are examples of a valid SharePoint site
URL:

• http://Machine_Name:port/sites/SiteName

• $\{DocUrl\}

Existing Group Name The name of the existing SharePoint Group for
which you would like to change the information.

New Group Name The new name of the SharePoint Group.

New Group Description The new description that will overwrite the
existing group description.

New Group Owner The domain and user name for the new group
owner.

Wait for Milestone Configuration Window
This dialog box enables you to configure the milestone. Click the Ellipses button to open the Wait For
Milestone Configuration dialog box.
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Field Definitions

Field Name Definition

Process Templates on AgilePoint Server Select the process template with the Pass
Milestone shape for which you want the current
shape to wait.

Milestone activities in the process template Select the specific Pass Milestone shape for
which you want to wait.

Web Service Configuration Window
This window allows the process modeler to configure which Web service method should be invoked at
runtime. It also allows the process modeler to configure the custom process attributes that should be
associated with the Web service method's parameters (if any), and the custom process attribute that
will be used to store the Web service method's return value (if any).
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Once the configuration dialog is open, enter the URL of a Web Service and click the Connect
button. A list of the Web service's available methods will be retrieved. Select the method you want to
associate with this AgileShape. To configure the custom process attributes for the parameters and/or
return value, simply click on an attribute (e.g. $piID) to highlight it, and then click on it again to modify
the value.
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Word Configuration Window
This property enables you to configure a Word template conversion. Click the Ellipses button to open
the Configuration dialog box.

Field Definitions

Field Name Definition

Word Template Enter the location for a Word template file, or
click the Ellipses to select a custom attribute.

Destination The destination (folder and file path) for the file
output. Click the Ellipses (...) to select a custom
attribute.

Save as PDF Indicates that the generated file will be saved as
a PDF file, instead of a Word document.

SharePoint Credentials Click this button to enter the SharePoint logon
credentials required to create the file.
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Field Name Definition

Load Word Fields Click this button to load the list on the right with
the dynamic fields from the Word document.
Select the field names in this list, and click the left
arrow (<-) button to add the fields to the list on
the left.

Process value For each field in the Word template, select this
column, and click the Ellipses (...) button. In the
pop-up, select the value you want for the selected
Word field.

Workflow Foundation Assembly Window
This window allows the process modeler to configure the details for invoking Windows Workflow
Foundation activities.

1. Click the Ellipses button to open the Workflow Foundation Assembly window.

2. Click Browse, the following two choices are available:

• Workflow Assembly in a folder

• Workflow Assembly in GAC
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The Sequential Workflow assembly can be either in the GAC or in a folder. If it is in a folder, it will
be added into the GAC automatically when the Sequential Workflow AgilePart is configured.

3. Choose a workflow assembly.

4. Configure the "Input Parameters" and "Output Parameters".

5. Click OK.

XML Schema Mappings
This window enables you to map schema nodes from a parent process to a sub-process.

Field Definitions

Field Name Definition

Child The mapped XML schema node for a child
process.

Parent The mapped XML schema node for a parent
process.

Schema Opens the schema associated with the selected
Child or Parent.

Add Creates a new parent/child pair you can map
using the schema mapper.

Remove Removes the selected new parent/child schema
node pair.
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